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Introducing ASP.NET Core




CHAPTER 1

Putting ASPNET Core in Context

Understanding ASP.NET Core

ASP.NET Core is Microsoft’s web development platform. The original ASP.NET was introduced in 2002, and it has been through
several reinventions and reincarnations to become ASP.NET Core 3, which is the topic of this book.

ASP.NET Core consists of a platform for processing HTTP requests, a series of principal frameworks for creating applications,
and secondary utility frameworks that provide supporting features, as illustrated by Figure 1-1.

Application Frameworks Utility Frameworks
MVC Razor r g I r Entity |
Blazor I Identity |
Framework Pages J| Framework |
Platform
HTTP ST - URL Routing DepAend‘ency Conflgur?tlon
Server Injection & Logging
. Model .
Caching Binting Razor gRPC SignalR

Figure 1-1. The structure of ASPNET Core

Understanding the Application Frameworks

When you start using ASP.NET Core, it can be confusing to find that there are different application frameworks available. As you will
learn, these frameworks are complementary and solve different problems, or, for some features, solve the same problems in different
ways. Understanding the relationship between these frameworks means understanding the changing design patterns that Microsoft
has supported, as I explain in the sections that follow.

Understanding the MVC Framework

The MVC Framework was introduced in the pre-Core days of ASP.NET. The original ASP.NET relied on a development model called
Web Pages, which re-created the experience of writing desktop applications but resulted in unwieldy web projects that did not scale
well. The MVC Framework was introduced alongside Web Pages with a development model that embraced the character of HTTP
and HTML, rather than trying to hide it.
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MVC stands for Model-View-Controller, which is a design pattern that describes the shape of an application. The MVC pattern
emphasizes separation of concerns, where areas of functionality are defined independently, which was an effective antidote to the
indistinct architectures that Web Pages led to.

Early versions of the MVC Framework were built on the ASP.NET foundations that were originally designed for Web Pages,
which led to some awkward features and workarounds. With the move to .NET Core, ASP.NET became ASP.NET Core, and the MVC
Framework was rebuilt on an open, extensible, and cross-platform foundation.

The MVC Framework remains an important part of ASP.NET Core, but the way it is commonly used has changed with the rise of
single-page applications (SPAs). In an SPA, the browser makes a single HTTP request and receives an HTML document that delivers
arich client, typically written in a JavaScript client such as Angular or React. The shift to SPAs means that the clean separation that
the MVC Framework was originally intended for is not as important, and the emphasis placed on following the MVC pattern is no
longer essential, even though the MVC Framework remains useful (and is used to support SPAs through web services, as described
in Chapter 19).

PUTTING PATTERNS IN THEIR PLACE

Design patterns provoke strong reactions, as the emails | receive from readers will testify. A substantial proportion of the
messages | receive are complaints that | have not applied a pattern correctly.

Patterns are just other people’s solutions to the problems they encountered in other projects. If you find yourself facing the
same problem, understanding how it has been solved before can be helpful. But that doesn’t mean you have to follow the
pattern exactly, or at all, as long as you understand the consequences. If a pattern is intended to make projects manageable, for
example, and you choose to deviate from that pattern, then you must accept that your project may be more difficult to manage.
But a pattern followed slavishly can be worse than no pattern at all, and no pattern is suited to every project.

My advice is to use patterns freely, adapt them as necessary, and ignore zealots who confuse patterns with commandments.

Understanding Razor Pages

One drawback of the MVC Framework is that it can require a lot of preparatory work before an application can start producing content.
Despite its structural problems, one advantage of Web Pages was that simple applications could be created in a couple of hours.

Razor Pages takes the development ethos of Web Pages and implements it using the platform features originally developed for
the MVC Framework. Code and content are mixed to form self-contained pages; this re-creates the speed of Web Pages development
without some of the underlying technical problems (although the issue of scaling up complex projects can still be an issue).

Razor Pages can be used alongside the MVC Framework, which is how I tend to use them. I write the main parts of the
application using the MVC Framework and use Razor Pages for the secondary features, such as administration and reporting tools.
You can see this approach in Chapters 7-11, where I develop a realistic ASP.NET Core application called SportsStore.

Understanding Blazor

The rise of JavaScript client-side frameworks can be a barrier for C# developers, who must learn a different—and somewhat
idiosyncratic—programming language. I have come to love JavaScript, which is as fluid and expressive as C#. But it takes time and
commitment to become proficient in a new programming language, especially one that has fundamental differences from C#.
Blazor attempts to bridge this gap by allowing C# to be used to write client-side applications. There are two versions of Blazor:
Blazor Server and Blazor WebAssembly. Blazor Server is a stable and supported part of ASP.NET Core, and it works by using a
persistent HTTP connection to the ASP.NET Core server, where the application’s C# code is executed. Blazor WebAssembly is an
experimental release that goes one step further and executes the application’s C# code in the browser. Neither version of Blazor is
suited for all situations, as I explain in Chapter 33, but they both give a sense of direction for the future of ASP.NET Core development.

Understanding the Utility Frameworks

Two frameworks are closely associated with ASP.NET Core but are not used directly to generate HTML content or data. Entity
Framework Core is Microsoft’s object-relational mapping (ORM) framework, which represents data stored in a relational database
as .NET objects. Entity Framework Core can be used in any .NET Core application, and it is commonly used to access databases in
ASP.NET Core applications.
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ASP.NET Core Identity is Microsoft’s authentication and authorization framework, and it is used to validate user credentials in
ASP.NET Core applications and restrict access to application features.

I describe only the basic features of both frameworks in this book, focusing on the capabilities required by most ASP.NET Core
applications. But these are both complex frameworks that are too large to describe in detail in what is already a large book about
ASP.NET Core.

TOPICS FOR FUTURE EDITIONS

| don’t have space in this book to cover every Entity Framework Core and ASP.NET Core Identity feature, so | have focused on
those aspects that most projects require. If there are topics you think | should include in the next edition or in new deep-dive
books, then please send me your suggestions at adam@adam-freeman.com.

Understanding the ASP.NET Core Platform

The ASP.NET Core platform contains the low-level features required to receive and process HTTP requests and create responses.
There is an integrated HTTP server, a system of middleware components to handle requests, and core features that the application
frameworks depend on, such as URL routing and the Razor view engine.

Most of your development time will be spent with the application frameworks, but effective ASP.NET Core use requires an
understanding of the powerful capabilities that the platform provides, without which the higher-level frameworks could not
function. I demonstrate how the ASP.NET Core platform works in detail in Part 2 of this book and explain how the features it provides
underpin every aspect of ASP.NET Core development.

I'have not described two notable platform features in this book: SignalR and gRPC. SignalR is used to create low-latency
communication channels between applications. It provides the foundation for the Blazor Server framework that I describe in Part
4 of this book, but SignalR is rarely used directly, and there are better alternatives for those few projects that need low-latency
messaging, such as Azure Event Grid or Azure Service Bus.

gRPC is an emerging standard for cross-platform remote procedure calls (RPCs) over HTTP that was originally created by
Google (the gin gRPC) and offers efficiency and scalability benefits. gRPC may be the future standard for web services, but it cannot
be used in web applications because it requires low-level control of the HTTP messages that it sends, which browsers do not allow.
(There is a browser library that allows gRPC to be used via a proxy server, but that undermines the benefits of using gRPC.) Until
gRPC can be used in the browser, its inclusion in ASP.NET Core is of interest only for projects that use it for communication between
back-end servers, for which many alternative protocols exist. I may cover gRPC in future editions of this book but not until it can be
used in the browser or becomes the dominant data-center protocol.

Understanding This Book

To get the most from this book, you should be familiar with the basics of web development, understand how HTML and CSS work,
and have a working knowledge of C#. Don’t worry if you haven’t done any client-side development, such as JavaScript. The emphasis
in this book is on C# and ASP.NET Core, and you will be able to pick up everything you need to know as you progress through the
chapters. In Chapter 5, I summarize the most important C# features for ASP.NET Core development, which you will find useful if you
are coming to ASP.NET Core from earlier versions of .NET Core or the NET Framework.

What Software Do I Need to Follow the Examples?

You need a code editor (either Visual Studio or Visual Studio Code), the .NET Core Software Development Kit, and SQL Server LocalDB.
All are available for use from Microsoft without charge, and Chapter 2 contains instructions for installing everything you need.

What Platform Do I Need to Follow the Examples?

This book is written for Windows. I used Windows 10 Pro, but any version of Windows supported by Visual Studio, Visual Studio
Code, and .NET Core should work. ASP.NET Core is supported on other platforms, but the examples in this book rely on the SQL
Server LocalDB feature, which is specific to Windows. You can contact me at adam@adam-freeman. com if you are trying to use another
platform, and I will give you some general pointers for adapting the examples, albeit with the caveat that I won’t be able to provide
detailed help if you get stuck.
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What If I Have Problems Following the Examples?

The first thing to do is to go back to the start of the chapter and begin again. Most problems are caused by missing a step or not fully
following a listing. Pay close attention to the emphasis in code listings, which highlights the changes that are required.

Next, check the errata/corrections list, which is included in the book’s GitHub repository. Technical books are complex,
and mistakes are inevitable, despite my best efforts and those of my editors. Check the errata list for the list of known errors and
instructions to resolve them.

If you still have problems, then download the project for the chapter you are reading from the book’s GitHub repository,
https://github.com/apress/pro-asp.net-core-3, and compare it to your project. I create the code for the GitHub repository by
working through each chapter, so you should have the same files with the same contents in your project.

If you still can’t get the examples working, then you can contact me at adam@adam-freeman. com for help. Please make it clear
in your email which book you are reading and which chapter/example is causing the problem. Please remember that I get a lot of
emails and that I may not respond immediately.

What IfI Find an Error in the Book?

You can report errors to me by email at adam@adam-freeman. com, although I ask that you first check the errata/corrections list for
this book, which you can find in the book’s GitHub repository at https://github.com/apress/pro-asp.net-core-3, in case it has
already been reported.

I add errors that are likely to cause confusion to readers, especially problems with example code, to the errata/corrections file
on the GitHub repository, with a grateful acknowledgment to the first reader who reported them. I keep a list of less serious issues,
which usually means errors in the text surrounding examples, and I fix them when I write a new edition.

What Does This Book Cover?

I have tried to cover the features that will be required by most ASP.NET Core projects. This book is split into four parts, each of which
covers a set of related topics.

Part 1: Introducing ASP.NET Core

This part of the book—which includes this chapter—introduces ASP.NET Core. In addition to setting up your development
environment and creating your first application, you'll learn about the most important C# features for ASP.NET Core development
and how to use the ASP.NET Core development tools. But most of Part 1 is given over to the development of a project called
SportsStore, through which I show you a realistic development process from inception to deployment, touching on all the main
features of ASP.NET Core and showing how they fit together—something that can be lost in the deep-dive chapters in the rest of the
book.

Part 2: The ASP.NET Core Platform

The chapters in this part of the book describe the key features of the ASP.NET Core platform. I explain how HTTP requests are
processed, how to create and use middleware components, how to create routes, how to define and consume services, and how to
work with Entity Framework Core. These chapters explain the foundations of ASP.NET Core, and understanding them is essential for
effective ASP.NET Core development.

Part 3: ASP.NET Core Applications

The chapters in this part of the book explain how to create different types of applications, including RESTful web services and HTML
applications using controllers and Razor Pages. These chapters also describe the features that make it easy to generate HTML,
including the views, view components, and tag helpers.

Part 4: Advanced ASP.NET Core Features

The final part of the book explains how to create applications using Blazor Server, how to use the experimental Blazor WebAssembly,
and how to authenticate users and authorize access using ASP.NET Core Identity.
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What Doesn’t This Book Cover?

This book doesn’t cover basic web development topics, such as HTML and CSS, and doesn’t teach basic C# (although Chapter 5
does describe C# features useful for ASP.NET Core development that may not be familiar to developers using older versions of .NET).

As much as I like to dive into the details in my books, not every ASP.NET Core feature is useful in mainstream development, and
I have to keep my books to a printable size. When I decide to omit a feature, it is because I don’t think it is important or because the
same outcome can be achieved using a technique that I do cover.

As noted earlier, I have not described the ASP.NET Core support for SignalR and gRPC, and I note other features in later
chapters that I don’t describe, either because they are not broadly applicable or because there are better alternatives available. In
each case, I explain why I have omitted a description and provide a reference to the Microsoft documentation for that topic.

How Do I Contact the Author?

You can email me at adam@adam-freeman. com. It has been a few years since I first published an email address in my books. I wasn’t
entirely sure that it was a good idea, but I am glad that I did it. I have received emails from around the world, from readers working or
studying in every industry, and—for the most part anyway—the emails are positive, polite, and a pleasure to receive.

I try to reply promptly, but I get a lot of email, and sometimes I get a backlog, especially when I have my head down trying to
finish writing a book. I always try to help readers who are stuck with an example in the book, although I ask that you follow the steps
described earlier in this chapter before contacting me.

While I welcome reader emails, there are some common questions for which the answers will always be no. I am afraid that I
won’t write the code for your new startup, help you with your college assignment, get involved in your development team’s design
dispute, or teach you how to program.

What If I Really Enjoyed This Book?

Please email me at adam@adam-freeman.com and let me know. It is always a delight to hear from a happy reader, and I appreciate the
time it takes to send those emails. Writing these books can be difficult, and those emails provide essential motivation to persist at an
activity that can sometimes feel impossible.

What If This Book Has Made Me Angry and I Want to Complain?

You can still email me at adam@adam-freeman.com, and I will still try to help you. Bear in mind that I can only help if you explain
what the problem is and what you would like me to do about it. You should understand that sometimes the only outcome is to accept
I am not the writer for you and that we will have closure only when you return this book and select another. I'll give careful thought
to whatever has upset you, but after 25 years of writing books, I have come to understand that not everyone enjoys reading the books
Ilike to write.

Summary

In this chapter, I set the scene for the rest of the book. I provided a brief overview of ASP.NET Core, explained the requirements for
and the content of this book, and explained how you can contact me. In the next chapter, I show you how to prepare for ASPNET
Core development.



CHAPTER 2

Getting Started

The best way to appreciate a software development framework is to jump right in and use it. In this chapter, I explain how to prepare
for ASP.NET Core development and how to create and run an ASP.NET Core application.

UPDATES TO THIS BOOK

Microsoft has an active development schedule for .NET Core and ASP.NET Core, which means that there may be new releases
available by the time you read this book. It doesn’t seem fair to expect readers to buy a new book every few months, especially
since most changes are relatively minor. Instead, | will post free updates to the GitHub repository for this book (https://github.
com/apress/pro-asp.net-core-3) for breaking changes.

This kind of update is an ongoing experiment for me (and for Apress), and it continues to evolve—not least because | don’t know
what the future major releases of ASP.NET Core will contain—but the goal is to extend the life of this book by supplementing the
examples it contains.

| am not making any promises about what the updates will be like, what form they will take, or how long | will produce them
before folding them into a new edition of this book. Please keep an open mind and check the repository for this book when new
ASP.NET Core versions are released. If you have ideas about how the updates could be improved, then email me at adam@adam-
freeman.com and let me know.

Choosing a Code Editor

Microsoft provides a choice of tools for ASP.NET Core development: Visual Studio and Visual Studio Code. Visual Studio is the
traditional development environment for .NET applications, and it offers an enormous range of tools and features for developing all
sorts of applications. But it can be resource-hungry and slow, and some of the features are so determined to be helpful they get in the
way of development.

Visual Studio Code is a light-weight alternative that doesn’t have the bells and whistles of Visual Studio but is perfectly capable
of handling ASP.NET Core development.

All the examples in this book include instructions for both editors, and both Visual Studio and Visual Studio Code can be used
without charge, so you can use whichever suits your development style.

If you are new to .NET Core development, then start with Visual Studio. It provides more structured support for creating
the different types of files used in ASP.NET Core development, which will help ensure you get the expected results from the code
examples.

Note This book describes ASP.NET Core development for Windows. It is possible to develop and run ASP.NET Core applications on
Linux and macOS, but most readers use Windows, and that is what | have chosen to focus on. Almost all the examples in this book rely
on LocalDB, which is a Windows-only feature provided by SQL Server that is not available on other platforms. If you want to follow this
book on another platform, then you can contact me using the email address in Chapter 1, and | will try to help you get started.
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Installing Visual Studio

ASP.NET Core 3 requires Visual Studio 2019. I use the free Visual Studio 2019 Community Edition, which can be downloaded from
www.visualstudio.com. Run the installer, and you will see the prompt shown in Figure 2-1.

Visual Studio Installer

Before you get started, we need to set up a few things so that you
can configure your installation.

To learn more about privacy, see the Microsoft Privacy Statement.

By continuing, you agree to the Microsoft Software License Terms.

Continue

Figure 2-1. Starting the Visual Studio installer

Click the Continue button, and the installer will download the installation files, as shown in Figure 2-2.

Visual Studio Installer

Just a moment ... Fetching your files.

Downloading: 11.17 MB of 71.23 MB 2.56 MB/sec
e )
Installing

Cancel

Figure 2-2. Downloading the Visual Studio installer files

When the installer files have been downloaded, you will be presented with a set of installation options, grouped into workloads.
Ensure that the “ASP.NET and web development” workload is checked, as shown in Figure 2-3.
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Figure 2-3. Selecting the workload
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GETTING STARTED

Select the “Individual components” section at the top of the window and ensure the SQL Server Express 2016 LocalDB option is
checked, as shown in Figure 2-4. This is the database component that I will be using to store data in later chapters.

Installing — Visual Studic Community 2019 — 16.4.3 x
Workload Individual comy Language packs Installation locations
Installation details
Search components (Ctrl+Q) L
> Visual Studio core editor
1iS Express « ASP.NET and web development

Service Fabric Tools Included
SQL ADAL runtime v .NET Core development tocls

QL Server Command Line Utilities v .NET Framework 4.7.2 development tools
« ASP.NET and web development tools

SQL Server Express 2016 LocalDg v IntelliCode
SQL Server ODBC Driver Opticnal
Visual Studio Tools for Kubernetes & .NET Framework 4 - 4.6 development tools
Web Deploy JNET Core 2.1 LTS Runtime
Cloud tools for web development
Code tools

JNET profiling tools

e Mﬂawﬁ_'r&- e

R Tt gt P

Figure 2-4. Ensuring LocalDB is installed

Click the Install button, and the files required for the selected workload will be downloaded and installed. To complete the
installation, a reboot is required, as shown in Figure 2-5.
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Reboot required

Success! One more step to go. Please restart your computer before you start Visual Studio

Community 2019.

Get troubleshooting_tips Restart Not now

Figure 2-5. Completing the installation

Installing the .NET Core SDK

The Visual Studio installer will install the .NET Core Software Development Kit (SDK), but it may not install the version required
for the examples in this book. Go to https://dotnet.microsoft.com/download/dotnet-core/3.1 and download the installer

for version 3.1.1 of the .NET Core SDK, which is the long-term support release at the time of writing. Run the installer; once the
installation is complete, open a new PowerShell command prompt from the Windows Start menu and run the command shown in
Listing 2-1, which displays a list of the installed .NET Core SDKs.

Listing 2-1. Listing the Installed SDKs
dotnet --list-sdks

Here is the output from a fresh installation on a Windows machine that has not been used for .NET Core:
3.1.101 [C:\Program Files\dotnet\sdk]

If you have been working with different versions of .NET Core, you may see a longer list, like this one:

.401
.502
.505
.602
.802
.100
.100
.101

:\Program Files\dotnet\sdk]
:\Program Files\dotnet\sdk]
:\Program Files\dotnet\sdk]
:\Program Files\dotnet\sdk]
:\Program Files\dotnet\sdk]
:\Program Files\dotnet\sdk]
:\Program Files\dotnet\sdk]
:\Program Files\dotnet\sdk]

— e e e
aNeNaNaEaNaNaNe)

W wWwwNNNNN
PR ORRRRERR

Regardless of how many entries there are, you must ensure there is one for the 3.1.1xx version, where the last two digits may
differ.

Installing Visual Studio Code

If you have chosen to use Visual Studio Code, download the installer from https://code.visualstudio.com. No specific version is
required, and you should select the current stable build. Run the installer and ensure you check the Add to PATH option, as shown in
Figure 2-6.
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ﬂ Setup - Microsoft Visual Studio Code (User)

Select Additional Tasks
Which additional tasks should be performed?

Additional icons:

[[] Create a desktop icon

Other:

[C] Add "Open with Code™ action to Windows Explorer file context menu

[[] Add "Open with Code" action to Windows Explorer directory context menu
__[ ] Register Code as an editor for supported file types

(] Add to PATH (requires shell restart)

Select the additional tasks you would like Setup to perform while installing Visual Studio
Code, then dick Next.

<gack [ Newt> ]| | concel |

Figure 2-6. Configuring the Visual Studio Code installation

Installing the .NET Core SDK

The Visual Studio installer does not include the .NET Core SDK, which must be installed separately. Go to https://dotnet.microsoft.
com/download/dotnet-core/3.1 and download the installer for version 3.1.1 of the .NET Core SDK, which is the long-term support
release at the time of writing. Run the installer; once the installation is complete, open a new PowerShell command prompt from the
Windows Start menu and run the command shown in Listing 2-2, which displays a list of the installed .NET Core SDKs.

Listing 2-2. Listing the Installed SDKs

CHAPTER 2 © GETTING STARTED

dotnet --list-sdks

Here is the output from a fresh installation on a Windows machine that has not been used for .NET Core:

3.1.101 [C:\Program Files\dotnet\sdk]

If you have been working with different versions of .NET Core, you may see a longer list, like this one:

.401 [C
.502 [C
.505 [C
.602 [C
.802 [C
.100 [C
.100 [C
.101 [C

W W WNNNNN
PR ORRRERR

:\Program
:\Program
:\Program
:\Program
:\Program
:\Program
:\Program
:\Program

Files\dotnet\sdk]
Files\dotnet\sdk]
Files\dotnet\sdk]
Files\dotnet\sdk]
Files\dotnet\sdk]
Files\dotnet\sdk]
Files\dotnet\sdk]
Files\dotnet\sdk]
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Regardless of how many entries there are, you must ensure there is one for the 3.1.1xx version, where the last two digits may
differ.

Installing SQL Server LocalDB

The database examples in this book require LocalDB, which is a zero-configuration version of SQL Server that can be installed as part
of the SQL Server Express edition, which is available for use without charge from https://www.microsoft.com/en-in/sql-server/
sql-server-downloads. Download and run the Express edition installer and select the Custom option, as shown in Figure 2-7.

SQL Server 2017
Express Edition

Select an installation type:

Basic Custom Download Media

experien

Figure 2-7. Selecting the installation option for SQL Server

Once you have selected the Custom option, you will be prompted to select a download location for the installation files. Click
the Install button, and the download will begin.
When prompted, select the option to create a new SQL Server installation, as shown in Figure 2-8.
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i m] X

New SQL Server stand-alone installation or add features to an existing installation

Launch a wizard to install SQL Server 2017 in a non-clustered environment or to add
features to an existing SQL Server 2017 instance.

T SOL Server Installation Center
Planning -
Installation %
Maintenance
Tools =
Resources
Options L‘:;E}
Microsoft SQL Server 2017

Install SQL Server Reporting Services

Launch a download page that provides a link to install SQL Server Reporting Services. An
internet connection is required to install SSRS.

Install SQL Server Management Tools
Launch a download page that provides a link to install SQL Server Management Studio,
SQL Server command-line utilities (SQLCMD and BCP), SQL Server PowerShell provider,

SQL Server Profiler and Database Tuning Advisor. An internet connection is required to
install these tools.

Install SQL Server Data Tools

Launchad | page that provides a link to install SOL Server Data Tools (SSDT). SSDT
provides Visual Studio integration including project system support for Azure SQL
Database, the SQL Server Datalk Engine, Reporting Services, Analysis Services and
Integration Services. An internet connection is required to install SSDT.

Upgrade from a previous version of SQL Server
Launch a wizard to upgrade a previous version of SQL Server to SQL Server 2017.

Figure 2-8. Selecting an installation option
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Work through the installation process, selecting the default options as they are presented. When you reach the Feature Selection
page, ensure that the LocalDB option is checked, as shown in Figure 2-9. (You may want to uncheck the options for R and Python,
which are not used in this book and take a long time to download and install.)

Feature Configuration Rules
Installation Progress
Complete

™ SQL Server 2017 Setup - o X
Feature Selection
Select the Express features to install.
License Terms S
: _—_ .
Global Rules Looking for Reporting Services nload it from the w
Microsoft Update Festures: Festure description:
e (ES [ The _ ion and of of each instance feature of a
Install Setup Files Database Engine Services SOL Server instance is isclated from other SOL Server
Install Rules [ SQL Server Replication instances. SQL Server instances can operate side-by-side on
Feature Selection 4 Machine Learning Services (In-Database) | the same computer.
Mr = . B
Feature Rules {4 Python . for selected
Instance Configuration [ Full-Text and Semantic Extractions for Search Already installed: 7
Server Configuration [J PolyBase Query Service for External Data Windows PowerShell 3.0 or higher
Database Engine Configuration Shared Features N = l:'_(l'el';:::n Fr:::”ﬂt 46
Consent to install Microsoft R . E:m I:::: ::::"?:::Mpbﬁbm o be installied from media: v
Consent to install Python Disk Space Requirements

| Drive C: 3177 MB required, 103232 MB available

Select All
Instance roct directory:

Shared feature directory:

Shared feature directory (x86):

Unselect All

[C:\Plogram Files\Microseft SQL Server\, I [

[C:\ngram Files\Microsoft SQL Server', | [

iC:\ngram Files (x26)\Microsoft SQL Server\ |

< Back Cancel

Figure 2-9. Selecting the LocalDB feature
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On the Instance Configuration page, select the “Default instance” option, as shown in Figure 2-10.

SQL Server 2017 Setu - o X
p

Instance Configuration

Specify the name and instance ID for the instance of SQL Server. Instance ID bacomes part of the installation path.

License Terms (@) Defaultinstance
Global Rules
Microsoft Update
Product Updates
Install Setup Files Instance ID: MSSQLSERVER
Install Rules E—

Feature Selection

(O Mamed instance:  MSSOLSERVER

Feature Rules SQL Server directory:  C:\Program Files\Microsoft SQL Server\MSSQL14.MSSQLSERVER
Instance Configuration
st Installed instances:
Server Configuration
Database Engine Confi : Instance Name Instance ID Features Edition Version

Consent to install Microsoft R ...
Consent to install Python
Feature Configuration Rules
Installation Progress

Complete

< Back Next > Cancel

Figure 2-10. Configuring the database

Continue to work through the installation process, selecting the default values. Once the installation is complete, install the
latest cumulative update for SQL Server. At the time of writing, the latest update is available at https://support.microsoft.com/
en-us/help/4527377/cumulative-update-18-for-sql-server-2017, although newer updates may have been released by the time
you read this chapter.

Caution It can be tempting to skip the update stage, but it is important to perform this step to get the expected results from the
examples in this book. As an example, the base installation of SQL Server has a bug that prevents LocalDB from creating database files,
which will cause problems when you reach Chapter 7.

Creating an ASP.NET Core Project

The most direct way to create a project is to use the command line, although Visual Studio provides a wizard system that I
demonstrate in Chapter 4. Open a new PowerShell command prompt from the Windows Start menu, navigate to the folder where
you want to create your ASP.NET Core projects, and run the commands shown in Listing 2-3.

Tip You can download the example project for this chapter—and for all the other chapters in this book—from https://github.
com/apress/pro-asp.net-core-3. See Chapter 1 for how to get help if you have problems running the examples.
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Listing 2-3. Creating a New Project

dotnet new globaljson --sdk-version 3.1.101 --output FirstProject
dotnet new mvc --no-https --output FirstProject --framework netcoreapp3.1

The first command creates a folder named FirstProject and adds to it a file named global. json, which specifies the version
of .NET Core that the project will use; this ensures you get the expected results when following the examples. The second command
creates a new ASP.NET Core project. The .NET Core SDK includes a range of templates for starting new projects, and the mvc
template is one of the options available for ASP.NET Core applications. This project template creates a project that is configured for
the MVC Framework, which is one of the application types supported by ASP.NET Core. Don’t be intimidated by the idea of choosing
a framework, and don’t worry if you have not heard of MVC—by the end of the book, you will understand the features that each
offers and how they fit together.

Note This is one of a small number of chapters in which | use a project template that contains placeholder content. | don’t like using
predefined project templates because they encourage developers to treat important features, such as authentication, as black boxes. My
goal in this book is to give you the knowledge to understand and manage every aspect of your ASP.NET Core applications, and that’s why
| start with an empty ASP.NET Core project. This chapter is about getting started quickly, for which the mvc template is well-suited.

Opening the Project Using Visual Studio

Start Visual Studio and click the “Open a project or solution” button, as shown in Figure 2-11.

Visual Studio 2019

Open recent Get started

As you use Visual Studio, any projects, folders, or files that you open will show up here for

quick access. é Clone or check out code

You can pin anything that you open frequently so that it's always at the top of the list. Get code from an online repository like GitHub or
Azure DevOps

C@ Open a project or solution

Open a local Visual Studio project or sin file

- Open a local folder

Navigate and edit code within any folder

¥8) Create a new project

Choose a project template with code scaffolding
to get started

Continue without code

Figure 2-11. Opening the ASP.NET Core project

Navigate to the FirstProject folder, select the FirstProject.csproj file, and click the Open button. Visual Studio will open
the project and display its contents in the Solution Explorer window, as shown in Figure 2-12. The files in the project were created by
the project template.
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Solution Explorer vyvAX
COREB- -5 B u-| S =
Search Solution Explorer (Ctrl+;) po
fa] Solution ‘FirstProject' (1 of 1 project)
4 ) FirstProject

& Connected Services
& Dependencies
M Properties
& wwwroot
. Controllers
I Models
I Views
&T appsettings.Development.json
£T appsettings.json
£T global.json
P € Program.cs
P €= Startup.cs

b, - A - i - - T -

s

Figure 2-12. Opening the project in Visual Studio

Choosing a Browser

Visual Studio will open a browser window automatically when the project is run. To select the browser that is used, click the
small arrow to the right of the IIS Express drop-down and select your preferred browser from the Web Browser menu, as shown in
Figure 2-13. I use Google Chrome throughout this book.

alyze Tools Extensions Window Help  Search (Ctrl+Q) R Partylnvites %
ZPU - )IISExpreSSvcvlﬁi|= '0

P IS Express

v IS Express
Partylnvites
Script Debugging (Disabled)
Browse With...

Microsoft Edge

Select Web Browsers...

Figure 2-13. Selecting the browser
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Start Visual Studio Code and select Flle » Open Folder. Navigate to the FirstProject folder and click the Select Folder button. Visual
Studio Code will open the project and display its contents in the Explorer pane, as shown in Figure 2-14. (The default dark theme used
in Visual Studio Code doesn’t show well on the page, so I have changed to the light theme for the screenshots in this book.)

=

File Edit Selection View Go Debug Terminal Help Visual Studio Code

EXPLORER

~ OPEN EDITORS
“ PARTYINVITES
> Controllers
> Models
> obj
> Properties
> Views
> wWwwroot
appsettings.Development.json
appsettings.json
globaljson
R Partylnvites.cspro)
C* Program.cs
C* Startup.cs

> OUTLINE

Figure 2-14. Opening the project in Visual Studio Code

Additional configuration is required the first time you open a .NET Core project in Visual Studio Code. The first step is to click
the Startup.cs file in the Explorer pane. This will trigger a prompt from Visual Studio Code to install the features required for C#
development, as shown in Figure 2-15. If you have opened a C# project before, you will see a prompt that offers to install the required

assets, also shown in Figure 2-15.

The 'C#* extension is recommended for this file type.

3 X

Show Recommendations

Required assets to build and debug are missing from

‘Partyinvites’. Add them?

Source: C# (Extension)

Figure 2-15. Installing Visual Studio Code C# features

£y X

Click the Install or Yes button, as appropriate, and Visual Studio Code will download and install the features required for .NET

Core projects.

19



CHAPTER 2 © GETTING STARTED

Running the ASP.NET Core Application

The template creates a project that contains everything needed to build and run the application. Select Start Without Debugging
from the Debug menu, and Visual Studio will compile and start the example application and then open a new browser window to
send the application an HTTP request, as shown in Figure 2-17. (If you don’t see the Start Without Debugging item in the Debug
menu, then click the Startup.cs file in the Solution Explorer window and check the menu again.)

If you are using Visual Studio Code, select Run Without Debugging in the Debug menu. Since this is the first time the project has
been started, you will be prompted to select an execution environment. Select the .NET Core option, as shown in Figure 2-16.

] File Edit Selection View Go Debug Terminal Help Visual Studio Code  — a X
NET Core
Modoe k
More...
FTUTIRITUNETS
> Models
> obj
-+ 'Y - YV S > Bsanertie ST s bl
P _ ) S _ et o lBOC TiEg o,

Figure 2-16. Selecting an execution environment

Visual Studio Code will create a 1launch. json file that contains the startup settings for the project and that you can ignore
for this book. Select Run Without Debugging from the Debug menu again, and Visual Studio Code will compile the project, start
executing the application, and open a new browser window, as shown in Figure 2-17.

You can also start the application from the command line. Open a new PowerShell command prompt from the Windows Start
menu; navigate to the FirstProject project folder, which is the folder that contains the FirstProject.csproj file; and run the
command shown in Listing 2-4.

Listing 2-4. Starting the Example Application

dotnet run

Once the application has started, you will need to open a new browser window and request http://localhost:5000, which will
produce the response shown in Figure 2-17.

| Home Page - Partylnvites x +

C @ localhost:59307 % O

FirstProject Home Privacy

Welcome

Learn about building Web apps with ASP.NET Core.

© 2020 - FirstProject - Privacy

Figure 2-17. Running the example project
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Tip If you are using Visual Studio Code or running the application from the command line, then ASP.NET Core listens for HTTP
requests on port 5000. If you are using Visual Studio, you will notice that the browser requests a different port, which is chosen when the
project is created. If you look in the Windows taskbar notification area, you will find an icon for IIS Express. This is a cut-down version
of the full IS application server that is included with Visual Studio and is used to deliver ASP.NET Core content and services during
development. In later chapters, | show you how to change the project configuration to use the same HTTP port as Visual Studio Code.

When you are finished, close the browser window that Visual Studio opened. If you are using Visual Studio Code, you click the
stop button displayed in the window that pops up over the code editor. If you started the application from the command line, then
use Control+C to stop execution.

Understanding Endpoints

In an ASP.NET Core application, incoming requests are handled by endpoints. The endpoint that produced the response in Figure 2-17
is an action, which is a method that is written in C#. An action is defined in a controller, which is a C# class that is derived from the
Microsoft.AspNetCore.Mvc.Controller class, the built-in controller base class.

Each public method defined by a controller is an action, which means you can invoke the action method to handle an HTTP
request. The convention in ASP.NET Core projects is to put controller classes in a folder named Controllers, which was created by
the template used to set up the project in Listing 2-3.

The project template added a controller to the Controllers folder to help jump-start development. The controller is defined
in the class file named HomeController.cs. Controller classes contain a name followed by the word Controller, which means that
when you see a file called HomeController. cs, you know that it contains a controller called Home, which is the default controller that
isused in ASP.NET Core applications.

Tip Don’t worry if the terms controller and action don’t make immediate sense. Just keep following the example, and you will see
how the HTTP request sent by the browser is handled by C# code.

Find the HomeController.cs file in the Solution Explorer or Explorer pane and click it to open it for editing. You will see the
following code:

using System;

using System.Collections.Generic;
using System.Diagnostics;

using System.Ling;

using System.Threading.Tasks;

using Microsoft.AspNetCore.Mvc;
using Microsoft.Extensions.Logging;
using FirstProject.Models;

namespace FirstProject.Controllers {
public class HomeController : Controller {
private readonly ILogger<HomeController> _logger;
public HomeController(ILogger<HomeController> logger) {
_logger = logger;

public IActionResult Index() {
return View();
}

public IActionResult Privacy() {
return View();
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[ResponseCache(Duration = 0, Location = ResponseCachelLocation.None,
NoStore = true)]
public IActionResult Error() {
return View(new ErrorViewModel { RequestId = Activity.Current?.Id
?? HttpContext.Traceldentifier });

Using the code editor, replace the contents of the HomeController.cs file so that it matches Listing 2-5. I have removed all but
one of the methods, changed the result type and its implementation, and removed the using statements for unused namespaces.

Listing 2-5. Changing the HomeController.cs File in the Controllers Folder

using Microsoft.AspNetCore.Mvc;
namespace FirstProject.Controllers {
public class HomeController : Controller {

public string Index() {
return "Hello World";
}

The result is that the Home controller defines a single action, named Index. These changes don’t produce a dramatic effect, but
they make for a nice demonstration. I have changed the method named Index so that it returns the string Hello World. Run the
project again by selecting Start Without Debugging or Run Without Debugging from the Debug menu.

The browser will make an HTTP request to the ASP.NET Core server. The configuration of the project created by the template
in Listing 2-5 means the HTTP request will be processed by the Index action defined by the Home controller. Put another way, the
request will be processed by the Index method defined by the HomeController class. The string produced by the Index method is
used as the response to the browser’s HTTP request, as shown in Figure 2-18.

| localhost:5000 X -~

C  ® localhost:5000 w 6 :

Hello World

Figure 2-18. The output from the action method

Understanding Routes

The ASP.NET Core routing system is responsible for selecting the endpoint that will handle an HTTP request. A route is a rule that is
used to decide how a request is handled. When the project was created, a default rule was created to get started. You can request any
of the following URLSs, and they will be dispatched to the Index action defined by the Home controller:

. /
o /Home

o /Home/Index
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So, when a browser requests http://yoursite/ or http://yoursite/Home, it gets back the output from HomeController’s Index
method. You can try this yourself by changing the URL in the browser. At the moment, it will be http://localhost:5000/, except
that the port part may be different if you are using Visual Studio. If you append /Home or /Home/Index to the URL and press Return,
you will see the same Hello World result from the application.

Understanding HTML Rendering

The output from the previous example wasn’t HTML—it was just the string Hello World. To produce an HTML response to a
browser request, [ need a view, which tells ASP.NET Core how to process the result produced by the Index method into an HTML
response that can be sent to the browser.

Creating and Rendering a View

The first thing I need to do is modify my Index action method, as shown in Listing 2-6. The changes are shown in bold, which is a
convention I follow throughout this book to make the examples easier to follow.

Listing 2-6. Rendering a View in the HomeController.cs File in the Controllers Folder

using Microsoft.AspNetCore.Mvc;
namespace FirstProject.Controllers {
public class HomeController : Controller {

public ViewResult Index() {
return View("MyView");
}

When I return a ViewResult object from an action method, I am instructing ASP.NET Core to render a view. I create the
ViewResult by calling the View method, specifying the name of the view that [ want to use, which is MyView. If you run the
application, you can see ASP.NET Core trying to find the view, as shown by the error message displayed in Figure 2-19.

|- Internal Server Error x 4+

C @ localhost:5000 v O

An unhandled exception occurred while processing the request.

InvalidOperationException: The view 'MyView' was not found. The following locations were searched:
/Views/Home/MyView.cshtml
/Views/Shared/MyView.cshtm

Microsoft. AspNetCore. Mvc.ViewEngines.ViewEngineResult.EnsureSuccessful{lEnumerable <string > originalLocations)

Ny Tower Ny SO ey Py o e .

et entn

Figure 2-19. Ttrying to find a view
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This is a helpful error message. It explains that ASP.NET Core could not find the view I specified for the action method and
explains where it looked. Views are stored in the Views folder, organized into subfolders. Views that are associated with the Home
controller, for example, are stored in a folder called Views/Home. Views that are not specific to a single controller are stored in a folder
called Views/Shared. The template used to create the project added the Home and Shared folders automatically and added some
placeholder views to get the project started.

If you are using Visual Studio, right-click the Views/Home folder in the Solution Explorer and select Add » New Item from the
popup menu. Visual Studio will present you with a list of templates for adding items to the project. Locate the Razor View item,
which can be found in the ASP.NET Core » Web » ASP.NET section, as shown in Figure 2-20. Set the name of the new file to
MyView.cshtml and click the Add button. Visual Studio will add a file named MyView. cshtml to the Views/Home folder and will open
it for editing. Replace the contents of the file with those shown in Listing 2-7.

Add Mew Item ? X
4 Installed Sort by: | Default -] 3= Search (Ctrl+E) P~
4 Vi 2 ce - .
s l_j Controller Class Visual C# Te: Voual o
4 ASP.NET Core % :
e Razor View Page
e l-j AP Controller Class Visual C=
Data %
General g
@ Razor Component Visual C#
4 Web
(2]
.hSP.NET @] RazorPage Visual C&
Scripts
ce
Lo E Razor View Visual C=
P Online Fe
Iil Razor Layout Visual C#
ce
@ Razor View Start Visual C#
(]
@ Razor View Imports Visual C=
Mame: _'M)r\.l'jew.cshlml ) i

Figure 2-20. Selecting a Visual Studio item template

Visual Studio Code doesn’t provide item templates. Instead, right-click the Views/Home folder in the file explorer pane and select
New File from the popup menu. Set the name of the file to MyView.cshtml and press Return. The file will be created and opened for
editing. Add the content shown in Listing 2-7.

Tip Itis easy to end up creating the view file in the wrong folder. If you didn’t end up with a file called MyView.cshtml in the
Views/Home folder, then either drag the file into the correct folder or delete the file and try again.

Listing 2-7. The Contents of the MyView.cshtml File in the Views/Home Folder

o{
Layout = null;

}

<!DOCTYPE html>

<html>

<head>
<meta name="viewport" content="width=device-width" />
<title>Index</title>

</head>
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<body>
<div>
Hello World (from the view)
</div>
</body>
</html>

The new contents of the view file are mostly HTML. The exception is the part that looks like this:

ef
Layout = null;
}

This is an expression that will be interpreted by Razor, which is the component that processes the contents of views and
generates HTML that is sent to the browser. Razor is a view engine, and the expressions in views are known as Razor expressions.

The Razor expression in Listing 2-7 tells Razor that I chose not to use a layout, which is like a template for the HTML that will be
sent to the browser (and which I describe in Chapter 22). To see the effect of creating the view, stop ASP.NET Core if it is running and
select Start Without Debugging (for Visual Studio) or Run Without Debugging (for Visual Studio Code) from the Debug menu. A new
browser window will open and produce the response shown in Figure 2-21.

| Index X -

C (@ localhost:5000 Q w O :

Hello World (from the view)

Figure 2-21. Rendering a view

When I first edited the Index action method, it returned a string value. This meant that ASP.NET Core did nothing except pass
the string value as is to the browser. Now that the Index method returns a ViewResult, Razor is used to process a view and render
an HTML response. Razor was able to locate the view because I followed the standard naming convention, which is to put view files
in a folder whose name matched the controller that contains the action method. In this case, this meant putting the view file in the
Views/Home folder, since the action method is defined by the Home controller.

I can return other results from action methods besides strings and ViewResult objects. For example, if I return a
RedirectResult, the browser will be redirected to another URL. If I return an HttpUnauthorizedResult, I can prompt the user
to log in. These objects are collectively known as action results. The action result system lets you encapsulate and reuse common
responses in actions. I'll tell you more about them and explain the different ways they can be used in Chapter 19.

Adding Dynamic Output

The whole point of a web application is to construct and display dyrnamic output. The job of the action method is to construct data
and pass it to the view so it can be used to create HTML content based on the data values. Action methods provide data to views by
passing arguments to the View method, as shown in Listing 2-8. The data provided to the view is known as the view model.
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Listing 2-8. Providing a View Model in the HomeController.cs File in the Controllers Folder

using Microsoft.AspNetCore.Mvc;
using System;

namespace FirstProject.Controllers {
public class HomeController : Controller {
public ViewResult Index() {
int hour = DateTime.Now.Hour;

string viewModel = hour < 12 ? "Good Morning" : "Good Afternoon";
return View("MyView", viewModel);

The view model in this example is a string, and it is provided to the view as the second argument to the View method.
Listing 2-9 updates the view so that it receives and uses the view model in the HTML it generates.

Listing 2-9. Using a View Model in the MyView.cshtml File in the Views/Home Folder

@model string
o{

}

<!DOCTYPE html>

Layout = null;

<html>
<head>
<meta name="viewport" content="width=device-width" />
<title>Index</title>
</head>
<body>
<div>
@Model World (from the view)
</div>
</body>
</html>

The type of the view model is specified using the @model expression, with a lowercase m. The view model value is included in
the HTML output using the @Model expression, with an uppercase M. (It can be difficult at first to remember which is lowercase and

which is uppercase, but it soon becomes second nature.)

When the view is rendered, the view model data provided by the action method is inserted into the HTML response. Select Start
Without Debugging (using Visual Studio) or Run Without Debugging (using Visual Studio Code), and you will see the output shown

in Figure 2-22 (although you may see the afternoon greeting if you are following this example after midday).
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| Index X --

C @ localhost:5000 w 6 :

Good Morning World (from the view)

Figure 2-22. Generating dynamic content

Putting the Pieces Together

It is a simple result, but this example reveals all the building blocks you need to create a simple ASP.NET Core web application and
to generate a dynamic response. The ASP.NET Core platform receives an HTTP request and uses the routing system to match the
request URL to an endpoint. The endpoint, in this case, is the Index action method defined by the Home controller. The method is
invoked and produces a ViewResult object that contains the name of a view and a view model object. The Razor view engine locates
and processes the view, evaluating the @Model expression to insert the data provided by the action method into the response, which
is returned to the browser and displayed to the user. There are, of course, many other features available, but this is the essence of
ASP.NET Core, and it is worth bearing this simple sequence in mind as you read the rest of the book.

Summary

In this chapter, I explained how to get set up for ASP.NET Core development by installing Visual Studio or Visual Studio Code and the
.NET Core SDK. I showed you how to create a simple project and briefly explained how the endpoint, the view, and the URL routing
system work together. In the next chapter, I show you how to create a simple data-entry application.
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CHAPTER 3

Your First ASPNET Core Application

Now that you are set up for ASP.NET Core development, it is time to create a simple application. In this chapter, you'll create a
data-entry application using ASP.NET Core. My goal is to demonstrate ASP.NET Core in action, so I will pick up the pace a little and
skip over some of the explanations as to how things work behind the scenes. But don’t worry; I'll revisit these topics in depth in later
chapters.

Setting the Scene

Imagine that a friend has decided to host a New Year’s Eve party and that she has asked me to create a web app that allows her
invitees to electronically RSVP. She has asked for these four key features:

o Ahome page that shows information about the party

e Aform that can be used to RSVP

o  Validation for the RSVP form, which will display a thank-you page
e Asummary page that shows who is coming to the party

In this chapter, I create an ASP.NET Core project and use it to create a simple application that contains these features; once
everything works, I'll apply some styling to improve the appearance of the finished application.

Creating the Project

Open a PowerShell command prompt from the Windows Start menu, navigate to a convenient location, and run the commands in
Listing 3-1 to create a project named PartyInvites.

Tip You can download the example project for this chapter—and for all the other chapters in this book—from https://github.
com/apress/pro-asp.net-core-3. See Chapter 1 for how to get help if you have problems running the examples.

Listing 3-1. Creating a New Project

dotnet new globaljson --sdk-version 3.1.101 --output PartyInvites
dotnet new mvc --no-https --output PartyInvites --framework netcoreapp3.1

These are the same commands I used to create the project in Chapter 2. If you are a Visual Studio user, I explain how you can
use a wizard to create a project in Chapter 4, but these commands are simple and will ensure you get the right project starting point
that uses the required version of .NET Core.
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Open the project and edit the HomeController.cs file in the Controllers folder, replacing the contents with the code shown in
Listing 3-2.

Listing 3-2. Replacing the Contents of the HomeController.cs File in the Controllers Folder
using Microsoft.AspNetCore.Mvc;

namespace PartyInvites.Controllers {
public class HomeController : Controller {

public IActionResult Index() {
return View();
}

The provides a clean starting point for the new application, defining a single action method that selects the default view for
rendering. To provide a welcome message to party invitees, open the Index.cshtml file in the Views/Home folder and replace the
contents with those shown in Listing 3-3.

Listing 3-3. Replacing the Contents of the Index.cshtml File in the Views/Home Folder

of
Layout = null;
}
<IDOCTYPE html>
<html>
<head>
<meta name="viewport" content="width=device-width" />
<title>Party!</title>
</head>
<body>
<div>
<div>
We're going to have an exciting party.<br />
(To do: sell it better. Add pictures or something.)
</div>
</div>
</body>
</html>

Start the application by selecting Start Without Debugging (for Visual Studio) or Run Without Debugging (for Visual Studio
Code), and you will see the details of the party (well, the placeholder for the details, but you get the idea), as shown in Figure 3-1.

| Party! X
3 C @ localhost:5000 T -

We're going to have an exciting party.
(To do: sell it better. Add pictures or something.)

Figure 3-1. Adding to the view HTML
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Adding a Data Model

The data model is the most important part of any ASP.NET Core application. The model is the representation of the real-world
objects, processes, and rules that define the subject, known as the domain, of the application. The model, often referred to as a
domain model, contains the C# objects (known as domain objects) that make up the universe of the application and the methods
that manipulate them. In most projects, the job of the ASP.NET Core application is to provide the user with access to the data model
and the features that allow the user to interact with it.

The convention for an ASP.NET Core application is that the data model classes are defined in a folder named Models, which was
added to the project by the template used in Listing 3-1.

I don’t need a complex model for the PartyInvites project because it is such a simple application. In fact, I need just one
domain class that I will call GuestResponse. This object will represent an RSVP from an invitee.

If you are using Visual Studio, right-click the Models folder and select Add » Class from the popup menu. Set the name of the
class to GuestResponse. cs and click the Add button. If you are using Visual Studio Code, right-click the Models folder, select New
File, and enter GuestResponse.cs as the file name. Use the new file to define the class shown in Listing 3-4.

Listing 3-4. The Contents of the GuestResponse.cs File in the Models Folder

namespace PartyInvites.Models {
public class GuestResponse {

public string Name { get; set; }
public string Email { get; set; }
public string Phone { get; set; }
public bool? WillAttend { get; set; }

Tip You may have noticed that the WillAttend property is a nullable bool, which means that it can be true, false, or null. |
explain the rationale for this in the “Adding Validation” section later in the chapter.

Creating a Second Action and View

One of my application goals is to include an RSVP form, which means I need to define an action method that can receive requests for
that form. A single controller class can define multiple action methods, and the convention is to group related actions together in the
same controller. Listing 3-5 adds a new action method to the Home controller.

Listing 3-5. Adding an Action Method in the HomeController.cs File in the Controllers Folder

using Microsoft.AspNetCore.Mvc;

namespace PartyInvites.Controllers {
public class HomeController : Controller {

public IActionResult Index() {
return View();
}

public ViewResult RsvpForm() {
return View();
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Both action methods invoke the View method without arguments, which may seem odd, but remember that the Razor view
engine will use the name of the action method when looking for a view file. That means the result from the Index action method tells
Razor to look for a view called Index.cshtml, while the result from the RsvpForm action method tells Razor to look for a view called
RsvpForm.cshtml.

If you are using Visual Studio, right-click the Views/Home folder and select Add » New Item from the popup menu. Select the
Razor View item, set the name to RsvpForm.cshtml, and click the Add button to create the file. Replace the contents with those
shown in Listing 3-6.

If you are using Visual Studio Code, right-click the Views/Home folder and select New File from the popup menu. Set the name of
the file to RsvpForm.cshtml and add the contents shown in Listing 3-6.

Listing 3-6. The Contents of the RsvpForm.cshtml File in the Views/Home Folder

of

Layout = null;
}
<!DOCTYPE html>
<html>
<head>

<meta name="viewport" content="width=device-width" />
<title>RsvpForm¢/title>
</head>
<body>
<div>
This is the RsvpForm.cshtml View
</div>
</body>
</html>

This content is just static HTML for the moment. To test the new action method and view, start the application by selecting Start
Without Debugging or Run Without Debugging from the Debug menu.

Using the browser window that is opened, request http://localhost:5000/home/rsvpform. (If you are using Visual Studio, you
will have to change the port to the one assigned when the project was created.) The Razor view engine locates the RsvpForm. cshtml
file and uses it to produce a response, as shown in Figure 3-2.

|l RsvpForm

e C @ localhost:5000/home/rsvpform w :

This is the RsvpForm.cshtml View

Figure 3-2. Rendering a second view

Linking Action Methods

I'want to be able to create a link from the Index view so that guests can see the RsvpForm view without having to know the URL that
targets a specific action method, as shown in Listing 3-7.
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Listing 3-7. Adding a Link in the Index.cshtml File in the Views/Home Folder

of
Layout = null;
}

<!DOCTYPE html>
<html>
<head>
<meta name="viewport" content="width=device-width" />
<title>Party!</title>
</head>
<body>
<div>
<div>
We're going to have an exciting party.<br />
(To do: sell it better. Add pictures or something.)
</div>
<a asp-action="RsvpFoxm"»RSVP Now</a)
</div>
</body>
</html>

The addition to the listing is an a element that has an asp-action attribute. The attribute is an example of a tag helper attribute,
which is an instruction for Razor that will be performed when the view is rendered. The asp-action attribute is an instruction to add
an href attribute to the a element that contains a URL for an action method. I explain how tag helpers work in Chapters 25-27, but
this tag helper tells Razor to insert a URL for an action method defined by the same controller for which the current view is being
rendered. You can see the link that the helper creates by running the project, as shown in Figure 3-3.

| Party! 3

|- RsvpForm

&« C @ localhost:5000

& @ localhost:5000/Home/RsvpForm
We're going to have an exciting - B e 2 ;
{fo-do~selli better. Add pi s or sq This is the RsvpForm.cshtml View
RSVP Now

Figure 3-3. Linking between action methods

Roll the mouse over the RSVP Now link in the browser. You will see that the link points to the following URL (allowing for the
different port number that Visual Studio will have assigned to your project):

http://localhost:5000/Home/RsvpForm

There is an important principle at work here, which is that you should use the features provided by ASP.NET Core to generate
URLs, rather than hard-code them into your views. When the tag helper created the href attribute for the a element, it inspected the
configuration of the application to figure out what the URL should be. This allows the configuration of the application to be changed
to support different URL formats without needing to update any views.

Building the Form

Now that I have created the view and can reach it from the Index view, [ am going to build out the contents of the RsvpForm.cshtml
file to turn it into an HTML form for editing GuestResponse objects, as shown in Listing 3-8.
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Listing 3-8. Creating a Form View in the RsvpForm.cshtml File in the Views/Home Folder

@model PartyInvites.Models.GuestResponse
of

}

<!DOCTYPE html>

Layout = null;

<html>

<head>
<meta name="viewport" content="width=device-width" />
<title>RsvpForm</title>

</head>
<body>
<form asp-action="RsvpForm" method="post"»
<divy
<label asp-for="Name"s>Your name:</labels
<input asp-for="Name" />
</div>
<divy
<label asp-for="Email">Your email:</labels
<input asp-for="Email" />
</divy
<div>
<label asp-for="Phone"s>Your phone:</labels
<input asp-for="Phone" />
</div>
<div>
<label>Will you attend?</label>
<select asp-for="WillAttend"»>
<option value=""»>Choose an option</options
<option value="true">Yes, I'll be there</option>
<option value="false"sNo, I can't come</option>
</select>
</div>
<button type="submit">Submit RSVP</button>
</formy
</body>
</html>

The @model expression specifies that the view expects to receive a GuestResponse object as its view model. I have defined a
label and input element for each property of the GuestResponse model class (or, in the case of the WillAttend property, a select
element). Each element is associated with the model property using the asp-for attribute, which is another tag helper attribute.
The tag helper attributes configure the elements to tie them to the view model object. Here is an example of the HTML that the tag
helpers produce:

<p>

<label for="Name">Your name:</label>

<input type="text" id="Name" name="Name" value="">
</p>

The asp-for attribute on the label element sets the value of the for attribute. The asp-for attribute on the input element
sets the id and name elements. This may not look especially useful, but you will see that associating elements with a model property
offers additional advantages as the application functionality is defined.
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Of more immediate use is the asp-action attribute applied to the form element, which uses the application’s URL routing
configuration to set the action attribute to a URL that will target a specific action method, like this:

<form method="post" action="/Home/RsvpForm">

As with the helper attribute I applied to the a element, the benefit of this approach is that you can change the system of URLs
that the application uses, and the content generated by the tag helpers will reflect the changes automatically.
You can see the form by running the application and clicking the RSVP Now link, as shown in Figure 3-4.

| Party! x | RsvpForm
<« C @ localhost:5000 < C @ localhost:5000/Home/RsvpForm b
We're going to have an excitin Your name: _
Ho-de=selt better. Add _piettires or | Your email:
RSVP Now Your phone:
Will you attend? Choose an option »
Submit RSVP

Figure 3-4. Adding an HTML form to the application

Receiving Form Data

I have not yet told ASP.NET Core what I want to do when the form is posted to the server. As things stand, clicking the Submit RSVP
button just clears any values you have entered in the form. That is because the form posts back to the RsvpForm action method in
the Home controller, which just renders the view again. To receive and process submitted form data, I am going to use an important
feature of controllers. I will add a second RsvpForm action method to create the following:

o A method that responds to HTTP GET requests: A GET request is what a browser issues normally each time
someone clicks a link. This version of the action will be responsible for displaying the initial blank form when
someone first visits /Home/RsvpForm.

e A method that responds to HTTP POST requests: By default, forms rendered using Html.BeginForm() are
submitted by the browser as a POST request. This version of the action will be responsible for receiving
submitted data and deciding what to do with it.

Handing GET and POST requests in separate C# methods helps to keep my controller code tidy since the two methods have different
responsibilities. Both action methods are invoked by the same URL, but ASP.NET Core makes sure that the appropriate method is
called, based on whether I am dealing with a GET or POST request. Listing 3-9 shows the changes to the HomeController class.

Listing 3-9. Adding a Method in the HomeController.cs File in the Controllers Folder

using Microsoft.AspNetCore.Mvc;
using PartyInvites.Models;

namespace PartyInvites.Controllers {
public class HomeController : Controller {

public IActionResult Index() {

return View();
}

[HttpGet]

public ViewResult RsvpForm() {
return View();

}
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[HttpPost]

public ViewResult RsvpForm(GuestResponse guestResponse) {
// TODO: store response from guest
return View();

I'have added the HttpGet attribute to the existing RsvpForm action method, which declares that this method should be used
only for GET requests. I then added an overloaded version of the RsvpForm method, which accepts a GuestResponse object. I applied
the HttpPost attribute to this method, which declares that the new method will deal with POST requests. I explain how these
additions to the listing work in the following sections. I also imported the PartyInvites.Models namespace—this is just so I can
refer to the GuestResponse model type without needing to qualify the class name.

Understanding Model Binding

The first overload of the RsvpForm action method renders the same view as before—the RsvpForm.cshtml file—to generate the form
shown in Figure 3-4. The second overload is more interesting because of the parameter, but given that the action method will be
invoked in response to an HTTP POST request and that the GuestResponse type is a C# class, how are the two connected?

The answer is model binding, a useful ASP.NET Core feature whereby incoming data is parsed and the key/value pairs in the
HTTP request are used to populate properties of domain model types.

Model binding is a powerful and customizable feature that eliminates the grind of dealing with HTTP requests directly and
lets you work with C# objects rather than dealing with individual data values sent by the browser. The GuestResponse object that is
passed as the parameter to the action method is automatically populated with the data from the form fields. I dive into the details of
model binding in Chapter 28.

To demonstrate how model binding works, I need to do some preparatory work. One of the application goals is to present a
summary page with details of who is attending the party, which means that I need to keep track of the responses that I receive. I am
going to do this by creating an in-memory collection of objects. This isn’t useful in a real application because the response data will
be lost when the application is stopped or restarted, but this approach will allow me to keep the focus on ASP.NET Core and create
an application that can easily be reset to its initial state. Later chapters will demonstrate persistent data storage.

Add a class file named Repository.cs to the Models folder and use it to define the class shown in Listing 3-10.

Listing 3-10. The Contents of the Repository.cs File in the Models Folder
using System.Collections.Generic;
namespace PartyInvites.Models {
public static class Repository {
private static List<GuestResponse> responses = new List<GuestResponse>();

public static IEnumerable<GuestResponse> Responses => responses;

public static void AddResponse(GuestResponse response) {
responses.Add(response);
}

The Repository class and its members are static, which will make it easy for me to store and retrieve data from different places
in the application. ASP.NET Core provides a more sophisticated approach for defining common functionality, called dependency
injection, which I describe in Chapter 14, but a static class is a good way to get started for a simple application like this one.

Storing Responses

Now that I have somewhere to store the data, I can update the action method that receives the HTTP POST requests, as shown in
Listing 3-11.
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Listing 3-11. Updating an Action Method in the HomeController.cs File in the Controllers Folder

using Microsoft.AspNetCore.Mvc;
using PartyInvites.Models;

namespace PartyInvites.Controllers {
public class HomeController : Controller {

public IActionResult Index() {
return View();
}

[HttpGet]

public ViewResult RsvpForm() {
return View();

}

[HttpPost]

public ViewResult RsvpForm(GuestResponse guestResponse) {
Repository.AddResponse(guestResponse);
return View("Thanks", guestResponse);

Before the POST version of the RsvpForm method is invoked, the ASP.NET Core model binding feature extracts values from
the HTML form and assigns them to the properties of the GuestResponse object. The result is used as the argument when the
method is invoked to handle the HTTP request, and all T have to do to deal with the form data sent in a request is to work with the
GuestResponse object that is passed to the action method—in this case, to pass it as an argument to the Repository.AddResponse
method so that the response can be stored.

Adding the Thanks View

The call to the View method in the RsvpForm action method creates a ViewResult that selects a view called Thanks and uses the
GuestResponse object created by the model binder as the view model. Add a Razor View named Thanks.cshtml to the Views/Home
folder with the content shown in Listing 3-12 to present a response to the user.

Listing 3-12. The Contents of the Thanks.cshtml File in the Views/Home Folder

@model PartyInvites.Models.GuestResponse

of

Layout = null;
}
<!DOCTYPE html>
<html>
<head>

<meta name="viewport" content="width=device-width" />
<title>Thanks</title>
</head>
<body>
<div>
<h1>Thank you, @Model.Name!</h1>
@if (Model.WillAttend == true) {
@:It's great that you're coming. The drinks are already in the fridge!
} else {
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@:Sorry to hear that you can't make it, but thanks for letting us know.
}
</div>
Click <a asp-action="ListResponses">here</a> to see who is coming.
</body>
</html>

The HTML produced by the Thanks.cshtml view depends on the values assigned to the GuestResponse view model provided
by the RsvpForm action method. To access the value of a property in the domain object, [ use an @Model.<PropertyName> expression.
So, for example, to get the value of the Name property, I use the @odel.Name expression. Don’t worry if the Razor syntax doesn’t make
sense—I explain it in more detail in Chapter 21.

Now that I have created the Thanks view, I have a basic working example of handling a form. Start the application, click the
RSVP Now link, add some data to the form, and click the Submit RSVP button. You will see the response shown in Figure 3-5
(although it will differ if your name is not Joe or you said you could not attend).

r |5 Pamtyl

€ 2 C O localho

|- Thanks

“

C @ localhostS000/Home/RsvpForm

| RsvpForm

We're going to have] < C’ (@ibaterinn

sellif better.| vy yr nape: [Joe
RSVF Now Your email: joe@example.com

Your phone: §55-1234
i ? Yes LWBethere

Thank you, Joe!

It's great that you're coming. The drinks are already in the fridge!
Click here to see who is coming.

Submit RSVP

Figure 3-5. The Thanks view

Displaying the Responses

At the end of the Thanks.cshtml view, I added an a element to create a link to display the list of people who are coming to the party.
Tused the asp-action tag helper attribute to create a URL that targets an action method called ListResponses, like this:

<div>Click <a asp-action="ListResponses">here</a> to see who is coming.</div>

If you hover the mouse over the link that is displayed by the browser, you will see that it targets the /Home/ListResponses URL.
This doesn’t correspond to any of the action methods in the Home controller, and if you click the link, you will see a 404 Not Found
error response.

To add an endpoint that will handle the URL, I need to add another action method to the Home controller, as shown in
Listing 3-13.

Listing 3-13. Adding an Action Method in the HomeController.cs File in the Controllers Folder

using Microsoft.AspNetCore.Mvc;
using PartyInvites.Models;
using System.Linq;

namespace PartyInvites.Controllers {
public class HomeController : Controller {

public IActionResult Index() {
return View();
}

38



CHAPTER 3 * YOUR FIRST ASP.NET CORE APPLICATION

[HttpGet]

public ViewResult RsvpForm() {
return View();

}

[HttpPost]

public ViewResult RsvpForm(GuestResponse guestResponse) {
Repository.AddResponse(guestResponse);
return View("Thanks", guestResponse);

}

public ViewResult ListResponses() {
return View(Repository.Responses.Where(r => r.WillAttend == true));
}

The new action method is called ListResponses, and it calls the View method, using the Repository.Responses property as the
argument. This will cause Razor to render the default view, using the action method name as the name of the view file, and to use the
data from the repository as the view model. The view model data is filtered using LINQ so that only positive responses are provided

to the view.
Add a Razor View named ListResponses.cshtml to the Views/Home folder with the content shown in Listing 3-14.

Listing 3-14. Displaying Acceptances in the ListResponses.cshtml File in the Views/Home Folder

@model IEnumerable<PartyInvites.Models.GuestResponse>

of
}

<!DOCTYPE html>

Layout = null;

<html>
<head>
<meta name="viewport" content="width=device-width" />
<title>Responses</title>
</head>
<body>
<h2>Here is the list of people attending the party</h2>
<table>
<thead>
<tr><th>Name</th><th>Email</th><th>Phone</th></tr>
</thead>
<tbody>
@foreach (PartyInvites.Models.GuestResponse r in Model) {
<tr>
<td>@r.Name</td>
<td>@r.Email</td>
<td>@r.Phone</td>
</tr>
}
</tbody>
</table>
</body>
</html>
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Razor view files have the . cshtml file extension because they are a mix of C# code and HTML elements. You can see this in
Listing 3-14 where [ have used a @foreach expression to process each of the GuestResponse objects that the action method passes
to the view using the View method. Unlike a normal C# foreach loop, the body of a Razor @foreach expression contains HTML
elements that are added to the response that will be sent back to the browser. In this view, each GuestResponse object generates a tr
element that contains td elements populated with the value of an object property.

Start the application, submit some form data, and click the link to see the list of responses. You will see a summary of the data
you have entered since the application was started, as shown in Figure 3-6. The view does not present the data in an appealing way,
but it is enough for the moment, and I will address the styling of the application later in this chapter.

| Responses X

&« C (@© localhost:5000/Home/ListResponses Yr :

Here is the list of people attending the party

Name Email Phone
Joe joe@example.com 555-1234
Alice alice@example.com 555-6789

Figure 3-6. Showing a list of party attendees

Adding Validation

I can now add data validation to the application. Without validation, users could enter nonsense data or even submit an empty
form. In an ASP.NET Core application, validation rules are defined by applying attributes to model classes, which means the same
validation rules can be applied in any form that uses that class. ASP.NET Core relies on attributes from the System.ComponentModel.
DataAnnotations namespace, which I have applied to the GuestResponse class in Listing 3-15.

Listing 3-15. Applying Validation in the GuestResponse.cs File in the Models Folder

using System.ComponentModel.DataAnnotations;
namespace PartyInvites.Models {
public class GuestResponse {

[Required(ErroxMessage = "Please enter your name")]
public string Name { get; set; }

[Required(ErrorMessage = "Please enter your email address")]
[EmailAddress]
public string Email { get; set; }

[Required(ErrorMessage = "Please enter your phone number")]
public string Phone { get; set; }

[Required(ErrorMessage = "Please specify whether you'll attend")]
public bool? WillAttend { get; set; }
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ASP.NET Core detects the attributes and uses them to validate data during the model-binding process.

Tip As noted earlier, | used a nullable bool for the WillAttend property. I did this so that | could apply the Required validation
attribute. If | had used a regular bool, the value | received through model binding could be only true or false, and | would not be able to
tell whether the user had selected a value. A nullable bool has three possible values: true, false, and null. The browser sends a null
value if the user has not selected a value, and this causes the Required attribute to report a validation error. This is a nice example of
how ASP.NET Core elegantly blends C# features with HTML and HTTP.

I check to see whether there has been a validation problem using the ModelState.IsValid property in the action method that
receives the form data, as shown in Listing 3-16.

Listing 3-16. Checking for Validation Errors in the HomeController.cs File in the Controllers Folder

using Microsoft.AspNetCore.Mvc;
using PartyInvites.Models;
using System.Ling;

namespace PartyInvites.Controllers {
public class HomeController : Controller {

public IActionResult Index() {
return View();
}

[HttpGet]

public ViewResult RsvpForm() {
return View();

}

[HttpPost]
public ViewResult RsvpForm(GuestResponse guestResponse) {
if (ModelState.IsValid) {
Repository.AddResponse(guestResponse);
return View("Thanks", guestResponse);
} else {
return View();
}

}

public ViewResult ListResponses() {
return View(Repository.Responses.Where(r => r.WillAttend == true));
}

The Controller base class provides a property called ModelState that provides details of the outcome of the model binding
process. If the ModelState.IsValid property returns true, then I know that the model binder has been able to satisfy the validation
constraints I specified through the attributes on the GuestResponse class. When this happens, I render the Thanks view, just as I did
previously.

If the ModelState.IsValid property returns false, then I know that there are validation errors. The object returned by the
ModelState property provides details of each problem that has been encountered, but I don’t need to get into that level of detail
because I can rely on a useful feature that automates the process of asking the user to address any problems by calling the View
method without any parameters.
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When it renders a view, Razor has access to the details of any validation errors associated with the request, and tag helpers can
access the details to display validation errors to the user. Listing 3-17 shows the addition of validation tag helper attributes to the
RsvpFormview.

Listing 3-17. Adding a Validation Summary to the RsvpForm.cshtml File in the Views/Home Folder

@model PartyInvites.Models.GuestResponse

of

Layout = null;
}
<!DOCTYPE html>
<html>
<head>

<meta name="viewport" content="width=device-width" />
<title>RsvpForm¢/title>
</head>
<body>
<form asp-action="RsvpForm" method="post">
<div asp-validation-summary="A11"></div>
<div>
<label asp-for="Name">Your name:</label>
<input asp-for="Name" />
</div>
<div>
<label asp-for="Email">Your email:</label>
<input asp-for="Email" />
</div>
<div>
<label asp-for="Phone">Your phone:</label>
<input asp-for="Phone" />
</div>
<div>
<label>Will you attend?</label>
<select asp-for="WillAttend">
<option value="">Choose an option</option>
<option value="true">Yes, I'll be there</option>
<option value="false">No, I can't come</option>
</select>
</div>
<button type="submit">Submit RSVP</button>
</form>
</body>
</html>

The asp-validation-summary attribute is applied to a div element, and it displays a list of validation errors when the view
isrendered. The value for the asp-validation-summary attribute is a value from an enumeration called ValidationSummary,
which specifies what types of validation errors the summary will contain. I specified AL1, which is a good starting point for most
applications, and I describe the other values and explain how they work in Chapter 29.

To see how the validation summary works, run the application, fill out the Name field, and submit the form without entering any
other data. You will see a summary of validation errors, as shown in Figure 3-7.
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| RsvpForm X

&« C @ localhost:5000/Home/RsvpForm T :

« Please enter your email address
» Please enter your phone number
« Please specify whether you'll attend

Your name: Joe

Your email:

Your phone:

Will you attend? | Choose an option ¥
Submit RSVP

Figure 3-7. Displaying validation errors

The RsvpForm action method will not render the Thanks view until all the validation constraints applied to the GuestResponse
class have been satisfied. Notice that the data entered in the Name field was preserved and displayed again when Razor rendered the
view with the validation summary. This is another benefit of model binding, and it simplifies working with form data.

Highlighting Invalid Fields

The tag helper attributes that associate model properties with elements have a handy feature that can be used in conjunction with
model binding. When a model class property has failed validation, the helper attributes will generate slightly different HTML. Here
is the input element that is generated for the Phone field when there is no validation error:

<input type="text" data-val="true" data-val-required="Please enter your phone number" id="Phone" name="Phone"

value="">

For comparison, here is the same HTML element after the user has submitted the form without entering data into the text field
(which is a validation error because I applied the Required attribute to the Phone property of the GuestResponse class):

<input type="text" class="input-validation-error" data-val="true"
data-val-required="Please enter your phone number" id="Phone"

name="Phone" value="">

I have highlighted the difference: the asp-for tag helper attribute added the input element to a class called input-validation-
error. I can take advantage of this feature by creating a stylesheet that contains CSS styles for this class and the others that different
HTML helper attributes use.

The convention in ASP.NET Core projects is that static content delivered to clients is placed into the wawroot folder and
organized by content type so that CSS stylesheets go into the wwwroot/css folder, JavaScript files go into the wawroot/js folder, and
S0 on.

Tip Visual Studio creates a site.css file in the wwwroot/css folder when a project is created using the Web Application template.
You can ignore this file, which | don’t use in this chapter.

If you are using Visual Studio, right-click the wwwroot/css folder and select Add » New Item from the popup menu. Locate the
Style Sheet item template, as shown in Figure 3-8; set the name of the file to styles.css; and click the Add button.
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Add New Item - Partylnvites

4 Installed Sort by: | Default ~| & [i= Search (Ctrl+E) P~
4 Visual C# -
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a%|  SCSS Style Sheet (SASS] Visual C#
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Content
b Online
Name: [styles.css

Figure 3-8. Creating a CSS stylesheet

If you are using Visual Studio Code, right-click the wwwroot/css folder, select New File from the popup menu, and use
styles.css as the file name. Regardless of which editor you use, replace the contents of the file with the styles shown in Listing 3-18.

Listing 3-18. The Contents of the styles.css File in the wwwroot/css Folder

.field-validation-error {color: #f00;}

.field-validation-valid { display: none;}

.input-validation-error { border: 1px solid #f00; background-color: #fee; }
.validation-summary-errors { font-weight: bold; color: #f00;}
.validation-summary-valid { display: none;}

To apply this stylesheet, I added a 1ink element to the head section of the RsvpForm view, as shown in Listing 3-19.

Listing 3-19. Applying a Stylesheet in the RsvpForm.cshtml File in the Views/Home Folder

<head>
<meta name="viewport" content="width=device-width" />
<title>RsvpForm</title>
<link rel="stylesheet" href="/css/styles.css" /»
</head>

The link element uses the href attribute to specify the location of the stylesheet. Notice that the wwwroot folder is omitted
from the URL. The default configuration for ASP.NET includes support for serving static content, such as images, CSS stylesheets,
and JavaScript files, and it maps requests to the wwwroot folder automatically. With the application of the stylesheet, a more obvious
validation error will be displayed when data is submitted that causes a validation error, as shown in Figure 3-9.
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| RsvpForm b 4

&« C @ localhost:5000/Home/RsvpForm r :

« Please enter your email address
« Please enter your phone number
+ Please specify whether you'll attend

Your name: Joe

Your email: | |

Your phone: | |

Will you attend? | Choose an option ¥ |
Submit RSVP

Figure 3-9. Automatically highlighted validation errors

Styling the Content

All the functional goals for the application are complete, but the overall appearance of the application is poor. When you create

a project using the mvc template, as I did for the example in this chapter, some common client-side development packages are
installed. While I am not a fan of using template projects, I do like the client-side libraries that Microsoft has chosen. One of them is
called Bootstrap, which is a good CSS framework originally developed by Twitter that has become a major open source project and a
mainstay of web application development.

Styling the Welcome View

The basic Bootstrap features work by applying classes to elements that correspond to CSS selectors defined in the files added to the
wwwroot/1ib/bootstrap folder. You can get full details of the classes that Bootstrap defines from http://getbootstrap.com, but you
can see how I have applied some basic styling to the Index.cshtml view file in Listing 3-20.

Listing 3-20. Adding Bootstrap to the Index.cshtml File in the Views/Home Folder

of

Layout = null;
}
<!DOCTYPE html>
<html>
<head>

<meta name="viewport" content="width=device-width" />
<link rel="stylesheet" href="/lib/bootstrap/dist/css/bootstrap.css" />
<title>Index</title>
</head>
<body>
<div class="text-center"»
<h3> We're going to have an exciting party!</h3>
<h4>And YOU are invited!</h4>
<a class="btn btn-primary" asp-action="RsvpForm">RSVP Now</a»
</div>
</body>
</html>
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I have added a 1ink element whose href attribute loads the bootstrap.css file from the wawroot/1ib/bootstrap/dist/css
folder. The convention is that third-party CSS and JavaScript packages are installed into the wawroot/1ib folder, and I describe the
tool that is used to manage these packages in Chapter 12.

Having imported the Bootstrap stylesheets, I need to style my elements. This is a simple example, so I need to use only a small
number of Bootstrap CSS classes: text-center, btn, and btn-primary.

The text-center class centers the content of an element and its children. The btn class styles a button, input, or a element as
a pretty button, and the btn-primary class specifies which of a range of colors I want the button to be. You can see the effect by
running the application, as shown in Figure 3-10.

I Wndex x
& & @® localhost:5000 ¢ :
We're going to have an exciting party!

And YOU are invited!

RSVP Now

Figure 3-10. Styling a view

It will be obvious to you that I am not a web designer. In fact, as a child, I was excused from art lessons on the basis that I had
absolutely no talent whatsoever. This had the happy result of making more time for math lessons but meant that my artistic skills
have not developed beyond those of the average 10-year-old. For a real project, I would seek a professional to help design and style
the content, but for this example, I am going it alone, and that means applying Bootstrap with as much restraint and consistency as I
can muster.

Styling the Form View

Bootstrap defines classes that can be used to style forms. I am not going to go into detail, but you can see how I have applied these
classes in Listing 3-21.

Listing 3-21. Adding Bootstrap to the RsvpForm.cshtml File in the Views/Home Folder

@model PartyInvites.Models.GuestResponse

of

Layout = null;
}
<!DOCTYPE html>
<html>
<head>

<meta name="viewport" content="width=device-width" />

<title>RsvpForm¢/title>

<link rel="stylesheet" href="/css/styles.css" />

<link rel="stylesheet" href="/lib/bootstrap/dist/css/bootstrap.css" />
</head>
<body>

<h5 class="bg-primary text-white text-center m-2 p-2">RSUP</h5>

<form asp-action="RsvpForm" method="post" class="m-2"»

<div asp-validation-summary="A11"></div>

46



CHAPTER 3

<div class="form-group"s
<label asp-for="Name">Your name:</label>
<input asp-for="Name" class="form-control" />
</div>
<div class="form-group"s
<label asp-for="Email">Your email:</label>
<input asp-for="Email" class="form-control" /»
</div>
<div class="form-group"s
<label asp-for="Phone">Your phone:</label>
<input asp-for="Phone" class="form-control" /»
</div>
<div class="form-group"»
<label>Will you attend?</label>
<select asp-for="WillAttend" class="form-control"»
<option value="">Choose an option</option>
<option value="true">Yes, I'll be there</option>
<option value="false">No, I can't come</option>
</select>
</div>
<button type="submit" class="btn btn-primary"sSubmit RSVP</button>

</form>

</body>
</html>

YOUR FIRST ASP.NET CORE APPLICATION

The Bootstrap classes in this example create a header, just to give structure to the layout. To style the form, I have used the
form-group class, which is used to style the element that contains the label and the associated input or select element, which is
assigned to the form-control class. You can see the effect of the styles in Figure 3-11.

I
&

Your

RSVP

Your email:

Your phone:

Will you attend?

Choose an option ¥

Submit RSVP

RsvpForm X

C @ localhost:5000/Home/RsvpForm w

name:

Figure 3-11. Styling the RsupForm view
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Styling the Thanks View

The next view file to style is Thanks.cshtml, and you can see how I have done this in Listing 3-22, using CSS classes that are similar
to the ones I used for the other views. To make an application easier to manage, it is a good principle to avoid duplicating code and
markup wherever possible. ASP.NET Core provides several features to help reduce duplication, which I describe in later chapters.
These features include Razor layouts (Chapter 22), partial views (Chapter 22), and view components (Chapter 24).

Listing 3-22. Applying Bootstrap to the Thanks.cshtml File in the Views/Home Folder

@model PartyInvites.Models.GuestResponse

of

Layout = null;
}
<!DOCTYPE html>
<html>
<head>

<meta name="viewport" content="width=device-width" />
<title>Thanks</title>
<link rel="stylesheet" href="/lib/bootstrap/dist/css/bootstrap.css" />
</head>
<body class="text-center"s
<div>
<h1>Thank you, @Model.Name!</h1>
@if (Model.WillAttend == true) {
@:It's great that you're coming. The drinks are already in the fridge!
} else {
@:Sorry to hear that you can't make it, but thanks for letting us know.
}

</div>

Click <a asp-action="ListResponses">here</a> to see who is coming.</div>
</body>
</html>

Figure 3-12 shows the effect of the styles.

| Thanks x

- C @ localhost:5000/Home/RsvpForm 7 :

Thank you, Joe!

It's great that you're coming. The drinks are already in the fridge!
Click here to see who is coming.

Figure 3-12. Styling the Thanks view

48



CHAPTER 3 * YOUR FIRST ASP.NET CORE APPLICATION

Styling the List View

The final view to style is ListResponses, which presents the list of attendees. Styling the content follows the same approach as used
for the other views, as shown in Listing 3-23.

Listing 3-23. Adding Bootstrap to the ListResponses.cshtml File in the Views/Home Folder

@model IEnumerable<PartyInvites.Models.GuestResponse>

of
}

<!DOCTYPE html>

Layout = null;

<html>
<head>
<meta name="viewport" content="width=device-width" />
<title>Responses</title>
<link rel="stylesheet" href="/lib/bootstrap/dist/css/bootstrap.css" />
</head>
<body>
<div class="text-center p-2"»
<h2>Here is the list of people attending the party</h2>
<table class="table table-bordered table-striped table-sm"»
<thead>
<tr><th>Name</th><th>Email</th><th>Phone</th></tr>
</thead>
<tbody>
@foreach (PartyInvites.Models.GuestResponse r in Model) {
<tr>
<td>@r.Name</td>
<td>@r.Email</td>
<td>@r.Phone</td>
</tr>
}
</tbody>
</table>
</div>
</body>
</html>

Figure 3-13 shows the way that the table of attendees is presented. Adding these styles to the view completes the example
application, which now meets all the development goals and has an improved appearance.
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| Responses x

& C @ localhost:5000/Home/ListResponses T :

Here is the list of people attending the party

Name Email Phone
Joe joe@example.com 555-1234
Alice alice@example.com 555-5678
Dora dora@example.com 555-1111

Figure 3-13. Styling the ListResponses view

Summary

In this chapter, I created a new ASP.NET Core project and used it to construct a simple data-entry application, giving you a first
glimpse of important ASP.NET features, such as tag helpers, model binding, and data validation. In the next chapter, I describe the
development tools that are used for ASP.NET Core development.
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Using the Development Tools

In this chapter, I introduce the tools that Microsoft provides for ASP.NET Core development and that are used throughout this book.
Unlike earlier editions of this book, I rely on the command-line tools provided by the .NET Core SDK and additional tool
packages that Microsoft publishes. In part, I have done this to help ensure you get the expected results from the examples but also
because the command-line tools provide access to all the features required for ASP.NET Core development, regardless of which

editor/IDE you have chosen.

Visual Studio—and, to a lesser extent, Visual Studio Code—offers access to some of the tools through user interfaces, which I
describe in this chapter, but Visual Studio and Visual Studio Code don’t support all the features that are required for ASP.NET Core
development, so there are times that using the command line is inevitable.

As ASP.NET Core has evolved, I have gradually moved to using just the command-line tools, except for when I need to use a
debugger (although, as I explain later in the chapter, this is a rare requirement). Your preferences may differ, especially if you are
used to working entirely within an IDE, but my suggestion is to give the command-line tools a go. They are simple, concise, and
predictable, which cannot be said for all the equivalent functionality provided by Visual Studio and Visual Studio Code. Table 4-1
summarizes the chapter.

Table 4-1. Chapter Summary

Problem Solution Listing
Creating a project Use the dotnet new commands or the Visual Studio wizard 1-4
Building and running Use the dotnet build and dotnet run commands or use the menus provided by Visual =~ 5-7
projects Studio and Visual Studio Code

Adding packages to a Use the dotnet add package command or use the Visual Studio package manager 8-10
project

Installing tool commands Use the dotnet tool command 11,12
Managing client-side Use the 1ibman command or the Visual Studio client-side package manager 13-16
packages

Creating ASP.NET Core Projects

The .NET Core SDK includes a set of command-line tools for creating, managing, building, and running projects. Visual Studio
provides integrated support for some of these tasks, but if you are using Visual Studio Code, then the command line is the only
option.

Iuse the command-line tools even when working with Visual Studio because they are simple and concise, while the Visual
Studio features tend to require more effort to locate the templates or settings I require. In the sections that follow, I show you how to
create and use both sets of tools. The results are the same whichever approach you choose, and you can freely switch between Visual
Studio and the command-line tools.

Tip You can download the example project for this chapter—and for all the other chapters in this book—from https://github.
com/apress/pro-asp.net-core-3. See Chapter 1 for how to get help if you have problems running the examples.
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Creating a Project Using the Command Line

The dotnet command provides access to the .NET Core command-line features. The dotnet new command is used to create a new
project, configuration file, or solution file. To see the list of templates available for creating new items, open a PowerShell command
prompt and run the command shown in Listing 4-1.

Listing 4-1. Listing the .NET Core Templates
dotnet new

Each template has a short name that makes it easier to use. There are a lot of templates available, but Table 4-2 describes the
ones that are most useful for creating ASP.NET Core projects.

Table 4-2. Useful ASP.NET Core Project Templates

Name Description

web This template creates a project that is set up with the minimum code and content required for ASP.NET Core
development. This is the template I use for most of the chapters in this book.

mvc This template creates an ASP.NET Core project configured to use the MVC Framework.

webapp This template creates an ASP.NET Core project configured to use Razor Pages.

blazorserver  Thistemplate creates an ASP.NET Core project configured to use Blazor Server.

angular This template creates an ASP.NET Core project that contains client-side features using the Angular JavaScript
framework.

react This template creates an ASP.NET Core project that contains client-side features using the React JavaScript
framework.

reactredux This template creates an ASP.NET Core project that contains client-side features using the React JavaScript

framework and the popular Redux library.

There are also templates that create commonly required files used to configure projects, as described in Table 4-3.

UNDERSTANDING THE LIMITATIONS OF PROJECT TEMPLATES

The project templates described in Table 4-2 are intended to help jump-start development by taking care of basic configuration
settings and adding placeholder content.

These templates can give you a sense of rapid progress, but they contain assumptions about how a project should be configured
and developed. If you don’t understand the impact of those assumptions, you won’t be able to get the results you require for the
specific demands of your project.

The web template creates a project with the minimum configuration required for ASP.NET Core development. This is the project
template | use for most of the examples in this book so that | can explain how each feature is configured and how the features
can be used together.

Once you understand how ASP.NET Core works, the other project templates can be useful because you will know how to adapt
them to your needs. But, while you are learning, | recommend sticking to the web template, even though it can take a little more
effort to get results.
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Table 4-3. The Configuration Item Templates

Name Description
globaljson This template adds a global. json file to a project, specifying the version of .NET Core that will be used.
sln This template creates a solution file, which is used to group multiple projects and is commonly used by Visual

Studio. The solution file is populated with the dotnet sln add command, as shown in the following listing.

gitignore This template creates a .gitignore file that excludes unwanted items from Git source control.

To create a project, open a new PowerShell command prompt and run the commands shown in Listing 4-2.

Listing 4-2. Creating a New Project

dotnet new globaljson --sdk-version 3.1.101 --output MySolution/MyProject
dotnet new web --no-https --output MySolution/MyProject --framework netcoreapp3.i
dotnet new sln -o MySolution

dotnet sln MySolution add MySolution/MyProject

The first command creates a MySolution/MyProject folder that contains a global. json file, which specifies that the project
will use .NET Core version 3.1.1. The top-level folder, named MySolution, is used to group multiple projects together. The nested
MyProject folder will contain a single project.

Tuse the globaljson template to help ensure you get the expected results when following the examples in this book. Microsoft
is good at ensuring backward compatibility with .NET Core releases, but breaking changes do occur, and it is a good idea to add a
global. json file to projects so that everyone in the development team is using the same version.

The second command creates the project using the web template, which I use for most of the examples in this book. As noted
in Table 4-3, this template creates a project with the minimum content required for ASP.NET Core development. Each template has
its own set of arguments that influence the project that is created. The --no-https argument creates a project without support for
HTTPS. (I explain how to use HTTPS in Chapter 16.) The - -framework argument selects the .NET Core runtime that will be used for
the project.

The other commands create a solution file that references the new project. Solution files are a convenient way of opening
multiple related files at the same time. A MySolution.sln file is created in the MySolution folder, and opening this file in Visual
Studio will load the project created with the web template. This is not essential, but it stops Visual Studio from prompting you to
create the file when you exit the code editor.

Opening the Project

To open the project, start Visual Studio, select “Open a Project or Solution,” and open the MySolution.sln file in the MySolution
folder. Visual Studio will open the solution file, discover the reference to the project that was added by the final command in
Listing 4-2, and open the project as well.

Visual Studio Code works differently. Start Visual Studio Code, select File » Open Folder, and navigate to the MySolution folder.
Click Select Folder, and Visual Studio Code will open the project.

Although Visual Studio Code and Visual Studio are working with the same project, each displays the contents differently. Visual
Studio Code shows you a simple list of files, ordered alphabetically, as shown on the left of Figure 4-1. Visual Studio hides some files
and nests others within related file items, as shown on the right of Figure 4-1.
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Figure 4-1. Opening a project in Visual Studio Code and Visual Studio

There are buttons at the top of the Visual Studio Solution Explorer that disable file nesting and show the hidden items in the
project. When you open a project for the first time in Visual Studio Code, you may be prompted to add assets for building and

debugging the project, as shown in Figure 4-2. Click the Yes button.

Required assets to build and debug are missing from
‘MySolution’. Add them?

Source: C# (Extension) Don't Ask Again m

& X

Figure 4-2. Adding assets in Visual Studio Code

Creating a Project Using Visual Studio

Visual Studio creates projects in the same way, using the same templates, but provides a wizard. Although my preference is to use
the command line, the result is the same if you pay close attention to the options you choose along the way. Start Visual Studio and
click “Create a New Project,” Then select the ASP.NET Core Web Application category, as shown in Figure 4-3, and click the Next

button.
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Figure 4-3. Creating a new project in Visual Studio

Enter MyProject in the “Project name” field and MySolution in the “Solution name” field, as shown in Figure 4-4. Use the
Location field to select a convenient folder in which to create the project and click the Create button.

Project name

Configure your new project

ASP.NET Core Web Application ¢ tmx  macos

MyProject

Windows

Cloud Service Web

Location

Solution name

C:\Users\adam\Source\Repos

MySolution

[] Place solution and project in the same directory

Figure 4-4. Selecting the project and solution names

The next step requires close attention, and because it is so prone to errors, I have used the command-line tools for the examples
in this book. First, use the drop-downs at the top of the window to select .NET Core and ASP.NET Core 3.1. Next, select the Empty
template from the list. Even though the name Empty is used, the content added to the project corresponds to the web template.

Uncheck the Configure for HTTPS option—which is equivalent to the --no-https command-line argument—and ensure the
Enable Docker Support option is unchecked that the Authentication option is set to No Authentication, as shown in Figure 4-5.
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Create a new ASP.NET Core web application

-NET Core = |ASP.NET Core 3.1 -
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@API

A project template for creating an ASP.NET Core application with an example Controller for a RESTul HTTP senvice.
This template can also be used for ASP.NET Core MVC Views and Controllers.

Advanced

@ Web Application [ ] Configure for HTTPS

A project template for creating an ASP.NET Core application with example ASP.NET Razor Pages content. |— Enable Docker Support

ires Docker Deskt
@ Web Application (Model-View-Controller) (Requires Docker Desktop)

A project template for creating an ASP.NET Core application with example ASP.NET Core MVC Views and
Controllers. This template can also be used for RESTul HTTP services.

e Angular

A project template for creating an ASP.NET Core application with Angular

_'-_f_( Reactjs Author: Microsoft
Saln Pk ¥  Source: NET Core 3.1.1

Get additicnal project templates

Back Create

Figure 4-5. Selecting and configuring the project template

Click the Create button, and Visual Studio will create the project and the solution file and then open them for editing, as shown
in Figure 4-6.

Solution Explorer e = be
co@e-|o-a®|u-| s
Search Solution Explorer (Ctrl+;) P

2] Solution 'MySolution' (1 of 1 project)
4 ] MyProject

& Connected Services

P %' Dependencies
b M Properties
4 [T appsettings,json
£T appsettings.Development.json
b €= Program.cs
b = Startup.cs

Figure 4-6. The new project in the Visual Studio Solution Explorer

Once the project has been opened, right-click the MyProject item in the Solution Explorer window and select Add » New Item
from the popup menu. Locate the JSON File item from the list of templates and set the Name field to global. json. Click the Add
button to create the file and replace its contents with those shown in Listing 4-3.
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Listing 4-3. The Contents of the global.json File in the MyProject Folder
{
n Sdkll : {
"version": "3.1.101"
}

Adding the global. json file ensures the right version of the .NET Core SDK will be used by the project.

Adding Code and Content to Projects

If you are using Visual Studio Code, then you add items to the project by right-clicking the folder that should contain the file and
selecting New File from the popup menu (or selecting New Folder if you are adding a folder).

Note You are responsible for ensuring that the file extension matches the type of item you want to add; for example, an HTML file
must be added with the .html extension. | give the complete file name and the name of the containing folder for every item added to a
project throughout this book, so you will always know exactly what files you need to add.

Right-click the MyProject item in the file explorer page, select New Folder, and set the name to wwwroot, which is where static
content is stored in ASP.NET Core projects. Press Enter, and a folder named wwwroot will be added to the project. Right-click the new
wwwroot folder, select New Item, and set the name to demo. html. Press Enter to create the HTML file and add the content shown in
Listing 4-4.

Listing 4-4. The Contents of the demo.html File in the wwwroot Folder

<!DOCTYPE html>
<html>
<head>
<meta charset="utf-8" />
<title></title>
</head>
<body>
<h3>HTML File from MyProject</h3>
</body>
</html>

Visual Studio provides a more comprehensive approach that can be helpful but only when used selectively. To create a folder,
right-click the MyProject item in the Solution Explorer and select Add » New Folder from the popup menu. Set the name of the new
item to wwwroot and press Enter; Visual Studio will create the folder.

Right-click the new wwwroot item in the Solution Explorer and select Add » New Item from the popup menu. Visual Studio will
present you with an extensive selection of templates for adding items to the project. These templates can be searched using the text
field in the top-right corner of the window or filtered using the categories on the left of the window. The item template for an HTML
file is named HTML Page, as shown in Figure 4-7.

57



CHAPTER 4 * USING THE DEVELOPMENT TOOLS

Add New Item - MyProject ? X
4 |nstalled Sort by: | Default - gg’ = Search (Ctrl+E) P -
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Scripts '-'.'.'.-I‘.-“.'] Y s ) o
Content
b Online
MName: demo.html
Add || Cancel

Figure 4-7. Adding an item to the example project

Enter demo.html in the Name field, click the Add button to create the new file, and replace the contents with the element
shown in Listing 4-4. (If you omit the file extension, Visual Studio will add it for you based on the item template you have selected.
If you entered just demo into the Name field when you created the file, Visual Studio would have created a file with the .html
extension because you had selected the HTML Page item template.)

Understanding Item Scaffolding

The item templates presented by Visual Studio can be useful, especially for C# classes where it sets the namespace and class name
automatically. But Visual Studio also provides scaffolded items, which I recommend against using. The Add » New Scaffolded Item
leads to a selection of items that guide you through a process to add more complex items. Visual Studio will also offer individual
scaffolded items based on the name of the folder that you are adding an item to. For example, if you right-click a folder named Views,
Visual Studio will helpfully add scaffolded items to the top of the menu, as shown in Figure 4-8.
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Figure 4-8. Scaffolded items in the Add menu
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Container Orchestrator Support...
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Application Insights Telemetry...
Client-Side Library...

New Azure WebJob Project
Existing Project as Azure Weblob

Class...

The View and Controller items are scaffolded, and selecting them will present you with choices that determine the content of

the items you create.

Just like the project templates, I recommend against using scaffolded items, at least until you understand the content they
create. In this book, I use only the Add » New Item menu for the examples and change the placeholder content immediately.

Building and Running Projects

You can build and run projects from the command line or from within Visual Studio and Visual Studio Code. To prepare, add the

statement shown in Listing 4-5 to the Startup.cs class file in the MyProject folder.

Listing 4-5. Adding a Statement in the Startup.cs File in the MyProject Folder

using System;

using System.Collections.Generic;

using System.Ling;

using System.Threading.Tasks;

using Microsoft.AspNetCore
using Microsoft.AspNetCore
using Microsoft.AspNetCore
using Microsoft.Extensions
using Microsoft.Extensions

.Builder;

.Hosting;

JHttp;
.DependencyInjection;
.Hosting;
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namespace MyProject {
public class Startup {

public void ConfigureServices(IServiceCollection services) {

}

public void Configure(IApplicationBuilder app, IWebHostEnvironment env) {
if (env.IsDevelopment()) {
app.UseDeveloperExceptionPage();
app.UseStaticFiles();
app.UseRouting();
app.UseEndpoints(endpoints => {

endpoints.MapGet("/", async context => {
await context.Response.WriteAsync("Hello World!");

}s
};

This statement adds support for responding to HTTP requests with static content in the wwwroot folder, such as the HTML file
created in the previous section. (I explain this feature in more detail in Chapter 15.)

Building and Running Projects Using the Command Line

To build the example project, run the command shown in Listing 4-6 in the MyProject or MySolution folder.

Listing 4-6. Building the Project
dotnet build

You can build and run the project in a single step by running the command shown in Listing 4-7 in the MyProject folder.

Listing 4-7. Building and Running the Project
dotnet run

The compiler will build the project and then start the integrated ASP.NET Core HTTP server to listen for HTTP requests on port
5000. You can see the contents of the static HTML file added to the project earlier in the chapter by opening a new browser window
and requesting http://localhost:5000/demo.html, which produces the response shown in Figure 4-9.
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@ localhost:5000/demo.html

o C @ localhost:5000/demo.html T :

HTML File from MyProject

Figure 4-9. Running the example application

Building and Running Projects Using Visual Studio Code

Visual Studio Code can build and execute the project for you if you prefer not to use the command line. Select Terminal » Run Build
Task, and Visual Studio Code will compile the project.

To build and run the project in a single step, select Debug Run » Without Debugging. Visual Studio Code will compile and
run the project and open a new browser window that will send an HTTP request to the ASP.NET Core server and produce the
placeholder response. Request http://localhost:5000/demo.html, and you will receive the response shown in Figure 4-9.

Building and Running Projects Using Visual Studio

Visual Studio uses IIS Express as a reverse proxy for the built-in ASP.NET Core HTTP server that is used directly when you use the
dotnet run command. When the project is created, an HTTP port is picked for IIS Express to use. To change the HTTP port to the
one used throughout this book, select Project » MyProject Properties and select the Debug section. Locate the App URL field and
change the port number in the URL to 5000, as shown in Figure 4-10.

o MysSolution - MyProject
MyProject” & X

Application

Build

Build Events "“
Package Web Serve

Debug” App URL: http://localhost:5000
Signing

: IIS Express Bitness: | Default
Code Analysis

TypeScript Build Hosting Model: Default (In Process)
Resources [] Enable SSL
Enable Anonymous Authentication
[T] Enable Windows Authentication

Figure 4-10. Changing the application port number
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Select File » Save All to apply the changes. To build the project, select Build Solution or Build MyProject from the Build menu.
To build and run the project, select Debug » Start Without Debugging. Once the project has been compiled, Visual Studio will open
a new browser window, which sends an HTTP request that is received by IIS Express and passes it to the ASP.NET Core HTTP server,
producing a placeholder response set up by the template used to create the project. Request http://localhost:5000/demo.html,
and you will see the response shown in Figure 4-9.

Tip IS Express is generally reliable, but if you have problems, right-click the IIS Express icon in the Windows taskbar’s System Tray
and select Exit from the popup menu.

Managing Packages

Most projects require additional features beyond those set up by the project templates, such as support for accessing databases or
for making HTTP requests, neither of which is included in the standard ASP.NET Core packages added to the project by the template
used to create the example project. In the sections that follow, I describe the tools available to manage the different types of packages
that are used in ASP.NET Core development.

Managing NuGet Packages

.NET packages are added to a project with the dotnet add package command. Use a PowerShell command prompt to run the
command shown in Listing 4-8 in the MyProject folder to add a package to the example project.

Listing 4-8. Adding a Package to the Example Project
dotnet add package Microsoft.EntityFrameworkCore.SqlServer --version 3.1.1

This command installs version 3.1.1 of the Microsoft.EntityFrameworkCore.SqlServer package. The package repository for
.NET projects is nuget.org, where you can search for the package and see the versions available. The package installed in Listing 4-8,
for example, is described at https://www.nuget.org/packages/Microsoft.EntityFrameworkCore.SqlServer/3.1.1.

You can see the packages installed in a project by running the command shown in Listing 4-9.

Tip The project file—which is the file with the . csproj extension—is used to keep track of the packages added to a project. You
can examine this file by opening it for editing in Visual Studio Code or by right-clicking the project item in the Visual Studio Solution
Explorer and selecting Edit Project File from the popup menu.

Listing 4-9. Listing the Packages in a Project

dotnet list package

This command produces the following output when it is run in the MyProject folder, showing the package added in Listing 4-8:

[netcoreapp3.1]:
Top-level Package Requested Resolved
> Microsoft.EntityFrameworkCore.SqlServer 3.1.1 3.1.1

Packages are removed with the dotnet remove package command. To remove the package from the example project, run the
command shown in Listing 4-10 in the MyProject folder.
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Listing 4-10. Removing a Package from the Example Project

dotnet remove package Microsoft.EntityFrameworkCore.SqlServer

Managing Tool Packages

Tool packages install commands that can be used from the command line to perform operations on .NET Core projects. One
common example is the Entity Framework Core tools package that installs commands that are used to manage databases in ASP.
NET Core projects. Tool packages are managed using the dotnet tool command. To install the Entity Framework Core tools
package, run the commands shown in Listing 4-11.

Listing 4-11. Installing a Tool Package

dotnet tool uninstall --global dotnet-ef
dotnet tool install --global dotnet-ef --version 3.1.1

The first command removes the dotnet-ef package, which is named dotnet-ef. This command will produce an error if the
package has not already been installed, but it is a good idea to remove existing versions before installing a package. The dotnet tool
install command installs version 3.1.1 of the dotnet-ef package, which is the version I use in this book. The commands installed
by tool packages are used through the dotnet command. To test the package installed in Listing 4-11, run the command shown in
Listing 4-12 in the MyProject folder.

Tip The --global arguments in Listing 4-11 mean the package is installed for global use and not just for a specific project. You can
install tool packages into just one project, in which case the command is accessed with dotnet tool run <command>. The tools | use in
this book are all installed globally.

Listing 4-12. Running a Tool Package Command
dotnet ef --help

The commands added by this tool package are accessed using dotnet ef, and you will see examples in later chapters that rely
on these commands.

Managing Client-Side Packages

Client-side packages contain content that is delivered to the client, such as images, CSS stylesheets, JavaScript files, and static
HTML. Client-side packages are added to ASP.NET Core using the Library Manager (LibMan) tool. To install the LibMan tool
package, run the commands shown in Listing 4-13.

Listing 4-13. Installing the LibMan Tool Package

dotnet tool uninstall --global Microsoft.Web.LibraryManager.Cli
dotnet tool install --global Microsoft.Web.LibraryManager.Cli --version 2.0.96

These commands remove any existing LibMan package and install the version that is used throughout this book. The next step
is to initialize the project, which creates the file that LibMan uses to keep track of the client packages it installs. Run the command
shown in Listing 4-14 in the MyProject folder to initialize the example project.
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Listing 4-14. Initializing the Example Project

libman init -p cdnjs

LibMan can download packages from different repositories. The -p argument in Listing 4-14 specifies the repository at
https://cdnjs.com, which is the most widely used. Once the project is initialized, client-side packages can be installed. To install
the Bootstrap CSS framework that I use to style HTML content throughout this book, run the command shown in Listing 4-15 in the
MyProject folder.

Listing 4-15. Installing the Bootstrap CSS Framework

libman install twitter-bootstrap@4.3.1 -d wwwroot/lib/twitter-bootstrap

The command installs version 4.3.1 of the Bootstrap package, which is known by the name twitter-bootstrap on the CDNJS
repository. There is some inconsistency in the way that popular packages are named on different repositories, and it is worth
checking that you are getting the package you expect before adding to your project. The -d argument specifies the location into
which the package is installed. The convention in ASP.NET Core projects is to install client-side packages into the wawroot/1ib
folder.

Once the package has been installed, add the classes shown in Listing 4-16 to the elements in the demo. html file. This is how the
features provided by the Bootstrap package are applied.

Note |don’t get into the details of using the Bootstrap CSS framework in this book. See https://getbootstrap.com for the
Bootstrap documentation.

Listing 4-16. Applying Bootstrap Classes in the demo.html File in the wwwroot Folder

<!DOCTYPE html>
<html>
<head>
<meta charset="utf-8" />
<titlex</title>
<link href="/1ib/twitter-bootstrap/css/bootstrap.min.css" rel="stylesheet" />
</head>
<body>
<h3 class="bg-primary text-white text-center p-2"»
HTML File from MyProject
</h3>
</body>
</html>

Start ASP.NET Core and request http://localhost:5000/demo.html, and you will see the styled content shown in Figure 4-11.
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HTML File from MyProject

Figure 4-11. Using a client-side package

Managing Packages Using Visual Studio

Visual Studio provides tools for managing packages without using the command line. Select Project » Manage NuGet Packages, and
Visual Studio will open the NuGet package manager tool. Click Browse and enter Microsoft.EntityFrameworkCore.SqlServer into
the search box to search for matching packages. Click the Microsoft.EntityFrameworkCore.SqlServer entry, which should be at
the top of the list, and you will be able to choose a version and install the package, as shown in Figure 4-12.

Caution The Visual Studio NuGet package manager cannot be used to install global tool packages, which can be installed only from
the command line.
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Figure 4-12. Using the Visual Studio package manager

The Visual Studio NuGet package manager can also be used to inspect the packages that have been installed in the project and
check whether new versions of packages are available.
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Managing Client-Side Packages Using Visual Studio

Visual Studio provides a separate tool for managing client-side packages. Right-click the MyProject item in the Solution Explorer and
select Add » Client Side Library from the popup menu. The client-side package tool is rudimentary, but it allows you to perform
basic searches, select the files that are added to the project, and set the install location, as shown in Figure 4-13.

Add Client-Side Library X

Provider: cdnjs ¥

Library: ‘ twitter-bootstrap@4.3.1

@ Include all library files
() Choose specific files:

4 Files:
4 css

bootstrap-grid.css
[ bootstrap-grid.css.map
bootstrap-grid.min.css
[ bootstrap-grid.min.css.map
bootstrap-reboot.css
[ bootstrap-reboot.css.map
bootstrap-reboot.min.css
[ bootstrap-reboot.min.css.map
[V bootstrap.css

Target Location: | wwwroot/lib/twitter-bootstrap/

Install H Cancel

Figure 4-13. Using the Visual Studio client-side package manager

Debugging Projects

Visual Studio and Visual Studio Code both provide debuggers that can be used to control and inspect the execution of an ASP.NET
Core application. Open the Startup.cs file in the MyProject folder, and click this statement in the code editor:

await context.Response.WriteAsync("Hello World!");

Select Debug » Toggle Breakpoint, which is available in both Visual Studio and Visual Studio Code. A breakpoint is shown as a
red dot alongside the code statement, as shown in Figure 4-14, and will interrupt execution and pass control to the user.

Start the project by selecting Debug » Start Debugging, which is available in both Visual Studio and Visual Studio Code.
(Choose .NET Core if Visual Studio Code prompts you to select an environment and then select the Start Debugging menu item
again.)
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Figure 4-14. Setting a breakpoint

The application will be started and continue normally until the statement to which the breakpoint is reached, at which point
execution is halted. Execution can be controlled using the Debug menu or the controls that Visual Studio and Visual Studio Code
display. Both debuggers are packed with features—more so if you have a paid-for version of Visual Studio—and I don’t describe
them in depth in this book. The Visual Studio 2019 debugger is described at https://docs.microsoft.com/en-us/visualstudio/
debugger/?view=vs-2019, and the Visual Studio Code debugger is described at https://code.visualstudio.com/docs/editor/
debugging.

HOW I DEBUG MY CODE

Debuggers are powerful tools, but | rarely use them. In most situations, | prefer to add System.Console.WriteLine Statements
to my code to figure out what is going on, which | can easily do because | tend to use the dotnet run command to run my
projects from the command line. This is a rudimentary approach that works for me, not least because most of the errors in

my code tend to be where statements are not being called because a condition in an if statement isn’t effective. If | want to
examine an object in detalil, | tend to serialize it to JSON and pass the result to the WriteLine method.

This may seem like madness if you are a dedicated user of the debugger, but it has the advantage of being quick and simple.
When | am trying to figure out why code isn’t working, | want to explore and iterate quickly, and | find the amount of time taken
to start the debugger to be a barrier. My approach is also reliable. The Visual Studio and Visual Studio Code debuggers are
sophisticated, but they are not always entirely predictable, and .NET Core and ASP.NET Core change too quickly for the debugger
features to have entirely settled down. When | am utterly confused by the behavior of some code, | want the simplest possible
diagnostic tool, and that, for me, is a message written to the console.

| am not suggesting that this is the approach you should use, but it can be a good place to start when you are not getting the
results you expect and you don’t want to battle with the debugger to figure out why.

Summary

In this chapter, I described the tools used for ASP.NET Core development. I explained that the command-line tools are the most
concise and reliable way to work with ASP.NET Core projects, which is why I have used them in the examples in this book. I also
demonstrated the alternative user interfaces that Visual Studio and Visual Studio Code provide, which can be a useful alternative for
some—but not all—of the command-line tools. In the next chapter, I describe the C# feature that are essential for effective ASP.NET
Core development.
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CHAPTER 5

Essential C# Features

In this chapter, I describe C# features used in web application development that are not widely understood or that often cause
confusion. This is not a book about C#, however, so I provide only a brief example for each feature so that you can follow the
examples in the rest of the book and take advantage of these features in your own projects. Table 5-1 summarizes this chapter.

Table 5-1. Chapter Summary

Problem Solution Listing
Managing null values Use the null conditional and null coalescing operators 7,10
Creating properties with getters and setters Define automatically implemented properties 11-13
Mixing static and dynamic values in strings Use string interpolation 14
Initializing and populate objects Use the object and collection initializers 15-18
Assigning a value for specific types Use pattern matching 19, 20
Extending the functionality of a class without modifyingit =~ Define an extension method 21-28
Expressing functions and methods concisely Use lambda expressions 29-36
Defining a variable without explicitly declaring its type Use the var keyword 37-39
Modifying an interface without requiring changes in its Define a default implementation 40-44
implementation classes

Performing work asynchronously Use tasks or the async/await keywords 45-47
Producing a sequence of values over time Use an asynchronous enumerable 48-51
Getting the name of a class or member Use a nameof expression 52,53

Preparing for This Chapter

To create the example project for this chapter, open a new PowerShell command prompt and run the commands shown in
Listing 5-1. If you are using Visual Studio and prefer not to use the command line, you can create the project using the process

described in Chapter 4.

Tip You can download the example project for this chapter—and for all the other chapters in this book—from https://github.
com/apress/pro-asp.net-core-3. See Chapter 1 for how to get help if you have problems running the examples.

© Adam Freeman 2020

A. Freeman, Pro ASP.NET Core 3, https://doi.org/10.1007/978-1-4842-5440-0_5
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Listing 5-1. Creating the Example Project

dotnet new globaljson --sdk-version 3.1.101 --output LanguageFeatures
dotnet new web --no-https --output LanguageFeatures --framework netcoreapp3.1
dotnet new sln -o LanguageFeatures

dotnet sln LanguageFeatures add LanguageFeatures

Opening the Project

If you are using Visual Studio, select File » Open » Project/Solution, select the LanguageFeatures.sln file in the LanguageFeatures
folder, and click the Open button to open the solution file and the project it references. If you are using Visual Studio Code, select File
» Open Folder, navigate to the LanguageFeatures folder, and click the Select Folder button.

Enabling the MVC Framework

The web project template creates a project that contains a minimal ASP.NET Core configuration. This means the placeholder content
that is added by the mvc template used in Chapter 3 is not available and that extra steps are required to reach the point where the
application can produce useful output. In this section, I make the changes required to set up the MVC Framework, which is one of
the application frameworks supported by ASP.NET Core, as I explained in Chapter 1. First, to enable the MVC framework, make the
changes shown in Listing 5-2 to the Startup class.

Listing 5-2. Enabling MVC in the Startup.cs File in the LanguageFeatures Folder

using System;

using System.Collections.Generic;

using System.Ling;

using System.Threading.Tasks;

using Microsoft.AspNetCore.Builder;

using Microsoft.AspNetCore.Hosting;

using Microsoft.AspNetCore.Http;

using Microsoft.Extensions.DependencyInjection;
using Microsoft.Extensions.Hosting;

namespace LanguageFeatures {
public class Startup {
public void ConfigureServices(IServiceCollection services) {
services.AddControllersilithViews();
}

public void Configure(IApplicationBuilder app, IWebHostEnvironment env) {
if (env.IsDevelopment()) {
app.UseDeveloperExceptionPage();
}

app.UseRouting();

app.UseEndpoints(endpoints => {
//endpoints.MapGet("/", async context =» {
2 await context.Response.WiriteAsync("Hello World!");
11});
endpoints.MapDefaultControllerRoute();

};
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I explain how to configure ASP.NET Core applications in Part 2, but the two statements added in Listing 5-2 provide a basic MVC
framework setup using a default configuration.

Creating the Application Components

Now that the MVC framework is set up, I can add the application components that I will use to demonstrate important C# language
features.

Creating the Data Model

I started by creating a simple model class so that I can have some data to work with. I added a folder called Models and created a
class file called Product.cs within it, which I used to define the class shown in Listing 5-3.

Listing 5-3. The Contents of the Product.cs File in the Models Folder

namespace LanguageFeatures.Models {
public class Product {

public string Name { get; set; }
public decimal? Price { get; set; }

public static Product[] GetProducts() {
Product kayak = new Product {

Name = "Kayak", Price = 275M
b

Product lifejacket = new Product {
Name = "Lifejacket", Price = 48.95M
b

return new Product[] { kayak, lifejacket, null };

The Product class defines Name and Price properties, and there is a static method called GetProducts that returns a Product
array. One of the elements contained in the array returned by the GetProducts method is set to null, which I will use to demonstrate
some useful language features later in the chapter.

Creating the Controller and View

For the examples in this chapter, I use a simple controller class to demonstrate different language features. I created a Controllers
folder and added to it a class file called HomeController.cs, the contents of which are shown in Listing 5-4.

Listing 5-4. The Contents of the HomeController.cs File in the Controllers Folder

using Microsoft.AspNetCore.Mvc;

namespace LanguageFeatures.Controllers {
public class HomeController : Controller {

public ViewResult Index() {
return View(new string[] { "C#", "Language", "Features" });
}
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The Index action method tells ASP.NET Core to render the default view and provides it with an array of strings as its view model,
which will be included in the HTML sent to the client. To create the view, I added a Views/Home folder (by creating a Views folder and
then adding a Home folder within it) and added a Razor View called Index.cshtml, the contents of which are shown in Listing 5-5.

Listing 5-5. The Contents of the Index.cshtml File in the Views/Home Folder

@model IEnumerable<string>
@{ Layout = null; }

<!DOCTYPE html>
<html>
<head>
<meta name="viewport" content="width=device-width" />
<title>language Features</title>
</head>
<body>
<ul>
@foreach (string s in Model) {
<li>@s</1i>
}

</ul>
</body>
</html>

Selecting the HTTP Port

If you are using Visual Studio, select Project » LanguageFeatures Properties, select the Debug section, and change the HTTP port to
5000 in the App URL field, as shown in Figure 5-1. Select File » Save All to save the new port. (This change is not required if you are
using Visual Studio Code.)

m LanguageFeatures - LanguageFeatures
Languagefeatures &= X
Application

Build

Build Events L ENEUIT UL JTIVE! USUUYgIng

N/A

Package Web Server Settings

Debug r -
App URL: | httpw/localhost:5000
Signing
IIS Express Bitness: aul

Code Analysis

TypeScript Build Hosting Model: Dafault (In Process)
Resources [] Enable SSL
Enable Ancnymous Authentication
[T] Enable Windows Authentication

Figure 5-1. Setting the HTTP port

Running the Example Application

Start ASP.NET Core by selecting Start Without Debugging (Visual Studio) or Run Without Debugging (Visual Studio Code) from the
Debug menu or by running the command shown in Listing 5-6 in the LanguageFeatures folder.
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Listing 5-6. Running the Example Application

dotnet run

Request http://localhost:5000, and you will see the output shown in Figure 5-2.

@ Language Features X

g C @ localhost:5000 1 -

e C#
e Language
» Features

Figure 5-2. Running the example application

Since the output from all the examples in this chapter is text, I will show the messages displayed by the browser like this:

CH#
Language
Features

Using the Null Conditional Operator

The null conditional operator allows for null values to be detected more elegantly. There can be a lot of checking for nulls in
ASP.NET Core development as you work out whether a request contains a specific header or value or whether the model contains a
specific data item. Traditionally, dealing with null values requires making an explicit check, which can become tedious and error-
prone when both an object and its properties need to be inspected. The null conditional operator makes this process simpler and
more concise, as shown in Listing 5-7.

Listing 5-7. Detecting null Values in the HomeController.cs File in the Controllers Folder

using Microsoft.AspNetCore.Mvc;
using System.Collections.Generic;
using LanguageFeatures.Models;

namespace LanguageFeatures.Controllers {
public class HomeController : Controller {

public ViewResult Index() {
List<string> results = new List<string>();
foreach (Product p in Product.GetProducts()) {
string name = p?.Name;

decimal? price = p?.Price;
results.Add(string.Format("Name: {0}, Price: {1}", name, price));
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return View(results);

The static GetProducts method defined by the Product class returns an array of objects that I inspect in the Index
action method to get a list of the Name and Price values. The problem is that both the object in the array and the value of
the properties could be null, which means I can’t just refer to p.Name or p.Price within the foreach loop without causing a
NullReferenceException. To avoid this, I used the null conditional operator, like this:

string name = p?.Name;
decimal? price = p?.Price;

The null conditional operator is a single question mark (the ? character). If p is null, then name will be set to null as well. If p
is not null, then name will be set to the value of the Person.Name property. The Price property is subject to the same test. Notice
that the variable you assign to when using the null conditional operator must be able to be assigned null, which is why the price
variable is declared as a nullable decimal (decimal?).

Chaining the Null Conditional Operator

The null conditional operator can be chained to navigate through a hierarchy of objects, which is where it becomes an effective tool
for simplifying code and allowing safe navigation. In Listing 5-8, I have added a property to the Product class that creates a more
complex object hierarchy.

Listing 5-8. Adding a Property in the Product.cs File in the Models Folder

namespace LanguageFeatures.Models {
public class Product {

public string Name { get; set; }
public decimal? Price { get; set; }
public Product Related { get; set; }
public static Product[] GetProducts() {

Product kayak = new Product {
Name = "Kayak", Price = 275M
};

Product lifejacket = new Product {

Name = "Lifejacket", Price = 48.95M
b
kayak.Related = lifejacket;

return new Product[] { kayak, lifejacket, null };

Each Product object has a Related property that can refer to another Product object. In the GetProducts method, I set the
Related property for the Product object that represents a kayak. Listing 5-9 shows how I can chain the null conditional operator to
navigate through the object properties without causing an exception.
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Listing 5-9. Detecting Nested null Values in the HomeController.cs File in the Controllers Folder

using Microsoft.AspNetCore.Mvc;
using System.Collections.Generic;
using LanguageFeatures.Models;

namespace LanguageFeatures.Controllers {
public class HomeController : Controller {

public ViewResult Index() {
List<string> results = new List<string>();

foreach (Product p in Product.GetProducts()) {
string name = p?.Name;
decimal? price = p?.Price;
string relatedName = p?.Related?.Name;
results.Add(string.Format("Name: {0}, Price: {1}, Related: {2}",
name, price, relatedName));

}

return View(results);

The null conditional operator can be applied to each part of a chain of properties, like this:
string relatedName = p?.Related?.Name;

The result is that the relatedName variable will be null when p is null or when p.Related is null. Otherwise, the variable will
be assigned the value of the p.Related.Name property. Restart ASP.NET Core and request http://localhost:5000, and you will see
the following output in the browser window:

Name: Kayak, Price: 275, Related: Lifejacket
Name: Lifejacket, Price: 48.95, Related:
Name: , Price: , Related:

Combining the Conditional and Coalescing Operators

It can be useful to combine the null conditional operator (a single question mark) with the null coalescing operator (two question
marks) to set a fallback value to prevent null values being used in the application, as shown in Listing 5-10.

Listing 5-10. Combining Null Operators in the HomeController.cs File in the Controllers Folder

using Microsoft.AspNetCore.Mvc;
using System.Collections.Generic;
using LanguageFeatures.Models;

namespace LanguageFeatures.Controllers {
public class HomeController : Controller {
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public ViewResult Index() {
List<string> results = new List<string>();

foreach (Product p in Product.GetProducts()) {
string name = p?.Name ?? "<No Name>";
decimal? price = p?.Price ?? 0;
string relatedName = p?.Related?.Name ?? "<None>";
results.Add(string.Format("Name: {0}, Price: {1}, Related: {2}",
name, price, relatedName));

}

return View(results);

The null conditional operator ensures that I don’t get a Nul1ReferenceException when navigating through the object

properties, and the null coalescing operator ensures that I don’t include null values in the results displayed in the browser. If you
run the example, you will see the following results displayed in the browser window:

Name: Kayak, Price: 275, Related: Lifejacket
Name: Lifejacket, Price: 48.95, Related: <None>
Name: <No Namey, Price: 0, Related: <None»

NULLABLE AND NON-NULLABLE REFERENCE TYPES
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Encountering unexpected null values is one of the most common causes of bugs. By default, C# treats null as a valid value for
all types, which means that | can assign null to a string variable, like this:

string product = null;

It is the responsibility of the code that uses the variable to check for null values, which can be especially problematic when the
same variable is in multiple places. It is easy to omit one of the checks or assume that a value won’t be null, producing an error
at runtime.

Nullable reference types shift responsibility for null checking to the code that assigns the value to a variable. When the nullable
reference feature is enabled, regular reference types cannot be assigned null values, such as assigning null to a string, for
example. Instead, nullable reference types must be used if null values are possible, like this:

string product = null; // compiler error - this is a non-nullable type
string? product = null; // no error - this is a nullable type

The string? type is nullable, while string is not, which means that the code that consumes a variable doesn’t have to worry
about null values unless it is dealing with a nullable type. To enable nullable reference types, an element must be added to the
csproj file, like this:

<Project Sdk="Microsoft.NET.Sdk.Web">

<PropertyGroup>
<TargetFramework>netcoreapp3.1</TargetFramework>
<Nullable>enable</Nullable>

</PropertyGroup>
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</Project>

If you are using Visual Studio, you can open the project file by right-clicking the project item in the Solution Explorer and
selecting Edit Project File from the popup menu.

| like this feature, but it is not yet used widely enough for me to use it in this book, especially since it can make some complex
topics even more difficult to follow. But, once the rest of .NET Core catches up with this feature, | expect it to be embraced in
ASP.NET Core by default, and you can expect to see nullable reference types used in future editions of this book.

Using Automatically Implemented Properties

C# supports automatically implemented properties, and I used them when defining properties for the Person class in the previous
section, like this:

namespace LanguageFeatures.Models {
public class Product {

public string Name { get; set; }
public decimal? Price { get; set; }
public Product Related { get; set; }
public static Product[] GetProducts() {

Product kayak = new Product {
Name = "Kayak", Price = 275M
};

Product lifejacket = new Product {

Name = "Lifejacket", Price = 48.95M
};
kayak.Related = lifejacket;

return new Product[] { kayak, lifejacket, null };

This feature allows me to define properties without having to implement the get and set bodies. Using the auto-implemented
property feature means I can define a property like this:
public string Name { get; set; }
is equivalent to the following code:
public string Name {

get { return name; }
set { name = value; }
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This type of feature is known as syntactic sugar, which means that it makes C# more pleasant to use—in this case by eliminating
redundant code that ends up being duplicated for every property—without substantially altering the way that the language behaves.
The term sugar may seem pejorative, but any enhancements that make code easier to write and maintain can be beneficial,
especially in large and complex projects.

Using Auto-implemented Property Initializers

Automatically implemented properties have been supported since C# 3.0. The latest version of C# supports initializers for
automatically implemented properties, which allows an initial value to be set without having to use the constructor, as shown in
Listing 5-11.

Listing 5-11. Using an Auto-implemented Property Initializer in the Product.cs File in the Models Folder

namespace LanguageFeatures.Models {
public class Product {

public string Name { get; set; }

public string Category { get; set; } = "llatersports”;
public decimal? Price { get; set; }

public Product Related { get; set; }

public static Product[] GetProducts() {
Product kayak = new Product {
Name = "Kayak",
Category = "Water Craft",
Price = 275M
};
Product lifejacket = new Product {
Name = "Lifejacket", Price = 48.95M
b

kayak.Related = lifejacket;

return new Product[] { kayak, lifejacket, null };

Assigning a value to an auto-implemented property doesn’t prevent the setter from being used to change the property later
and just tidies up the code for simple types that ended up with a constructor that contained a list of property assignments to provide
default values. In the example, the initializer assigns a value of Watersports to the Category property. The initial value can be
changed, which I do when I create the kayak object and specify a value of Water Craft instead.

Creating Read-Only Automatically Implemented Properties

You can create a read-only property by using an initializer and omitting the set keyword from an auto-implemented property that
has an initializer, as shown in Listing 5-12.

Listing 5-12. Creating a Read-Only Property in the Product.cs File in the Models Folder

namespace LanguageFeatures.Models {
public class Product {

public string Name { get; set; }

public string Category { get; set; } = "Watersports";
public decimal? Price { get; set; }
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public Product Related { get; set; }
public bool InStock { get; } = true;

public static Product[] GetProducts() {

Product kayak = new Product {
Name = "Kayak",
Category = "Water Craft",
Price = 275M
35
Product lifejacket = new Product {
Name = "Lifejacket", Price = 48.95M
b

kayak.Related = lifejacket;

return new Product[] { kayak, lifejacket, null };

The InStock property is initialized to true and cannot be changed; however, the value can be assigned to in the type’s
constructor, as shown in Listing 5-13.

Listing 5-13. Assigning a Value to a Read-Only Property in the Product.cs File in the Models Folder

namespace LanguageFeatures.Models {
public class Product {

public Product(bool stock = true) {
InStock = stock;
}

public string Name { get; set; }

public string Category { get; set; } = "Watersports";
public decimal? Price { get; set; }

public Product Related { get; set; }

public bool InStock { get; }

public static Product[] GetProducts() {
Product kayak = new Product {
Name = "Kayak",
Category = "Water Craft",
Price = 275M
};

Product lifejacket = new Product(false) {
Name = "Lifejacket",
Price = 48.95M

}s
kayak.Related = lifejacket;

return new Product[] { kayak, lifejacket, null };
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The constructor allows the value for the read-only property to be specified as an argument and defaults to true if no value is
provided. The property value cannot be changed once set by the constructor.

Using String Interpolation

The string.Format method is the traditional C# tool for composing strings that contain data values. Here is an example of this
technique from the Home controller:

results.Add(string.Format("Name: {0}, Price: {1}, Related: {2}",
name, price, relatedName));

C# also supports a different approach, known as string interpolation, that avoids the need to ensure that the {0} references
in the string template match up with the variables specified as arguments. Instead, string interpolation uses the variable names
directly, as shown in Listing 5-14.

Listing 5-14. Using String Interpolation in the HomeController.cs File in the Controllers Folder

using Microsoft.AspNetCore.Mvc;
using System.Collections.Generic;
using LanguageFeatures.Models;

namespace LanguageFeatures.Controllers {
public class HomeController : Controller {

public ViewResult Index() {
List<string> results = new List<string>();

foreach (Product p in Product.GetProducts()) {
string name = p?.Name ?? "<No Name>";
decimal? price = p?.Price ?? 0;
string relatedName = p?.Related?.Name ?? "<None>";
results.Add($"Name: {name}, Price: {price}, Related: {relatedName}");

}

return View(results);

Interpolated strings are prefixed with the $ character and contain holes, which are references to values contained within the {
and } characters. When the string is evaluated, the holes are filled in with the current values of the variables or constants that are
specified.

Tip String interpolation supports all the format specifiers that are available with the string.Format method. The format specifics
are included as part of the hole, so $"Price: {price:C2}" would format the price value as a currency value with two decimal digits.
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Using Object and Collection Initializers

When I create an object in the static GetProducts method of the Product class, I use an object initializer, which allows me to create
an object and specify its property values in a single step, like this:

Product kayak = new Product {
Name = "Kayak",
Category = "Water Craft",
Price = 275M

};

This is another syntactic sugar feature that makes C# easier to use. Without this feature, I would have to call the Product
constructor and then use the newly created object to set each of the properties, like this:

Product kayak = new Product();
kayak.Name = "Kayak";
kayak.Category = "Water Craft";
kayak.Price = 275M;

A related feature is the collection initializer, which allows the creation of a collection and its contents to be specified in a single
step. Without an initializer, creating a string array, for example, requires the size of the array and the array elements to be specified
separately, as shown in Listing 5-15.

Listing 5-15. Initializing an Object in the HomeController.cs File in the Controllers Folder

using Microsoft.AspNetCore.Mvc;
using System.Collections.Generic;
using LanguageFeatures.Models;

namespace LanguageFeatures.Controllers {
public class HomeController : Controller {

public ViewResult Index() {
string[] names = new string[3];

names[0] = "Bob";
names[1] = "Joe";
names[2] = "Alice";

return View("Index", names);

Using a collection initializer allows the contents of the array to be specified as part of the construction, which implicitly provides
the compiler with the size of the array, as shown in Listing 5-16.

Listing 5-16. Using a Collection Initializer in the HomeController.cs File in the Controllers Folder

using Microsoft.AspNetCore.Mvc;
using System.Collections.Generic;
using LanguageFeatures.Models;

namespace LanguageFeatures.Controllers {
public class HomeController : Controller {
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public ViewResult Index() {
return View("Index", new string[] { "Bob", "Joe", "Alice" });
}

The array elements are specified between the { and } characters, which allows for a more concise definition of the collection
and makes it possible to define a collection inline within a method call. The code in Listing 5-16 has the same effect as the code
in Listing 5-15. Restart ASP.NET Core and request http://localhost:5000, and you will see the following output in the browser
window:

Bob
Joe
Alice

Using an Index Initializer

Recent versions of C# tidy up the way collections that use indexes, such as dictionaries, are initialized. Listing 5-17 shows the Index
action rewritten to define a collection using the traditional C# approach to initializing a dictionary.

Listing 5-17. Initializing a Dictionary in the HomeController.cs File in the Controllers Folder

using Microsoft.AspNetCore.Mvc;
using System.Collections.Generic;
using LanguageFeatures.Models;

namespace LanguageFeatures.Controllers {
public class HomeController : Controller {

public ViewResult Index() {
Dictionary<string, Product> products = new Dictionary<string, Products {
{ "Kayak", new Product { Name = "Kayak", Price = 275M } },
{ "Lifejacket", new Product{ Name = "Lifejacket", Price = 48.95M } }
b

return View("Index", products.Keys);

The syntax for initializing this type of collection relies too much on the { and } characters, especially when the collection values
are created using object initializers. The latest versions of C# support a more natural approach to initializing indexed collections that
is consistent with the way that values are retrieved or modified once the collection has been initialized, as shown in Listing 5-18.

Listing 5-18. Using Collection Initializer Syntax in the HomeController.cs File in the Controllers Folder
using Microsoft.AspNetCore.Mvc;
using System.Collections.Generic;

using LanguageFeatures.Models;

namespace LanguageFeatures.Controllers {
public class HomeController : Controller {

public ViewResult Index() {

Dictionary<string, Product> products = new Dictionary<string, Product> {
["Kayak"] = new Product { Name = "Kayak", Price = 275M },
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["Lifejacket"] = new Product { Name = "Lifejacket", Price = 48.95M }
};

return View("Index", products.Keys);

The effect is the same—to create a dictionary whose keys are Kayak and Lifejacket and whose values are Product objects—but
the elements are created using the index notation that is used for other collection operations. Restart ASP.NET Core and request
http://localhost:5000, and you will see the following results in the browser:

Kayak
Lifejacket

Pattern Matching

One of the most useful recent additions to C# is support for pattern matching, which can be used to test that an object is of a specific
type or has specific characteristics. This is another form of syntactic sugar, and it can dramatically simplify complex blocks of
conditional statements. The is keyword is used to perform a type test, as demonstrated in Listing 5-19.

Listing 5-19. Performing a Type Test in the HomeController.cs File in the Controllers Folder

using Microsoft.AspNetCore.Mvc;
using System.Collections.Generic;
using LanguageFeatures.Models;

namespace LanguageFeatures.Controllers {
public class HomeController : Controller {

public ViewResult Index() {
object[] data = new object[] { 275M, 29.95M,
"apple", "orange", 100, 10 };
decimal total = 0;
for (int i = 0; i < data.Length; i++) {

if (data[i] is decimal d) {
total += d;
}

}

return View("Index", new string[] { $"Total: {total:C2}" });

The is keyword performs a type check and, if a value is of the specified type, will assign the value to a new variable, like this:

if (data[i] is decimal d) {
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This expression evaluates as true if the value stored in data[1i] is a decimal. The value of data[i] will be assigned to the
variable d, which allows it to be used in subsequent statements without needing to perform any type conversions. The is keyword
will match only the specified type, which means that only two of the values in the data array will be processed (the other items in the
array are string and int values). If you run the application, you will see the following output in the browser window:

Total: $304.95

Pattern Matching in switch Statements

Pattern matching can also be used in switch statements, which support the when keyword for restricting when a value is matched by

a case statement, as shown in Listing 5-20.

Listing 5-20. Pattern Matching in the HomeController.cs File in the Controllers Folder

using Microsoft.AspNetCore.Mvc;
using System.Collections.Generic;
using LanguageFeatures.Models;

namespace LanguageFeatures.Controllers {

public class HomeController : Controller {

public ViewResult Index() {

object[] data = new object[] { 275M, 29.95M,
"apple", "orange", 100, 10 };
decimal total = 0;
for (int i = 0; i < data.Length; i++) {
switch (data[i]) {
case decimal decimalValue:
total += decimalValue;
break;
case int intValue when intValue » 50:
total += intValue;
break;

}

return View("Index", new string[] { $"Total: {total:C2}" });

To match any value of a specific type, use the type and variable name in the case statement, like this:

case decimal decimalValue:

This case statement matches any decimal value and assigns it to a new variable called decimalValue. To be more selective, the

when keyword can be included, like this:

case int intValue when intValue > 50:
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This case statement matches int values and assigns them to a variable called intValue, but only when the value is greater than
50. Restart ASP.NET Core and request http://localhost:5000, and you will see the following output in the browser window:

Total: $404.95

Using Extension Methods

Extension methods are a convenient way of adding methods to classes that you cannot modify directly, typically because they are
provided by Microsoft or a third-party package. Listing 5-21 shows the definition of the ShoppingCart class, which I added to the
Models folder in a class file called ShoppingCart.cs file and which represents a collection of Product objects.

Listing 5-21. The Contents of the ShoppingCart.cs File in the Models Folder

using System.Collections.Generic;
namespace LanguageFeatures.Models {

public class ShoppingCart {
public IEnumerable<Product> Products { get; set; }
}

This is a simple class that acts as a wrapper around a sequence of Product objects (I only need a basic class for this example).
Suppose I need to be able to determine the total value of the Product objects in the ShoppingCart class, but I cannot modify the
class because it comes from a third party, and I do not have the source code. I can use an extension method to add the functionality I
need.

Add a class file named MyExtensionMethods. cs in the Models folder and use it to define the class shown in Listing 5-22.

Listing 5-22. The Contents of the MyExtensionMethods.cs File in the Models Folder

namespace LanguageFeatures.Models {
public static class MyExtensionMethods {

public static decimal TotalPrices(this ShoppingCart cartParam) {
decimal total = 0;
foreach (Product prod in cartParam.Products) {
total += prod?.Price ?? 0;
}

return total;

Extension methods are defined in static classes within the same namespace as the class the extension methods applies to.

In this case, the static MyExtensionMethods class is in the LanguageFeatures.Models namespace, which means that it can contain
extension methods for classes in that namespace.

Extension methods are also static, and Listing 5-22 defines a single extension method named TotalPrices. The this keyword
in front of the first parameter marks TotalPrices as an extension method. The first parameter tells .NET which class the extension
method can be applied to—ShoppingCart in this case. I can refer to the instance of the ShoppingCart that the extension method has
been applied to by using the cartParam parameter. This extension method enumerates the Product objects in the ShoppingCart and
returns the sum of the Product.Price property values. Listing 5-23 shows how I apply the extension method in the Home controller’s
action method.
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Note Extension methods do not let you break through the access rules that classes define for methods, fields, and properties. You
can extend the functionality of a class by using an extension method but only using the class members that you had access to anyway.

Listing 5-23. Applying an Extension Method in the HomeController.cs File in the Controllers Folder

using Microsoft.AspNetCore.Mvc;
using System.Collections.Generic;
using LanguageFeatures.Models;

namespace LanguageFeatures.Controllers {
public class HomeController : Controller {

public ViewResult Index() {
ShoppingCart cart
= new ShoppingCart { Products = Product.GetProducts() };
decimal cartTotal = cart.TotalPrices();
return View("Index", new string[] { $"Total: {cartTotal:C2}" });

The key statement is this one:
decimal cartTotal = cart.TotalPrices();

I call the TotalPrices method on a ShoppingCart object as though it were part of the ShoppingCart class, even though it is an
extension method defined by a different class altogether. .NET will find extension classes if they are in the scope of the current class,
meaning that they are part of the same namespace or in a namespace that is the subject of a using statement. Restart ASP.NET Core
and request http://localhost:5000, which will produce the following output in the browser window:

Total: $323.95

Applying Extension Methods to an Interface

Extension methods can also be applied to an interface, which allows me to call the extension method on all the classes that
implement the interface. Listing 5-24 shows the ShoppingCart class updated to implement the IEnumerable<Product> interface.

Listing 5-24. Implementing an Interface in the ShoppingCart.cs File in the Models Folder

using System.Collections;
using System.Collections.Generic;

namespace LanguageFeatures.Models {

public class ShoppingCart : IEnumerable<Products> {
public IEnumerable<Product> Products { get; set; }

public IEnumerator<Product> GetEnumerator() {
return Products.GetEnumerator();
}
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IEnumerator IEnumerable.GetEnumerator() {
return GetEnumerator();
}

I can now update the extension method so that it deals with IEnumerable<Product>, as shown in Listing 5-25.

Listing 5-25. Updating an Extension Method in the MyExtensionMethods.cs File in the Models Folder

using System.Collections.Generic;
namespace LanguageFeatures.Models {
public static class MyExtensionMethods {

public static decimal TotalPrices(this IEnumerable<Products products) {
decimal total = 0;
foreach (Product prod in products) {
total += prod?.Price ?? 0;
}

return total;

The first parameter type has changed to IEnumerable<Product>, which means that the foreach loop in the method body works
directly on Product objects. The change to using the interface means that I can calculate the total value of the Product objects
enumerated by any IEnumerable<Product>, which includes instances of ShoppingCart but also arrays of Product objects, as shown
in Listing 5-26.

Listing 5-26. Applying an Extension Method in the HomeController.cs File in the Controllers Folder

using Microsoft.AspNetCore.Mvc;
using System.Collections.Generic;
using LanguageFeatures.Models;

namespace LanguageFeatures.Controllers {
public class HomeController : Controller {

public ViewResult Index() {

ShoppingCart cart
= new ShoppingCart { Products = Product.GetProducts() };

Product[] productArray = {
new Product {Name = "K
new Product {Name

ayak", Price = 275M},
"Lifejacket", Price = 48.95M}

)

decimal cartTotal = cart.TotalPrices();
decimal arrayTotal = productArray.TotalPrices();

return View("Index", new string[] {

$"Cart Total: {cartTotal:C2}",
$"Array Total: {arrayTotal:C2}" });
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Restart ASP.NET Core and request http://localhost:5000, which will produce the following output in the browser,
demonstrating that I get the same result from the extension method, irrespective of how the Product objects are collected:

Cart Total: $323.95
Array Total: $323.95

Creating Filtering Extension Methods

The last thing I want to show you about extension methods is that they can be used to filter collections of objects. An extension
method that operates on an IEnumerable<T> and that also returns an IEnumerable<T> can use the yield keyword to apply selection
criteria to items in the source data to produce a reduced set of results. Listing 5-27 demonstrates such a method, which I have added
to the MyExtensionMethods class.

Listing 5-27. A Filtering Extension Method in the MyExtensionMethods.cs File in the Models Folder

using System.Collections.Generic;
namespace LanguageFeatures.Models {
public static class MyExtensionMethods {

public static decimal TotalPrices(this IEnumerable<Product> products) {
decimal total = 0;
foreach (Product prod in products) {
total += prod?.Price ?? 0;
}

return total;

}

public static IEnumerable<Product> FilterByPrice(
this IEnumerable<Products> productEnum, decimal minimumPrice) {

foreach (Product prod in productEnum) {
if ((prod?.Price ?? 0) >= minimumPrice) {
yield return prod;
}

This extension method, called FilterByPrice, takes an additional parameter that allows me to filter products so that Product
objects whose Price property matches or exceeds the parameter are returned in the result. Listing 5-28 shows this method being
used.

Listing 5-28. Using the Filtering Extension Method in the HomeController.cs File in the Controllers Folder

using Microsoft.AspNetCore.Mvc;
using System.Collections.Generic;
using LanguageFeatures.Models;

namespace LanguageFeatures.Controllers {
public class HomeController : Controller {
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public ViewResult Index() {

Product[] productArray = {
new Product {Name = "Kayak", Price = 275M},
new Product {Name = "Lifejacket", Price = 48.95M},
new Product {Name = "Soccer ball", Price = 19.50M},
new Product {Name = "Corner flag", Price = 34.95M}

};
decimal arrayTotal = productArray.FilterByPrice(20).TotalPrices();

return View("Index", new string[] { $"Array Total: {arrayTotal:C2}" });

When I call the FilterByPrice method on the array of Product objects, only those that cost more than $20 are received by the
TotalPrices method and used to calculate the total. If you run the application, you will see the following output in the browser
window:

Total: $358.90

Using Lambda Expressions

Lambda expressions are a feature that causes a lot of confusion, not least because the feature they simplify is also confusing. To
understand the problem that is being solved, consider the FilterByPrice extension method that I defined in the previous section.
This method is written so that it can filter Product objects by price, which means I must create a second method I want to filter by
name, as shown in Listing 5-29.

Listing 5-29. Adding a Filter Method in the MyExtensionMethods.cs File in the Models Folder
using System.Collections.Generic;
namespace LanguageFeatures.Models {
public static class MyExtensionMethods {
public static decimal TotalPrices(this IEnumerable<Product> products) {
decimal total = 0;
foreach (Product prod in products) {

total += prod?.Price ?? 0;
}

return total;

}

public static IEnumerable<Product> FilterByPrice(
this IEnumerable<Product> productEnum, decimal minimumPrice) {

foreach (Product prod in productEnum) {

if ((prod?.Price ?? 0) >= minimumPrice) {
yield return prod;
}
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public static IEnumerable<Product> FilterByName(
this IEnumerable<Product> productEnum, char firstletter) {

foreach (Product prod in productEnum) {
if (prod?.Name?[0] == firstLetter) {
yield return prod;
}

Listing 5-30 shows the use of both filter methods applied in the controller to create two different totals.

Listing 5-30. Using Two Filter Methods in the HomeController.cs File in the Controllers Folder

using Microsoft.AspNetCore.Mvc;
using System.Collections.Generic;
using LanguageFeatures.Models;

namespace LanguageFeatures.Controllers {
public class HomeController : Controller {

public ViewResult Index() {

Product[] productArray = {
new Product {Name = "Kayak", Price = 275M},
new Product {Name = "Lifejacket", Price = 48.95M},
new Product {Name = "Soccer ball", Price = 19.50M},
new Product {Name = "Corner flag", Price = 34.95M}

};

decimal priceFilterTotal = productArray.FilterByPrice(20).TotalPrices();
decimal nameFilterTotal = productArray.FilterByName('S').TotalPrices();

return View("Index", new string[] {
$"Price Total: {priceFilterTotal:C2}",
$"Name Total: {nameFilterTotal:C2}" });

The first filter selects all the products with a price of $20 or more, and the second filter selects products whose name starts with
the letter S. You will see the following output in the browser window if you run the example application:

Price Total: $358.90
Name Total: $19.50

Defining Functions

I can repeat this process indefinitely to create filter methods for every property and every combination of properties that I am
interested in. A more elegant approach is to separate the code that processes the enumeration from the selection criteria. C#
makes this easy by allowing functions to be passed around as objects. Listing 5-31 shows a single extension method that filters an
enumeration of Product objects but that delegates the decision about which ones are included in the results to a separate function.
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Listing 5-31. Creating a General Filter Method in the MyExtensionMethods.cs File in the Models Folder

using System.Collections.Generic;
using System;

namespace LanguageFeatures.Models {
public static class MyExtensionMethods {

public static decimal TotalPrices(this IEnumerable<Product> products) {
decimal total = 0;
foreach (Product prod in products) {
total += prod?.Price ?? 0;
}

return total;

}

public static IEnumerable<Product> Filter(
this IEnumerable<Products> productEnum,
Func<Product, bool> selector) {

foreach (Product prod in productEnum) {
if (selector(prod)) {
yield return prod;
}

The second argument to the Filter method is a function that accepts a Product object and that returns a bool value. The
Filter method calls the function for each Product object and includes it in the result if the function returns true. To use the Filter
method, I can specify a method or create a stand-alone function, as shown in Listing 5-32.

Listing 5-32. Using a Function to Filter Objects in the HomeController.cs File in the Controllers Folder

using Microsoft.AspNetCore.Mvc;
using System.Collections.Generic;
using LanguageFeatures.Models;
using System;

namespace LanguageFeatures.Controllers {
public class HomeController : Controller {

bool FilterByPrice(Product p) {
return (p?.Price ?? 0) >= 20;
}

public ViewResult Index() {

Product[] productArray = {
new Product {Name = "Kayak", Price = 275M},
new Product {Name = "Lifejacket", Price = 48.95M},
new Product {Name = "Soccer ball", Price = 19.50M},
new Product {Name = "Corner flag", Price = 34.95M}

};
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Func<Product, bool> nameFilter = delegate (Product prod) {
return prod?.Name?[0] == 'S’;
};

decimal priceFilterTotal = productArray
.Filter(FilterByPrice)
.TotalPrices();

decimal nameFilterTotal = productArray
.Filter(nameFilter)
.TotalPrices();

return View("Index", new string[] {
$"Price Total: {priceFilterTotal:C2}",
$"Name Total: {nameFilterTotal:C2}" });

Neither approach is ideal. Defining methods like FilterByPrice clutters up a class definition. Creating a Func<Product,
bool> object avoids this problem but uses an awkward syntax that is hard to read and hard to maintain. It is this issue that lambda
expressions address by allowing functions to be defined in a more elegant and expressive way, as shown in Listing 5-33.

Listing 5-33. Using a Lambda Expression in the HomeController.cs File in the Controllers Folder

using Microsoft.AspNetCore.Mvc;
using System.Collections.Generic;
using LanguageFeatures.Models;
using System;

namespace LanguageFeatures.Controllers {
public class HomeController : Controller {

public ViewResult Index() {

Product[] productArray = {
new Product {Name = "Kayak", Price = 275M},
new Product {Name = "Lifejacket", Price = 48.95M},
new Product {Name = "Soccer ball", Price = 19.50M},
new Product {Name = "Corner flag", Price = 34.95M}
};

decimal priceFilterTotal = productArray
+Filter(p => (p?.Price ?? 0) >= 20)
.TotalPrices();

decimal nameFilterTotal = productArray
.Filter(p => p?.Name?[0] == 'S")
.TotalPrices();

return View("Index", new string[] {

$"Price Total: {priceFilterTotal:C2}",
$"Name Total: {nameFilterTotal:C2}" });
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The lambda expressions are shown in bold. The parameters are expressed without specifying a type, which will be inferred

automatically. The => characters are read aloud as “goes to” and link the parameter to the result of the lambda expression. In my
examples, a Product parameter called p goes to a bool result, which will be true if the Price property is equal or greater than 20 in
the first expression or if the Name property starts with S in the second expression. This code works in the same way as the separate
method and the function delegate but is more concise and is—for most people—easier to read.

OTHER FORMS FOR LAMBDA EXPRESSIONS

| don’t need to express the logic of my delegate in the lambda expression. | can as easily call a method, like this:

[;."f(.)d => EvaluateProduct(prod)

If I need a lambda expression for a delegate that has multiple parameters, | must wrap the parameters in parentheses, like this:
&p‘n‘rod, count) => prod.Price > 20 8& count > 0

Finally, if | need logic in the lambda expression that requires more than one statement, | can do so by using braces ({}) and
finishing with a return statement, like this:

(prod, count) => {
// ...multiple code statements...
return result;

You do not need to use lambda expressions in your code, but they are a neat way of expressing complex functions simply and in
a manner that is readable and clear. | like them a lot, and you will see them used throughout this book.

Using Lambda Expression Methods and Properties

Lambda expressions can be used to implement constructors, methods, and properties. In ASP.NET Core development, you will often
end up with methods that contain a single statement that selects the data to display and the view to render. In Listing 5-34,  have
rewritten the Index action method so that it follows this common pattern.

Listing 5-34. Creating a Common Action Pattern in the HomeController.cs File in the Controllers Folder

using Microsoft.AspNetCore.Mvc;
using System.Collections.Generic;
using LanguageFeatures.Models;
using System;

using System.Ling;

namespace LanguageFeatures.Controllers {

public class HomeController : Controller {

public ViewResult Index() {
return View(Product.GetProducts().Select(p => p?.Name));
}
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The action method gets a collection of Product objects from the static Product.GetProducts method and uses LINQ to project
the values of the Name properties, which are then used as the view model for the default view. If you run the application, you will see
the following output displayed in the browser window:

Kayak
Lifejacket

There will be an empty list item in the browser window as well because the GetProducts method includes a null reference in its
results, but that doesn’t matter for this section of the chapter.

When a constructor or method body consists of a single statement, it can be rewritten as a lambda expression, as shown in
Listing 5-35.

Listing 5-35. A Lambda Action Method in the HomeController.cs File in the Controllers Folder

using Microsoft.AspNetCore.Mvc;
using System.Collections.Generic;
using LanguageFeatures.Models;
using System;

using System.Ling;

namespace LanguageFeatures.Controllers {
public class HomeController : Controller {

public ViewResult Index() =»
View(Product.GetProducts().Select(p =» p?.Name));

Lambda expressions for methods omit the return keyword and use => (goes to) to associate the method signature (including
its arguments) with its implementation. The Index method shown in Listing 5-35 works in the same way as the one shown in
Listing 5-34 but is expressed more concisely. The same basic approach can also be used to define properties. Listing 5-36 shows the
addition of a property that uses a lambda expression to the Product class.

Listing 5-36. A Lambda Property in the Product.cs File in the Models Folder

namespace LanguageFeatures.Models {
public class Product {

public Product(bool stock = true) {
InStock = stock;
}

public string Name { get; set; }

public string Category { get; set; } = "Watersports";
public decimal? Price { get; set; }

public Product Related { get; set; }

public bool InStock { get; }

public bool NameBeginsWithS =» Name?[0] == 'S’;

public static Product[] GetProducts() {

Product kayak = new Product {
Name = "Kayak",
Category = "Water Craft",
Price = 275M

};
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Product lifejacket = new Product(false) {
Name = "Lifejacket",
Price = 48.95M

};

kayak.Related = lifejacket;

return new Product[] { kayak, lifejacket, null };

Using Type Inference and Anonymous Types

The var keyword allows you to define a local variable without explicitly specifying the variable type, as demonstrated by Listing 5-37.
This is called type inference, or implicit typing.

Listing 5-37. Using Type Inference in the HomeController.cs File in the Controllers Folder

using Microsoft.AspNetCore.Mvc;
using System.Collections.Generic;
using LanguageFeatures.Models;
using System;

using System.Lling;

namespace LanguageFeatures.Controllers {
public class HomeController : Controller {

public ViewResult Index() {
var names = new [] { "Kayak", "Lifejacket", "Soccer ball" };
return View(names);

Itis not that the names variable does not have a type; instead, I am asking the compiler to infer the type from the code. The
compiler examines the array declaration and works out that it is a string array. Running the example produces the following output:

Kayak
Lifejacket
Soccer ball

Using Anonymous Types

By combining object initializers and type inference, I can create simple view model objects that are useful for transferring data
between a controller and a view without having to define a class or struct, as shown in Listing 5-38.

Listing 5-38. Creating an Anonymous Type in the HomeController.cs File in the Controllers Folder

using Microsoft.AspNetCore.Mvc;
using System.Collections.Generic;
using LanguageFeatures.Models;
using System;

using System.Ling;
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namespace LanguageFeatures.Controllers {
public class HomeController : Controller {

public ViewResult Index() {
var products = new [] {
new { Name = "Kayak", Price = 275M },
new { Name = "Lifejacket", Price = 48.95M },
new { Name = "Soccer ball", Price = 19.50M },
new { Name = "Corner flag", Price = 34.95M }

)

return View(products.Select(p =» p.Name));

Each of the objects in the products array is an anonymously typed object. This does not mean that it is dynamic in the sense
that JavaScript variables are dynamic. It just means that the type definition will be created automatically by the compiler. Strong
typing is still enforced. You can get and set only the properties that have been defined in the initializer, for example. Restart ASP.NET
Core and request http://localhost:5000, and you will see the following output in the browser window:

Kayak
Lifejacket
Soccer ball
Corner flag

The C# compiler generates the class based on the name and type of the parameters in the initializer. Two anonymously typed
objects that have the same property names and types will be assigned to the same automatically generated class. This means that all
the objects in the products array will have the same type because they define the same properties.

Tip | have to use the var keyword to define the array of anonymously typed objects because the type isn’t created until the code is
compiled, so | don’t know the name of the type to use. The elements in an array of anonymously typed objects must all define the same
properties; otherwise, the compiler can’t work out what the array type should be.

To demonstrate this, I have changed the output from the example in Listing 5-39 so that it shows the type name rather than the
value of the Name property.

Listing 5-39. Displaying the Type Name in the HomeController.cs File in the Controllers Folder

using Microsoft.AspNetCore.Mvc;
using System.Collections.Generic;
using LanguageFeatures.Models;
using System;

using System.Ling;

namespace LanguageFeatures.Controllers {
public class HomeController : Controller {

public ViewResult Index() {
var products = new [] {
new { Name = "Kayak", Price = 275M },
new { Name = "Lifejacket", Price = 48.95M },
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19.50M },
34.95M }

new { Name = "Soccer ball", Price
new { Name = "Corner flag", Price

};

return View(products.Select(p =» p.GetType().Name));

All the objects in the array have been assigned the same type, which you can see if you run the example. The type name isn’t
user-friendly but isn’t intended to be used directly, and you may see a different name than the one shown in the following output:

<>f__AnonymousType0" 2
<>f__AnonymousType0" 2
<>f__AnonymousType0~ 2
<>f__AnonymousType0" 2

Using Default Implementations in Interfaces

C# 8.0 introduces the ability to define default implementations for properties and methods defined by interfaces. This may seem
like an odd feature because interfaces are intended to be a description of features without specifying an implementation, but this
addition to C# makes it possible to update interfaces without breaking the existing implementations of them.

Add a class file named IProductSelection.cs to the Models folder and use it to define the interface shown in Listing 5-40.

Listing 5-40. The Contents of the IProductSelection.cs File in the Models Folder

using System.Collections.Generic;

namespace LanguageFeatures.Models {
public interface IProductSelection {

IEnumerable<Product> Products { get; }

Update the ShoppingCart class to implement the new interface, as shown in Listing 5-41.

Listing 5-41. Implementing an Interface in the ShoppingCart.cs File in the Models Folder

using System.Collections;
using System.Collections.Generic;

namespace LanguageFeatures.Models {

public class ShoppingCart : IProductSelection {
private List<Product> products = new List<Product>();

public ShoppingCart(params Product[] prods) {
products.AddRange(prods);
}

public IEnumerable<Product> Products { get => products; }
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Listing 5-42 updates the Home controller so that it uses the ShoppingCart class.

Listing 5-42. Using an Interface in the HomeController.cs File in the Controllers Folder

using Microsoft.AspNetCore.Mvc;
using System.Collections.Generic;
using LanguageFeatures.Models;
using System;

using System.Ling;

namespace LanguageFeatures.Controllers {
public class HomeController : Controller {

public ViewResult Index() {
IProductSelection cart = new ShoppingCart(
new Product { Name = "Kayak", Price = 275M },
new Product { Name = "Lifejacket", Price = 48.95M },
new Product { Name = "Soccer ball", Price = 19.50M },
new Product { Name = "Corner flag", Price = 34.95M }
);

return View(cart.Products.Select(p => p.Name));

This is the familiar use of an interface, and if you restart ASP.NET Core and request http://localhost:5000, you will see the
following output in the browser:

Kayak

Lifejacket
Soccer ball
Corner flag

If I want to add a new feature to the interface, I must locate and update all the classes that implement it, which can be difficult,
especially if an interface is used by other development teams in their projects. This is where the default implementation feature can
be used, allowing new features to be added to an interface, as shown in Listing 5-43.

Listing 5-43. Adding a Feature in the IProductSelection.cs File in the Models Folder

using System.Collections.Generic;
using System.Ling;

namespace LanguageFeatures.Models {
public interface IProductSelection {

IEnumerable<Product> Products { get; }

IEnumerable<string> Names => Products.Select(p =»> p.Name);

The listing defines a Names property and provides a default implementation, which means that consumers of the
IProductSelection interface can use the Total property even if it isn’t defined by implementation classes, as shown in Listing 5-44.
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Listing 5-44. Using a Default Implementation in the HomeController.cs File in the Controllers Folder

using Microsoft.AspNetCore.Mvc;
using System.Collections.Generic;
using LanguageFeatures.Models;
using System;

using System.Ling;

namespace LanguageFeatures.Controllers {
public class HomeController : Controller {

public ViewResult Index() {

IProductSelection cart = new ShoppingCart(
new Product { Name = "Kayak", Price = 275M },
new Product { Name = "Lifejacket", Price = 48.95M },
new Product { Name = "Soccer ball", Price = 19.50M },
new Product { Name = "Corner flag", Price = 34.95M }

)5

return View(cart.Names);

The ShoppingCart class has not been modified, but the Index method is able to use the default implementation of the Names
property. Restart ASP.NET Core and request http://localhost:5000, and you will see the following output in the browser:

Kayak

Lifejacket
Soccer ball
Corner flag

Using Asynchronous Methods

Asynchronous methods perform work in the background and notify you when they are complete, allowing your code to take care
of other business while the background work is performed. Asynchronous methods are an important tool in removing bottlenecks
from code and allow applications to take advantage of multiple processors and processor cores to perform work in parallel.

In ASP.NET Core, asynchronous methods can be used to improve the overall performance of an application by allowing the
server more flexibility in the way that requests are scheduled and executed. Two C# keywords—async and await—are used to
perform work asynchronously.

Working with Tasks Directly

C# and .NET have excellent support for asynchronous methods, but the code has tended to be verbose, and developers who are
not used to parallel programming often get bogged down by the unusual syntax. To create an example, add a class file called
MyAsyncMethods . cs to the Models folder and add the code shown in Listing 5-45.

Listing 5-45. The Contents of the MyAsyncMethods.cs File in the Models Folder

using System.Net.Http;
using System.Threading.Tasks;

namespace LanguageFeatures.Models {
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public class MyAsyncMethods {

public static Task<long?> GetPagelength() {
HttpClient client = new HttpClient();
var httpTask = client.GetAsync("http://apress.com");
return httpTask.ContinueWith((Task<HttpResponseMessage> antecedent) => {
return antecedent.Result.Content.Headers.ContentLength;

1

This method uses a System.Net.Http.HttpClient object to request the contents of the Apress home page and returns its
length. .NET represents work that will be done asynchronously as a Task. Task objects are strongly typed based on the result that the
background work produces. So, when I call the HttpClient.GetAsync method, what I get back is a Task<HttpResponseMessage>.
This tells me that the request will be performed in the background and that the result of the request will be an HttpResponseMessage
object.

Tip When | use words like background, | am skipping over a lot of detail to make just the key points that are important to the world
of ASP.NET Core. The .NET support for asynchronous methods and parallel programming is excellent, and | encourage you to learn more
about it if you want to create truly high-performing applications that can take advantage of multicore and multiprocessor hardware. You
will see how ASP.NET Core makes it easy to create asynchronous web applications throughout this book as I introduce different features.

The part that most programmers get bogged down with is the continuation, which is the mechanism by which you specity
what you want to happen when the task is complete. In the example, I have used the ContinueWith method to process the
HttpResponseMessage object I get from the HttpClient.GetAsync method, which I do with a lambda expression that returns the
value of a property that contains the length of the content I get from the Apress web server. Here is the continuation code:

return httpTask.ContinueWith((Task<HttpResponseMessage> antecedent) => {
return antecedent.Result.Content.Headers.ContentLength;

1

Notice that I use the return keyword twice. This is the part that causes confusion. The first use of the return keyword
specifies that I am returning a Task<HttpResponseMessage> object, which, when the task is complete, will return the length of the
ContentLength header. The ContentLength header returns a long? result (a nullable long value), and this means that the result of
my GetPagelength method is Task<long?>, like this:

public static Task<long?> GetPagelength() {

Do not worry if this does not make sense—you are not alone in your confusion. It is for this reason that Microsoft added
keywords to C# to simplify asynchronous methods.

Applying the async and await Keywords

Microsoft introduced two keywords to C# that simplify using asynchronous methods like HttpClient.GetAsync. The keywords are
async and await, and you can see how I have used them to simplify my example method in Listing 5-46.
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Listing 5-46. Using the async and await Keywords in the MyAsyncMethods.cs File in the Models Folder

using System.Net.Http;
using System.Threading.Tasks;

namespace LanguageFeatures.Models {
public class MyAsyncMethods {

public async static Task<long?» GetPageLength() {
HttpClient client = new HttpClient();
var httpMessage = await client.GetAsync("http://apress.com");
return httpMessage.Content.Headers.ContentLength;

Tused the await keyword when calling the asynchronous method. This tells the C# compiler that I want to wait for the result of
the Task that the GetAsync method returns and then carry on executing other statements in the same method.

Applying the await keyword means I can treat the result from the GetAsync method as though it were a regular method and just
assign the HttpResponseMessage object that it returns to a variable. Even better, I can then use the return keyword in the normal
way to produce a result from another method—in this case, the value of the ContentLength property. This is a much more natural
technique, and it means I do not have to worry about the ContinueWith method and multiple uses of the return keyword.

When you use the await keyword, you must also add the async keyword to the method signature, as I have done in the example.
The method result type does not change—my example GetPagelLength method still returns a Task<long?>. This is because await
and async are implemented using some clever compiler tricks, meaning that they allow a more natural syntax, but they do not
change what is happening in the methods to which they are applied. Someone who is calling my GetPageLength method still has to
deal with a Task<long?> result because there is still a background operation that produces a nullable long—although, of course,
that programmer can also choose to use the await and async keywords as well.

This pattern follows through into the controller, which makes it easy to write asynchronous action methods, as shown in
Listing 5-47.

Note You can also use the async and await keywords in lambda expressions, which | demonstrate in later chapters.

Listing 5-47. An Asynchronous Action Methods in the HomeController.cs File in the Controllers Folder

using Microsoft.AspNetCore.Mvc;
using System.Collections.Generic;
using LanguageFeatures.Models;
using System;

using System.Ling;

using System.Threading.Tasks;

namespace LanguageFeatures.Controllers {
public class HomeController : Controller {

public async Task<ViewResult> Index() {

long? length = await MyAsyncMethods.GetPageLength();
return View(new string[] { $"Length: {length}" });
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I have changed the result of the Index action method to Task<ViewResult>, which declares that the action method will return
a Task that will produce a ViewResult object when it completes, which will provide details of the view that should be rendered
and the data that it requires. I have added the async keyword to the method’s definition, which allows me to use the await
keyword when calling the MyAsyncMethods .GetPathLength method. .NET takes care of dealing with the continuations, and the
result is asynchronous code that is easy to write, easy to read, and easy to maintain. Restart ASP.NET Core and request http://
localhost:5000, and you will see output similar to the following (although with a different length since the content of the Apress
web site changes often):

Length: 101868

Using an Asynchronous Enumerable

An asynchronous enumerable describes a sequence of values that will be generated over time. To demonstrate the issue that this
feature addresses, Listing 5-48 adds a method to the MyAsyncMethods class.

Listing 5-48. Adding a Method in the MyAsyncMethods.cs File in the Models Folder

using System.Net.Http;
using System.Threading.Tasks;
using System.Collections.Generic;

namespace LanguageFeatures.Models {
public class MyAsyncMethods {

public async static Task<long?> GetPagelength() {
HttpClient client = new HttpClient();
var httpMessage = await client.GetAsync("http://apress.com");
return httpMessage.Content.Headers.ContentLength;

}

public static async Task<IEnumerable<long?>»

GetPagelengths(List<string> output, params string[] urls) {

List<long?» results = new List<long?>();

HttpClient client = new HttpClient();

foreach (string url in urls) {
output.Add($"Started request for {url}");
var httpMessage = await client.GetAsync($"http://{url}");
results.Add(httpMessage.Content.Headers.ContentLength);
output.Add($"Completed request for {url}");

}

return results;

The GetPagelengths method makes HTTP requests to a series of web sites and gets their length. The requests are performed
asynchronously, but there is no way to feed the results back to the method’s caller as they arrive. Instead, the method waits until all
the requests are complete and then returns all of the results in one go. In addition to the URLs that will be requested, this method
accepts a List<string> to which I add messages in order to highlight how the code works. Listing 5-49 updates the Index action
method of the Home controller to use the new method.
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Listing 5-49. Using the New Method in the HomeController.cs File in the Controllers Folder

using Microsoft.AspNetCore.Mvc;
using System.Collections.Generic;
using LanguageFeatures.Models;
using System;

using System.Ling;

using System.Threading.Tasks;

namespace LanguageFeatures.Controllers {
public class HomeController : Controller {

public async Task<ViewResult> Index() {
List¢string> output = new List<string>();
foreach(long? len in await MyAsyncMethods.GetPagelengths(output,
"apress.com”, "microsoft.com"”, "amazon.com")) {
output.Add($"Page length: { len}");

return View(output);

The action method enumerates the sequence produced by the GetPagelLengths method and adds each result to the
List<string> object, which produces an ordered sequence of messages showing the interaction between the foreach loop in the
Index method that processes the results and the foreach loop in the GetPagelLengths method that generates them. Restart ASP.NET
Core and request http://localhost:5000, and you will see the following output in the browser (which may take several seconds to
appear and may have different page lengths):

Started request for apress.com
Completed request for apress.com
Started request for microsoft.com
Completed request for microsoft.com
Started request for amazon.com
Completed request for amazon.com
Page length: 101868

Page length: 159158

Page length: 91879

You can see that the Index action method doesn’t receive the results until all the HTTP requests have been completed. This is
the problem that the asynchronous enumerable feature solves, as shown in Listing 5-50.

Listing 5-50. Using an Asynchronous Enumerable in the MyAsyncMethods.cs File in the Models Folder

using System.Net.Http;
using System.Threading.Tasks;
using System.Collections.Generic;

namespace LanguageFeatures.Models {
public class MyAsyncMethods {
public async static Task<long?> GetPagelength() {
HttpClient client = new HttpClient();

var httpMessage = await client.GetAsync("http://apress.com");
return httpMessage.Content.Headers.ContentLength;
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public static async IAsyncEnumerable<long?»

GetPagelengths(List<stringy output, params string[] urls) {

HttpClient client = new HttpClient();

foreach (string url in urls) {
output.Add($"Started request for {url}");
var httpMessage = await client.GetAsync($"http://{url}");
output.Add($"Completed request for {url}");
yield return httpMessage.Content.Headers.ContentLength;

The methods result is IAsyncEnumerable<long?>, which denotes an asynchronous sequence of nullable long values. This result
type has special support in .NET Core and works with standard yield return statements, which isn’t otherwise possible because
the result constraints for asynchronous methods conflict with the yield keyword. Listing 5-51 updates the controller to use the
revised method.

Listing 5-51. Using an Asynchronous Enumerable in the HomeController.cs File in the Controllers Folder

using Microsoft.AspNetCore.Mvc;
using System.Collections.Generic;
using LanguageFeatures.Models;
using System;

using System.Ling;

using System.Threading.Tasks;

namespace LanguageFeatures.Controllers {
public class HomeController : Controller {

public async Task<ViewResult> Index() {
List<string> output = new List<string>();
await foreach(long? len in MyAsyncMethods.GetPageLengths(output,
"apress.com”, "microsoft.com”, "amazon.com")) {
output.Add($"Page length: { len}");
}

return View(output);

The difference is that the await keyword is applied before the foreach keyword and not before the call to the async method.
Restart ASP.NET Core and request http://localhost:5000; once the HTTP requests are complete, you will see that the order of the
response messages has changed, like this:

Started request for apress.com
Completed request for apress.com
Page length: 101868

Started request for microsoft.com
Completed request for microsoft.com
Page length: 159160

Started request for amazon.com
Completed request for amazon.com
Page length: 91674
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The controller receives the next result in the sequence as it is produced. As I explain in Chapter 19, ASP.NET Core has special
support for using IAsyncEnumerable<T> results in web services, allowing data values to be serialized as the values in the sequence
are generated.

Getting Names

There are many tasks in web application development in which you need to refer to the name of an argument, variable, method, or
class. Common examples include when you throw an exception or create a validation error when processing input from the user.
The traditional approach has been to use a string value hard-coded with the name, as shown in Listing 5-52.

Listing 5-52. Hard-Coding a Name in the HomeController.cs File in the Controllers Folder

using Microsoft.AspNetCore.Mvc;
using System.Collections.Generic;
using LanguageFeatures.Models;
using System;

using System.Lling;

using System.Threading.Tasks;

namespace LanguageFeatures.Controllers {
public class HomeController : Controller {

public ViewResult Index() {
var products = new[] {
new { Name = "Kayak", Price = 275M },
new { Name = "Lifejacket", Price = 48.95M },
new { Name = "Soccer ball", Price = 19.50M },
new { Name = "Corner flag", Price = 34.95M }
};

return View(products.Select(p =»> $"Name: {p.Name}, Price: {p.Price}"));

The call to the LINQ Select method generates a sequence of strings, each of which contains a hard-coded reference to the
Name and Price properties. Restart ASP.NET Core and request http://localhost:5000, and you will see the following output in the
browser window:

Name: Kayak, Price: 275

Name: Lifejacket, Price: 48.95
Name: Soccer ball, Price: 19.50
Name: Corner flag, Price: 34.95

This approach is prone to errors, either because the name was mistyped or because the code was refactored and the name in
the string isn’t correctly updated. C# supports the nameof expression, in which the compiler takes responsibility for producing a
name string, as shown in Listing 5-53.

Listing 5-53. Using nameof Expressions in the HomeController.cs File in the Controllers Folder

using Microsoft.AspNetCore.Mvc;
using System.Collections.Generic;
using LanguageFeatures.Models;
using System;

using System.Lling;

using System.Threading.Tasks;
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namespace LanguageFeatures.Controllers {
public class HomeController : Controller {

public ViewResult Index() {
var products = new[] {
new { Name = "Kayak", Price = 275M },
new { Name = "Lifejacket", Price = 48.95M },
new { Name = "Soccer ball", Price = 19.50M },
new { Name = "Corner flag", Price = 34.95M }

};
return View(products.Select(p =»
$"{nameof(p.Name)}: {p.Name}, {nameof(p.Price)}: {p.Price}"));

The compiler processes a reference such as p.Name so that only the last part is included in the string, producing the same output
as in previous examples. There is IntelliSense support for nameof expressions, so you will be prompted to select references, and
expressions will be correctly updated when you refactor code. Since the compiler is responsible for dealing with nameof, using an
invalid reference causes a compiler error, which prevents incorrect or outdated references from escaping notice.

Summary

In this chapter, I gave you an overview of the key C# language features that an effective ASP.NET Core programmer needs to know.
C# is a sufficiently flexible language that there are usually different ways to approach any problem, but these are the features that you
will encounter most often during web application development and that you will see throughout the examples in this book. In the
next chapter, I explain how to set up a unit test project for ASP.NET Core.
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Testing ASPNET Core Applications

In this chapter, I demonstrate how to unit test ASP.NET Core applications. Unit testing is a form of testing in which individual
components are isolated from the rest of the application so their behavior can be thoroughly validated. ASP.NET Core has been
designed to make it easy to create unit tests, and there is support for a wide range of unit testing frameworks. I show you how to set
up a unit test project and describe the process for writing and running tests. Table 6-1 summarizes the chapter.

DECIDING WHETHER TO UNIT TEST

Being able to easily perform unit testing is one of the benefits of using ASP.NET Core, but it isn’t for everyone, and | have no
intention of pretending otherwise.

| like unit testing, and | use it in my own projects, but not all of them and not as consistently as you might expect. | tend to focus
on writing unit tests for features and functions that | know will be hard to write and likely to be the source of bugs in deployment.
In these situations, unit testing helps structure my thoughts about how to best implement what I need. | find that just thinking
about what | need to test helps produce ideas about potential problems, and that’s before | start dealing with actual bugs and
defects.

That said, unit testing is a tool and not a religion, and only you know how much testing you require. If you don’t find unit

testing useful or if you have a different methodology that suits you better, then don’t feel you need to unit test just because it is
fashionable. (However, if you don’t have a better methodology and you are not testing at all, then you are probably letting users
find your bugs, which is rarely ideal. You don’t have to unit test, but you really should consider doing some testing of some kind.)

If you have not encountered unit testing before, then | encourage you to give it a try to see how it works. If you are not a fan
of unit testing, then you can skip this chapter and move on to Chapter 7, where | start to build a more realistic ASP.NET Core
application.

Table 6-1. Chapter Summary

Problem Solution Listing

Creating a unit test project Use the dotnet new command with the project template for your preferred test 7
framework

Creating an XUnit test Create a class with methods decorated with the Fact attribute and use the Assert 9
class to inspect the test results

Running unit tests Use the Visual Studio or Visual Studio Code test runners or use the dotnet test 11
command

Isolating a component for Create mock implementations of the objects that the component under test requires 12-19

testing

Preparing for This Chapter

To prepare for this chapter, I need to create a simple ASP.NET Core project. Open a new PowerShell command prompt using the
Windows Start menu, navigate to a convenient location, and run the commands shown in Listing 6-1.
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Tip You can download the example project for this chapter—and for all the other chapters in this book—from https://github.
com/apress/pro-asp.net-core-3. See Chapter 1 for how to get help if you have problems running the examples.

Listing 6-1. Creating the Example Project

dotnet new globaljson --sdk-version 3.1.101 --output Testing/SimpleApp
dotnet new web --no-https --output Testing/SimpleApp --framework netcoreapp3.1
dotnet new sln -o Testing

dotnet sln Testing add Testing/SimpleApp

These commands create a new project named SimpleApp using the web template, which contains the minimal configuration for
ASP.NET Core applications. The project folder is contained within a solution folder also called Testing.

Opening the Project

If you are using Visual Studio, select File » Open » Project/Solution, select the Testing.sln file in the Testing folder, and click the
Open button to open the solution file and the project it references. If you are using Visual Studio Code, select File » Open Folder,
navigate to the Testing folder, and click the Select Folder button.

Selecting the HTTP Port

If you are using Visual Studio, select Project » SimpleApp Properties, select the Debug section, and change the HTTP port to 5000 in
the App URL field, as shown in Figure 6-1. Select File » Save All to save the new port. (This change is not required if you are using
Visual Studio Code.)

SimpleApp + X
Application
Build
Build Events

Package SQL Server debugging

Debug - Settings

Signing

App URL: http://localhost:5000

Code Analysis
TypeScript Build IS Express Bitness: | Default
Resources Hosting Model: Default (In Process)

[C] Enable S5L

Enable Anonymous Authentication

Figure 6-1. Setting the HTTP port
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Enabling the MVC Framework

AsIexplained in Chapter 1, ASP.NET Core supports different application frameworks, but I am going to continue using the MVC

Framework in this chapter. I introduce the other frameworks in the SportsStore application that I start to build in Chapter 7, but for
the moment, the MVC Framework gives me a foundation for demonstrating how to perform unit testing that is familiar from earlier

examples. Add the statements shown in Listing 6-2 to the Startup.cs file in the SimpleApp folder.

Listing 6-2. Enabling the MVC Framework in the Startup.cs File in the SimpleApp Folder

using System;

using System.Collections.Generic;

using System.Lling;

using System.Threading.Tasks;

using Microsoft.AspNetCore.Builder;

using Microsoft.AspNetCore.Hosting;

using Microsoft.AspNetCore.Http;

using Microsoft.Extensions.DependencyInjection;
using Microsoft.Extensions.Hosting;

namespace SimpleApp {
public class Startup {

public void ConfigureServices(IServiceCollection services) {
services.AddControllershlithViews();
}

public void Configure(IApplicationBuilder app, IWebHostEnvironment env) {
if (env.IsDevelopment()) {
app.UseDeveloperExceptionPage();

app.UseRouting();

app.UseEndpoints(endpoints => {
endpoints.MapDefaultControllerRoute();
//endpoints.MapGet("/", async context =»> {
11 await context.Response.WriteAsync("Hello World!");

11});
};

Creating the Application Components

Now that the MVC Framework is set up, I can add the application components that I will use to demonstrate important C#
language features.

Creating the Data Model

I started by creating a simple model class so that I can have some data to work with. I added a folder called Models and created a
class file called Product. cs within it, which I used to define the class shown in Listing 6-3.

Listing 6-3. The Contents of the Product.cs File in the SimpleApp/Models Folder

namespace SimpleApp.Models {
public class Product {

public string Name { get; set; }
public decimal? Price { get; set; }
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public static Product[] GetProducts() {

Product kayak = new Product {
Name = "Kayak", Price = 275M
};

Product lifejacket = new Product {
Name = "Lifejacket", Price = 48.95M
b

return new Product[] { kayak, lifejacket };

The Product class defines Name and Price properties, and there is a static method called GetProducts that returns a
Products array.

Creating the Controller and View

For the examples in this chapter, I use a simple controller class to demonstrate different language features. I created a Controllers
folder and added to it a class file called HomeController.cs, the contents of which are shown in Listing 6-4.

Listing 6-4. The Contents of the HomeController.cs File in the SimpleApp/Controllers Folder

using Microsoft.AspNetCore.Mvc;
using SimpleApp.Models;

namespace SimpleApp.Controllers {
public class HomeController : Controller {

public ViewResult Index() {
return View(Product.GetProducts());
}

The Index action method tells ASP.NET Core to render the default view and provides it with the Product objects obtained from
the static Product.GetProducts method. To create the view for the action method, I added a Views/Home folder (by creating a Views
folder and then adding a Home folder within it) and added a Razor View called Index.cshtml, with the contents shown in Listing 6-5.

Listing 6-5. The Contents of the Index.cshtml File in the SimpleApp/Views/Home Folder

@using SimpleApp.Models
@model IEnumerable<Product>
@{ Layout = null; }

<!DOCTYPE html>

<html>

<head>
<meta name="viewport" content="width=device-width" />
<title>Simple App</title>

</head>
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<body>
<ul>
@foreach (Product p in Model) {
<li>Name: @p.Name, Price: @p.Price</li>
}
</ul>
</body>
</html>

Running the Example Application

Start ASP.NET Core by selecting Start Without Debugging (Visual Studio) or Run Without Debugging (Visual Studio Code) from the
Debug menu or by running the command shown in Listing 6-6 in the SimpleApp folder.

Listing 6-6. Running the Example Application
dotnet run

Request http://localhost:5000, and you will see the output shown in Figure 6-2.

@ Simple App X

g C @ localhost:5000 r :

o Name: Kayak, Price: 275
o« Name: Lifejacket, Price: 48.95

Figure 6-2. Running the example application

Creating a Unit Test Project

For ASP.NET Core applications, you generally create a separate Visual Studio project to hold the unit tests, each of which is defined
as amethod in a C# class. Using a separate project means you can deploy your application without also deploying the tests. The .NET
Core SDK includes templates for unit test projects using three popular test tools, as described in Table 6-2.

Table 6-2. The Unit Test Project Tools

Name Description

mstest This template creates a project configured for the MS Test framework, which is produced by Microsoft.
nunit This template creates a project configured for the NUnit framework.

xunit This template creates a project configured for the XUnit framework.

These testing frameworks have largely the same feature set and differ only in how they are implemented and how they integrate
into third-party testing environments. I recommend starting with XUnit If you do not have an established preference, largely because
itis the test framework that I find easiest to work with.

The convention is to name the unit test project <ApplicationName>.Tests. Run the commands shown in Listing 6-7 in the
Testing folder to create the XUnit test project named SimpleApp.Tests, add it to the solution file, and create a reference between
projects so the unit tests can be applied to the classes defined in the SimpleApp project.
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Listing 6-7. Creating the Unit Test Project

dotnet new xunit -o SimpleApp.Tests --framework netcoreapp3.i1
dotnet sln add SimpleApp.Tests
dotnet add SimpleApp.Tests reference SimpleApp

If you are using Visual Studio, you will be prompted to reload the solution, which will cause the new unit test project to be
displayed in the Solution Explorer, alongside the existing project. You may find that Visual Studio Code doesn’t build the new
project. If that happens, select Terminal » Configure Default Build Task, select “build” from the list, and, if prompted, select .NET
Core from the list of environments.

Removing the Default Test Class

The project template adds a C# class file to the test project, which will confuse the results of later examples. Either delete the
UnitTest1.cs file from the SimpleApp.Tests folder using the Solution Explorer or File Explorer pane or run the command shown in
Listing 6-8 in the Testing folder.

Listing 6-8. Removing the Default Test Class File

Remove-Item SimpleApp.Tests/UnitTestl.cs

Writing and Running Unit Tests

Now that all the preparation is complete, I can write some tests. To get started, I added a class file called ProductTests.cs to the
SimpleApp.Tests project and used it to define the class shown in Listing 6-9. This is a simple class, but it contains everything
required to get started with unit testing.

Note The CanChangeProductPrice method contains a deliberate error that | resolve later in this section.

Listing 6-9. The Contents of the ProductTests.cs File in the SimpleApp.Tests Folder

using SimpleApp.Models;
using Xunit;

namespace SimpleApp.Tests {
public class ProductTests {

[Fact]
public void CanChangeProductName() {

// Arrange
var p = new Product { Name = "Test", Price = 100M };

// Act
p.Name = "New Name";

//Assert
Assert.Equal("New Name", p.Name);
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public void CanChangeProductPrice() {

// Arrange

var p = new Product { Name = "Test", Price = 100M };

// Act
p.Price = 200M;

//Assert

Assert.Equal(100M, p.Price);

There are two unit tests in the ProductTests class, each of which tests a behavior of the Product model class from the
SimpleApp project. A test project can contain many classes, each of which can contain many unit tests.

Conventionally, the name of the test methods describes what the test does, and the name of the class describes what is being
tested. This makes it easier to structure the tests in a project and to understand what the results of all the tests are when they are
run by Visual Studio. The name ProductTests indicates that the class contains tests for the Product class, and the method names
indicate that they test the ability to change the name and price of a Product object.

The Fact attribute is applied to each method to indicate that it is a test. Within the method body, a unit test follows a pattern
called arrange, act, assert (A/A/A). Arrange refers to setting up the conditions for the test, act refers to performing the test, and assert
refers to verifying that the result was the one that was expected.

The arrange and act sections of these tests are regular C# code, but the assert section is handled by xUnit.net, which provides a
class called Assert, whose methods are used to check that the outcome of an action is the one that is expected.

Tip The Fact attribute and the Asset class are defined in the Xunit namespace, for which there must be a using statement in

every test class.

The methods of the Assert class are static and are used to perform different kinds of comparison between the expected and
actual results. Table 6-3 shows the commonly used Assert methods.

Table 6-3. Commonly Used xUnit.net Assert Methods

Name

Description

Equal(expected, result)

NotEqual(expected, result)
True(result)

False(result)
IsType(expected, result)
IsNotType(expected, result)
IsNull(result)
IsNotNull(result)
InRange(result, low, high)
NotInRange(result, low, high)

Throws (exception, expression)

This method asserts that the result is equal to the expected outcome. There are overloaded
versions of this method for comparing different types and for comparing collections.

There is also a version of this method that accepts an additional argument of an object that
implements the IEqualityComparer<T> interface for comparing objects.

This method asserts that the result is not equal to the expected outcome.
This method asserts that the result is true.

This method asserts that the result is false.

This method asserts that the result is of a specific type.

This method asserts that the result is not a specific type.

This method asserts that the result is null.

This method asserts that the result is not null.

This method asserts that the result falls between low and high.

This method asserts that the result falls outside low and high.

This method asserts that the specified expression throws a specific exception type.

113



CHAPTER 6 = TESTING ASP.NET CORE APPLICATIONS

Each Assert method allows different types of comparison to be made and throws an exception if the result is not what was
expected. The exception is used to indicate that a test has failed. In the tests in Listing 6-9, I used the Equal method to determine
whether the value of a property has been changed correctly.

Assert.Equal("New Name", p.Name);

Running Tests with the Visual Studio Test Explorer

Visual Studio includes support for finding and running unit tests through the Test Explorer window, which is available through the
Test » Test Explorer menu and is shown in Figure 6-3.

Tip Build the solution if you don’t see the unit tests in the Test Explorer window. Compilation triggers the process by which unit tests
are discovered.

Test Explorer *@ X
> r-F's 4201 '01 FERS L= - B Search Test Explorer P
Test Duration Traits Error Message Group Summary
4 €3 SimpleApp.Tests (2) 1 ms SimpleApp.Tests
4 3 SimpleApp.Tests (2) 1ms Tests in group: 2
4 3 ProductTests (2) 1M ms (© Total Duration: 11 ms
g Ean.i:nge:':“‘:?m :.ms & Equal() Failure E: d: 100 A I Oucoins
anChangeProductPrice ms ssert.Equal() Failure Expected: ctual:... © 1 passed
D 1 Failed

Figure 6-3. The Visual Studio Test Explorer

Run the tests by clicking the Run All Tests button in the Test Explorer window (it is the button that shows two arrows and is the
first button in the row at the top of the window). As noted, the CanChangeProductPrice test contains an error that causes the test to
fail, which is clearly indicated in the test results shown in the figure.

Running Tests with Visual Studio Code
Visual Studio Code detects tests and allows them to be run using the code lens feature, which displays details about code features

in the editor. To run all the tests in the ProductTests class, click Run All Tests in the code editor when the unit test class is open, as
shown in Figure 6-4.

] File Edit Selection View Go Debug Terminal Help ProductTests.cs - Testing - Visual Studio Code = ] X
C* ProductTests.cs X m - EXPLORER
SimpleApp.Tests > € ProductTests.cs > {} SimpleApp.Tests > 42 SimpleAp » OPEN EDITORS
1 using Simpledpp.Models; X € ProductTests.cs SimpleApp.Tests
2 using Xunit;  TESTING
3
5] é > NS
4 namespace SimpleApp.Tests {
5 = » .vscode
T m un All Tests ] t ~ SimpleApp
6 public clyss—Prodoctfests { > bin
; [Fact] > Controller
t ; > Models
9 public woid CanChangeProcfuctNalne() { > obj
flu.,_.f" B9 ettt e P b e Su ROl . e P i o™

Figure 6-4. Running tests with the Visual Studio Code code lens feature
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Tip Close and reopen the Testing folder in Visual Studio Code if you don’t see the code lens test features.

Visual Studio Code runs the tests using the command-line tools that I describe in the following section, and the results are
displayed as text in a terminal window.

Running Tests from the Command Line

To run the tests in the project, run the command shown in Listing 6-10 in the Testing folder.

Listing 6-10. Running Unit Tests
dotnet test

The tests are discovered and executed, producing the following results, which show the deliberate error that I
introduced earlier:

Test run for C:\Users\adam\SimpleApp.Tests.d11(.NETCoreApp,Version=v3.1)
Microsoft (R) Test Execution Command Line Tool Version 16.3.0
Copyright (c) Microsoft Corporation. All rights reserved.

Starting test execution, please wait...

A total of 1 test files matched the specified pattern.
[xUnit.net 00:00:00.83] SimpleApp.Tests.ProductTests.CanChangeProductPrice [FAIL]
X SimpleApp.Tests.ProductTests.CanChangeProductPrice [6ms]
Error Message:
Assert.Equal() Failure
Expected: 100
Actual: 200
Stack Trace:
at SimpleApp.Tests.ProductTests.CanChangeProductPrice() in C:\Users\adam\Documents\Books\Pro ASP.NET Core
MVC 3\Source Code\Current\Testin
g\SimpleApp.Tests\ProductTests.cs:1ine 31

Test Run Failed.
Total tests: 2
Passed: 1
Failed: 1
Total time: 1.7201 Seconds

Correcting the Unit Test

The problem with the unit test is with the arguments to the Assert.Equal method, which compares the test result to the original
Price property value rather than the value it has been changed to. Listing 6-11 corrects the problem.

Tip When a test fails, it is always a good idea to check the accuracy of the test before looking at the component it targets, especially
if the test is new or has been recently modified.
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Listing 6-11. Correcting a Test in the ProductTests.cs File in the SimpleApp.Tests Folder

using SimpleApp.Models;
using Xunit;

namespace SimpleApp.Tests {
public class ProductTests {

[Fact]
public void CanChangeProductName() {

// Arrange
var p = new Product { Name = "Test", Price = 100M };

// Act
p.Name = "New Name";

//Assert

Assert.Equal("New Name", p.Name);
}
[Fact]

public void CanChangeProductPrice() {

// Arrange
var p = new Product { Name = "Test", Price = 100M };

// Act
p.Price = 200M;

//Assert
Assert.Equal(200M, p.Price);

Run the tests again, and you will see they all pass. If you are using Visual Studio, you can click the Run Failed Tests button, which
will execute only the tests that failed, as shown in Figure 6-5.

8-k - Search Test Explorer p-
stion  Traits  EmorMessace | Group Summary

-

Test

4 ) SimpleAppTests (2)
4 ) Simpledpp.Tests (2) ‘o |A210: D0 B~z & - SeAh St Exploser e
4 € Productlests 2) Test Duration  Traits Error Message Group Summary
@ CanChangeProductN] @ simpleppTests (2) 9 ms SimpleApp. Tests
€ CanChangeProductPl  , @ SimpleApp.Tests (2) O ms Tests in group: 2
4 @ ProductTests (2) Ims (D Total Duration: 9 ms
CanChangeProducth 3 ms
& : e = Outcomes
CanChangeProductPrice 6ms @ 2 Passed

Figure 6-5. Running only failed tests

Isolating Components for Unit Testing

Writing unit tests for model classes like Product is easy. Not only is the Product class simple, but it is self-contained, which means that
when I perform an action on a Product object, I can be confident that I am testing the functionality provided by the Product class.
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The situation is more complicated with other components in an ASP.NET Core application because there are dependencies
between them. The next set of tests that I define will operate on the controller, examining the sequence of Product objects that are
passed between the controller and the view.

When comparing objects instantiated from custom classes, you will need to use the xUnit.net Assert.Equal method that
accepts an argument that implements the IEqualityComparer<T> interface so that the objects can be compared. My first step is to
add a class file called Comparer.cs to the unit test project and use it to define the helper classes shown in Listing 6-12.

Listing 6-12. The Contents of the Comparer.cs File in the SimpleApp.Tests Folder

using System;
using System.Collections.Generic;

namespace SimpleApp.Tests {
public class Comparer {

public static Comparer<U> Get<U>(Func<U, U, bool> func) {
return new Comparer<Us(func);
}

}

public class Comparer<T> : Comparer, IEqualityComparer<T> {
private Func<T, T, bool> comparisonFunction;

public Comparer(Func<T, T, bool> func) {
comparisonFunction = func;
}

public bool Equals(T x, Ty) {
return comparisonFunction(x, y);
}

public int GetHashCode(T obj) {
return obj.GetHashCode();
}

These classes will allow me to create IEqualityComparer<T> objects using lambda expressions rather than having to define a
new class for each type of comparison that I want to make. This isn’t essential, but it will simplify the code in my unit test classes and
make them easier to read and maintain.

Now that I can easily make comparisons, I can illustrate the problem of dependencies between components in the application.
Iadded a new class called HomeControllerTests.cs to the SimpleApp.Tests folder and used it to define the unit test shown in Listing 6-13.

Listing 6-13. The HomeControllerTests.cs File in the SimpleApp.Tests Folder

using Microsoft.AspNetCore.Mvc;
using System.Collections.Generic;
using SimpleApp.Controllers;
using SimpleApp.Models;

using Xunit;

namespace SimpleApp.Tests {
public class HomeControllerTests {

[Fact]

public void IndexActionModelIsComplete() {
// Arrange
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var controller = new HomeController();
Product[] products = new Product[] {
new Product { Name = "Kayak", Price = 275M },
new Product { Name = "Lifejacket", Price = 48.95M}

};

// Act
var model = (controller.Index() as ViewResult)?.ViewData.Model
as IEnumerable<Product>;

// Assert
Assert.Equal(products, model,
Comparer.Get<Product>((p1, p2) => pil.Name == p2.Name
88 p1.Price == p2.Price));

The unit test creates an array of Product objects and checks that they correspond to the ones the Index action method provides
as the view model. (Ignore the act section of the test for the moment; I explain the ViewResult class in Chapters 21 and 22. For the
moment, it is enough to know that I am getting the model data returned by the Index action method.)

The test passes, but it isn’t a useful result because the Product data that I am testing is coming from the hardwired objects’
Product class. I can’t write a test to make sure that the controller behaves correctly when there are more than two Product objects,
for example, or if the Price property of the first object has a decimal fraction. The overall effect is that I am testing the combined
behavior of the HomeController and Product classes and only for the specific hardwired objects.

Unit tests are effective when they target small parts of an application, such as an individual method or class. What I need is the
ability to isolate the Home controller from the rest of the application so that I can limit the scope of the test and rule out any impact
caused by the repository.

Isolating a Component

The key to isolating components is to use C# interfaces. To separate the controller from the repository, I added a new class file called
IDataSource.cs to the Models folder and used it to define the interface shown in Listing 6-14.

Listing 6-14. The Contents of the IDataSource.cs File in the SimpleApp/Models Folder
using System.Collections.Generic;

namespace SimpleApp.Models {
public interface IDataSource {

IEnumerable<Product> Products { get; }

In Listing 6-15, I have removed the static method from the Product class and created a new class that implements the
IDataSource interface.

Listing 6-15. Creating a Data Source in the Product.cs File in the SimpleApp/Models Folder
using System.Collections.Generic;
namespace SimpleApp.Models {

public class Product {

public string Name { get; set; }
public decimal? Price { get; set; }
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public class ProductDataSource : IDataSource {
public IEnumerable<Product> Products =>
new Product[] {
new Product { Name
new Product { Name

"Kayak", Price = 275M },
"Lifejacket", Price = 48.95M }

)

The next step is to modify the controller so that it uses the ProductDataSouzrce class as the source for its data, as shown in
Listing 6-16.

Tip ASP.NET Core supports a more elegant approach for solving this problem, known as dependency injection, which | describe in
Chapter 14. Dependency injection often causes confusion, so | isolate components in a simpler and more manual way in this chapter.

Listing 6-16. Adding a Property in the HomeController.cs File in the SimpleApp/Controllers Folder

using Microsoft.AspNetCore.Mvc;
using SimpleApp.Models;

namespace SimpleApp.Controllers {
public class HomeController : Controller {
public IDataSource dataSource = new ProductDataSource();

public ViewResult Index() {
return View(dataSource.Products);
}

This may not seem like a significant change, but it allows me to change the data source the controller uses during testing,
which is how I can isolate the controller. In Listing 6-17, I have updated the controller unit tests so they use a special version of the
repository.

Listing 6-17. Isolating the Controller in the HomeControllerTests.cs File in the SimpleApp.Tests Folder

using Microsoft.AspNetCore.Mvc;
using System.Collections.Generic;
using SimpleApp.Controllers;
using SimpleApp.Models;

using Xunit;

namespace SimpleApp.Tests {
public class HomeControllerTests {

class FakeDataSource : IDataSource {
public FakeDataSource(Product[] data) =» Products = data;
public IEnumerable<Product> Products { get; set; }

}

[Fact]
public void IndexActionModelIsComplete() {
// Arrange
Product[] testData = new Product[] {
new Product { Name = "P1", Price = 75.10M },
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"P2", Price
"P3", Price

120M },
110M }

new Product { Name
new Product { Name

}s

IDataSource data = new FakeDataSource(testData);
var controller = new HomeController();
controller.dataSource = data;

// Act
var model = (controller.Index() as ViewResult)?.ViewData.Model
as IEnumerable<Product>;

// Assert
Assert.Equal(data.Products, model,
Comparer.Get<Product>((p1, p2) => pil.Name == p2.Name
88 pi1.Price == p2.Price));

I have defined a fake implementation of the IDataSource interface that lets me use any test data with the controller.

UNDERSTANDING TEST-DRIVEN DEVELOPMENT

| have followed the most commonly used unit testing style in this chapter, in which an application feature is written and then
tested to make sure it works as required. This is popular because most developers think about application code first and testing
comes second (this is certainly the category that | fall into).

This approach is that it tends to produce unit tests that focus only on the parts of the application code that were difficult to write
or that needed some serious debugging, leaving some aspects of a feature only partially tested or untested altogether.

An alternative approach is Test-Driven Development (TDD). There are lots of variations on TDD, but the core idea is that you write
the tests for a feature before implementing the feature itself. Writing the tests first makes you think more carefully about the
specification you are implementing and how you will know that a feature has been implemented correctly. Rather than diving
into the implementation detail, TDD makes you consider what the measures of success or failure will be in advance.

The tests that you write will all fail initially because your new feature will not be implemented. But as you add code to the
application, your tests will gradually move from red to green, and all your tests will pass by the time that the feature is complete.
TDD requires discipline, but it does produce a more comprehensive set of tests and can lead to more robust and reliable code.

Using a Mocking Package

It was easy to create a fake implementation for the IDataSource interface, but most classes for which fake implementations are
required are more complex and cannot be handled as easily.

A better approach is to use a mocking package, which makes it easy to create fake—or mock—objects for tests. There are
many mocking packages available, but the one I use (and have for years) is called Moq. To add Moq to the unit test project, run the
command shown in Listing 6-18 in the Testing folder.

Note The Moq package is added to the unit testing project and not the project that contains the application to be tested.

Listing 6-18. Installing the Mocking Package

dotnet add SimpleApp.Tests package Moq --version 4.13.1
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Creating a Mock Object

I can use the Moq framework to create a fake IDataSource object without having to define a custom test class, as shown in Listing 6-19.

Listing 6-19. Creating a Mock Object in the HomeControllerTests.cs File in the SimpleApp.Tests Folder

using Microsoft.AspNetCore.Mvc;
using System.Collections.Generic;
using SimpleApp.Controllers;
using SimpleApp.Models;

using Xunit;

using Mogq;

namespace SimpleApp.Tests {
public class HomeControllerTests {

//class FakeDataSource : IDataSource {

2 public FakeDataSource(params Product[] data) =» Products = data;
1/ public IEnumerable<Products> Products { get; set; }

11}

[Fact]
public void IndexActionModelIsComplete() {

// Arrange

Product[] testData = new Product[] {
new Product { Name = "P1", Price = 75.10M },
new Product { Name = "P2", Price = 120M },
new Product { Name = "P3", Price = 110M }

b

var mock = new Mock<IDataSources();
mock.SetupGet(m => m.Products).Returns(testData);
var controller = new HomeController();
controller.dataSource = mock.Object;

// Act
var model = (controller.Index() as ViewResult)?.ViewData.Model
as IEnumerable<Product>;

// Assert
Assert.Equal(testData, model,
Comparer.Get<Product>((p1, p2) => pil.Name == p2.Name
88 p1.Price == p2.Price));
mock.VerifyGet(m => m.Products, Times.Once);

The use of Moq has allowed me to remove the fake implementation of the IDataSource interface and replace it with a few lines
of code. I am not going to go into detail about the different features that Moq supports, but I will explain the way that I used Moq
in the examples. (See https://github.com/Moq/mog4 for examples and documentation for Moq. There are also examples in later
chapters as I explain how to unit test different types of components.)

The first step is to create a new instance of the Mock object, specifying the interface that should be implemented, like this:

var mock = new Mock<IDataSource>();
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The Mock object I created will fake the IDataSource interface. To create an implementation of the Product property, I use the
SetUpGet method, like this:

mock.SetupGet(m => m.Products).Returns(testData);

The SetupGet method is used to implement the getter for a property. The argument to this method is a lambda expression
that specifies the property to be implemented, which is Products in this example. The Returns method is called on the result of the
SetupGet method to specify the result that will be returned when the property value is read.

The Mock class defines an Object property, which returns the object that implements the specified interface with the behaviors
that have been defined. I used the Object property to set the dataSource field defined by the HomeController, like this:

controller.dataSource = mock.Object;
The final Moq feature I used was to check that the Products property was called once, like this:
mock.VerifyGet(m => m.Products, Times.Once);

The VerifyGet method is one of the methods defined by the Mock class to inspect the state of the mock object when the test has
completed. In this case, the VerifyGet method allows me to check the number of times that the Products property method has been
read. The Times.Once value specifies that the VerifyGet method should throw an exception if the property has not been read exactly
once, which will cause the test to fail. (The Assert methods usually used in tests work by throwing an exception when a test fails,
which is why the VerifyGet method can be used to replace an Assert method when working with mock objects.)

The overall effect is the same as my fake interface implementation, but mocking is more flexible and more concise and can
provide more insight into the behavior of the components under test.

Summary

This chapter focused on unit testing, which can be a powerful tool for improving the quality of code. Unit testing doesn’t suit every
developer, but it is worth experimenting with and can be useful even if used only for complex features or problem diagnosis. I
described the use of the xUnit.net test framework, explained the importance of isolating components for testing, and demonstrated
some tools and techniques for simplifying unit test code. In the next chapter, I start the development of a more realistic project,
named SportsStore.
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SportsStore: A Real Application

In the previous chapters, I built quick and simple ASP.NET Core applications. I described ASP.NET Core patterns, the essential C#
features, and the tools that good ASP.NET Core developers require. Now it is time to put everything together and build a simple but
realistic e-commerce application.

My application, called SportsStore, will follow the classic approach taken by online stores everywhere. I will create an online
product catalog that customers can browse by category and page, a shopping cart where users can add and remove products, and
a checkout where customers can enter their shipping details. I will also create an administration area that includes create, read,
update, and delete (CRUD) facilities for managing the catalog, and I will protect it so that only logged-in administrators can make
changes.

My goal in this chapter and those that follow is to give you a sense of what real ASP.NET Core development is by creating
as realistic an example as possible. I want to focus on ASP.NET Core, of course, so I have simplified the integration with external
systems, such as the database, and omitted others entirely, such as payment processing.

You might find the going a little slow as I build up the levels of infrastructure I need, but the initial investment will result in
maintainable, extensible, well-structured code with excellent support for unit testing.

UNIT TESTING

| include sections on unit testing different components in the SportsStore application throughout the development process,
demonstrating how to isolate and test different ASPNET Core components.

| know that unit testing is not embraced by everyone. If you do not want to unit test, that is fine with me. To that end, when I have
something to say that is purely about testing, | put it in a sidebar like this one. If you are not interested in unit testing, you can
skip right over these sections, and the SportsStore application will work just fine. You do not need to do any kind of unit testing
to get the technology benefits of ASP.NET Core, although, of course, support for testing is a key reason for adopting ASP.NET Core
in many projects.

Most of the features I use for the SportsStore application have their own chapters later in the book. Rather than duplicate
everything here, I tell you just enough to make sense of the example application and point you to another chapter for in-depth
information.

I'will call out each step needed to build the application so that you can see how the ASP.NET Core features fit together. You
should pay particular attention when I create views. You will get some odd results if you do not follow the examples closely.

Creating the Projects

I am going to start with a minimal ASP.NET Core project and add the features I require as they are needed. Open a new PowerShell
command prompt from the Windows Start menu and run the commands shown in Listing 7-1 to get started.

Tip You can download the example project for this chapter—and for all the other chapters in this book—from https://github.
com/apress/pro-asp.net-core-3. See Chapter 1 for how to get help if you have problems running the examples.
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Listing 7-1. Creating the SportsStore Project

dotnet new globaljson --sdk-version 3.1.101 --output SportsSln/SportsStore
dotnet new web --no-https --output SportsSln/SportsStore --framework netcoreapp3.1
dotnet new sln -o SportsSln

dotnet sln SportsSln add SportsSln/SportsStore

These commands create a SportsSln solution folder that contains a SportsStore project folder created with the web project
template. The SportsSln folder also contains a solution file, to which the SportsStore project is added.

I am using different names for the solution and project folders to make the examples easier to follow, but if you create a project

with Visual Studio, the default is to use the same name for both folders. There is no “right” approach, and you can use whatever
names suit your project.

Creating the Unit Test Project

To create the unit test project, run the commands shown in Listing 7-2 in the same location you used for the commands shown in
Listing 7-1.

Listing 7-2. Creating the Unit Test Project

dotnet new xunit -o SportsSln/SportsStore.Tests --framework netcoreapp3.i
dotnet sln SportsSln add SportsSln/SportsStore.Tests
dotnet add SportsSln/SportsStore.Tests reference SportsSln/SportsStore

I am going to use the Moq package to create mock objects. Run the command shown in Listing 7-3 to install the Moq package
into the unit testing project. Run this command from the same location as the commands in Listings 7-1 and 7-2.

Listing 7-3. Installing the Moq Package

dotnet add SportsSln/SportsStore.Tests package Moq --version 4.13.1

Creating the Application Project Folders

The next step is to create folders that will contain the application’s components. Right-click the SportsStore item in the Visual Studio
Solution Explorer or Visual Studio Code Explorer pane and select Add » New Folder or New Folder to create the set of folders
described in Table 7-1.

Table 7-1. The Folders Created in Listing 7-3

Name Description

Models This folder will contain the data model and the classes that provide access to
the data in the application’s database.

Controllers This folder will contain the controller classes that handle HTTP requests.

Views This folder will contain all the Razor files, grouped into separate subfolders.

Views/Home This folder will contain Razor files that are specific to the Home controller,

which I create in the “Creating the Controller and View” section.

Views/Shared This folder will contain Razor files that are common to all controllers.
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Opening the Projects

If you are using Visual Studio Code, select File » Open Folder, navigate to the SportsSln folder, and click the Select Folder button.
Visual Studio Code will open the folder and discover the solution and project files. When prompted, as shown in Figure 7-1, click Yes
to install the assets required to build the projects. Select SportsStore if Visual Studio Code prompts you to select the project to run.

/\ Required assets to build and debug are missing from 3 X
'SportsSin’. Add them?

Source: C# (Extension) Don't Ask Again

Figure 7-1. Adding assets in Visual Studio Code

If you are using Visual Studio, click the “Open a project or solution” button on the splash screen or select File » Open »
Project/Solution. Select the SportsSln.sln file in the SportsSln folder and click the Open button to open the project. Once the
projects have been opened, select Project » SportsStore Properties, select the Debug section, and change the port for the URL in the
App URL field to 5000, as shown in Figure 7-2. Select File » Save All to save the new URL.

w SportsSin
SportsStore & X
Application

Build
Build Events

Package

Debug App URL: | http://localhost:5000
Signing

IIS Express Bitness: | Default
Code Analysis

TypeScript Build Hosting Model: Default (In Process)

Resources [] Enable SSL

Figure 7-2. Changing the HITP port in Visual Studio

Preparing the Application Services and the Request Pipeline

The Startup class is responsible for configuring the ASP.NET Core application. Apply the changes shown in Listing 7-4 to the
Startup class in the SportsStore project to configure the basic application features.

Note The Startup class is an important ASPNET Core feature. | describe it in detail in Chapter 12.
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Listing 7-4 Configuring the Application in the Startup.cs File in the SportsStore Folder

using System;

using System.Collections.Generic;

using System.Ling;

using System.Threading.Tasks;

using Microsoft.AspNetCore.Builder;

using Microsoft.AspNetCore.Hosting;

using Microsoft.AspNetCore.Http;

using Microsoft.Extensions.DependencyInjection;
using Microsoft.Extensions.Hosting;

namespace SportsStore {
public class Startup {

public void ConfigureServices(IServiceCollection services) {
services.AddControllersilithViews();
}

public void Configure(IApplicationBuilder app, IWebHostEnvironment env) {

app.UseDeveloperExceptionPage();
app.UseStatusCodePages();
app.UseStaticFiles();

app.UseRouting();
app.UseEndpoints(endpoints => {

endpoints.MapDefaultControllerRoute();
D;

The ConfigureServices method is used to set up objects, known as services, that can be used throughout the application and
that are accessed through a feature called dependency injection, which I describe in Chapter 14. The AddControllersWithViews
method called in the ConfigureServices method sets up the shared objects required by applications using the MVC Framework
and the Razor view engine.

ASP.NET Core receives HTTP requests and passes them along a request pipeline, which is populated with middleware
components registered in the Configure method. Each middleware component is able to inspect requests, modify them, generate
aresponse, or modify the responses that other components have produced. The request pipeline is the heart of ASP.NET Core, and
I describe it in detail in Chapter 12, where I also explain how to create custom middleware components. Table 7-2 describes the
methods that are used to set up middleware components in Listing 7-4.

Table 7-2. The Middleware Methods Used in Listing 7-4

Name Description

UseDeveloperExceptionPage() This extension method displays details of exceptions that occur in the application, which is
useful during the development process, as described in Chapter 16. It should not be enabled in
deployed applications, and I disable this feature when I prepare the SportsStore application for
deployment in Chapter 11.

UseStatusCodePages () This extension method adds a simple message to HTTP responses that would not otherwise
have a body, such as 404 - Not Found responses. This feature is described in Chapter 16.

UseStaticFiles() This extension method enables support for serving static content from the wwwroot folder. I
describe the support for static content in Chapter 15.
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One especially important middleware component provides the endpoint routing feature, which matches HTTP requests to the
application features - known as endpoints - able to produce responses for them, a process I describe in detail in Chapter 13. The
endpoint routing feature is added to the request pipeline with the UseRouting and UseEndpoints methods. To register the MVC
Framework as a source of endpoints, Listing 7-4 calls the MapDefaultControllerRoute method.

Configuring the Razor View Engine

The Razor view engine is responsible for processing view files, which have the .cshtml extension, to generate HTML responses.
Some initial preparation is required to configure Razor to make it easier to create views for the application.
Add a Razor View Imports file named ViewImports.cshtml in the Views folder with the content shown in Listing 7-5.

Caution Pay close attention to the contents of this file. It is easy to make a mistake that causes the application to generate incorrect
HTML content.

Listing 7-5. The Contents of the _ViewImports.cshtml File in the SportsStore/Views Folder

@using SportsStore.Models
@addTagHelper *, Microsoft.AspNetCore.Mvc.TagHelpers

The @using statement will allow me to use the types in the SportsStore.Models namespace in views without needing to refer
to the namespace. The @addTagHelper statement enables the built-in tag helpers, which I use later to create HTML elements that
reflect the configuration of the SportsStore application and which I describe in detail in Chapter 15.

Add a Razor View Start file named _ViewStart.cshtml to the SportsStore/Views folder with the content shown in Listing 7-6.
(The file will already contain this expression if you create the file using the Visual Studio item template.)

Listing 7-6. The Contents of the _ViewStart.cshtml File in the SportsStore/Views Folder

of
Layout =
}

_Layout";

The view start file tells Razor to use a layout file in the HTML that it generates, reducing the amount of duplication in views. To
create the view, add a Razor layout named _Layout.cshtml to the Views/Shared folder, with the content shown in Listing 7-7.

Listing 7-7. The Contents of the _Layout.cshtml File in the SportsStore/Views/Shared Folder

<!DOCTYPE html>
<html>
<head>
<meta name="viewport" content="width=device-width" />
<title>SportsStore</title>
</head>
<body>
<div>
@RenderBody()
</div>
</body>
</html>

This file defines a simple HTML document into which the contents of other views will be inserted by the @RenderBody
expression. I explain how Razor expressions work in detail in Chapter 21.
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Creating the Controller and View

Add a class file named HomeController.cs in the SportsStore/Controllers folder and use it to define the class shown in Listing 7-8.
This is a minimal controller that contains just enough functionality to produce a response.

Listing 7-8. The Contents of the HomeController.cs File in the SportsStore/Controllers Folder
using Microsoft.AspNetCore.Mvc;

namespace SportsStore.Controllers {
public class HomeController: Controller {

public IActionResult Index() => View();

The MapDefaultControllerRoute method used in Listing 7-4 tells ASP.NET Core how to match URLs to controller classes. The
configuration applied by that method declares that the Index action method defined by the Home controller will be used to handle
requests.

The Index action method doesn’t do anything useful yet and just returns the result of calling the View method, which is inherited
from the Controller base class. This result tells ASP.NET Core to render the default view associated with the action method. To create
the view, add a Razor View file named Index.cshtml to the Views/Home folder with the content shown in Listing 7-9.

Listing 7-9. The Contents of the Index.cshtml File in the SportsStore/Views/Home Folder

<h4>Welcome to SportsStore</h4>

Starting the Data Model

Almost all projects have a data model of some sort. Since this is an e-commerce application, the most obvious model I need is for a
product. Add a class file named Product. cs to the Models folder and use it to define the class shown in Listing 7-10.

Listing 7-10. The Contents of the Product.cs File in the SportsStore/Models Folder
using System.ComponentModel.DataAnnotations.Schema;
namespace SportsStore.Models {
public class Product {
public long ProductID { get; set; }
public string Name { get; set; }
public string Description { get; set; }

[Column(TypeName = "decimal(8, 2)")]
public decimal Price { get; set; }

public string Category { get; set; }

The Price property has been decorated with the Column attribute to specify the SQL data type that will be used to store values
for this property. Not all C# types map neatly onto SQL types, and this attribute ensures the database uses an appropriate type for the
application data.
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Checking and Running the Application

Before going any further, it is a good idea to make sure the application builds and runs as expected. Select Start Without Debugging
or Run Without Debugging from the Debug menu or run the command shown in Listing 7-11 in the SportsStore folder.

Listing 7-11 Running the Example Application

dotnet run

Request http://localhost: 5000, and you will see the response shown in Figure 7-3.

& SportsStore X

o C @ localhost:5000 r :

Welcome to SportsStore

Figure 7-3. Running the example application

Adding Data to the Application

Now that the SportsStore contains some basic setup and can produce a simple response, it is time to add some data so that the
application has something more useful to display. The SportsStore application will store its data in a SQL Server LocalDB database,
which is accessed using Entity Framework Core. Entity Framework Core is the Microsoft object-to-relational mapping (ORM)
framework, and it is the most widely used method of accessing databases in ASP.NET Core projects.

Caution If you did not install LocalDB when you prepared your development environment in Chapter 2, you must do so now. The
SportsStore application will not work without its database.

Installing the Entity Framework Core Packages

The first step is to add Entity Framework Core to the project. Use a PowerShell command prompt to run the command shown in
Listing 7-12 in the SportsStore folder.

Listing 7-12. Adding the Entity Framework Core Packages to the SportsStore Project

dotnet add package Microsoft.EntityFrameworkCore.Design --version 3.1.1
dotnet add package Microsoft.EntityFrameworkCore.SqlServer --version 3.1.1

These packages install Entity Framework Core and the support for using SQL Server. Entity Framework Core also requires a
tools package, which includes the command-line tools required to prepare and create databases for ASP.NET Core applications. Run
the commands shown in Listing 7-13 to remove any existing version of the tools package, if there is one, and install the version used
in this book. (Since this package is installed globally, you can run these commands in any folder.)
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Listing 7-13. Installing the Entity Framework Core Tool Package

dotnet tool uninstall --global dotnet-ef
dotnet tool install --global dotnet-ef --version 3.1.1

Defining the Connection String

Configuration settings, such as database connection strings, are stored in JSON configuration files. To describe the connection to
the database that will be used for the SportsStore data, add the entries shown in Listing 7-14 to the appsettings.json file in the
SportsStore folder.

The project also contains an appsettings.Development. json file that contains configuration settings that are used only in
development. This file is displayed as nested within the appsettings. json file by Solution Explorer but is always visible in Visual
Studio Code. I use only the appsettings.json file for the development of the SportsStore project, but I explain the relationship
between the files and how they are both used in detail in Chapter 15.

Tip Connection strings must be expressed as a single unbroken line, which is fine in the code editor but doesn’t fit on the printed
page and is the cause of the awkward formatting in Listing 7-14. When you define the connection string in your own project, make sure
that the value of the SportsStoreConnection item is on a single line.

Listing 7-14. Adding a Configuration Setting in the appsettings.json File in the SportsStore Folder

{
"Logging": {
"LogLevel": {
"Default": "Information",
"Microsoft": "Warning",
"Microsoft.Hosting.Lifetime": "Information"

}
b
"AllowedHosts": "x",
"ConnectionStrings”: {
"SportsStoreConnection": "Server=(localdb)\\MSSOLLocalDB;Database=SportsStore;MultipleActiveResultSets=true"
}

}

This configuration string specifies a LocalDB database called SportsStore and enables the multiple active result set feature (MARS),
which is required for some of the database queries that will be made by the SportsStore application using Entity Framework Core.

Pay close attention when you add the configuration setting. JSON data must be expressed exactly as shown in the listing, which
means you must ensure you correctly quote the property names and values. You can download the configuration file from the
GitHub repository if you have difficulty.

Tip Each database server requires its own connection string format. A helpful site for formulating connection strings is

www.connectionstrings.com.

Creating the Database Context Class

Entity Framework Core provides access to the database through a context class. Add a class file named StoreDbContext.cs to the
Models folder and use it to define the class shown in Listing 7-15.
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Listing 7-15. The Contents of the StoreDbContext.cs File in the SportsStore/Models Folder
using Microsoft.EntityFrameworkCore;

namespace SportsStore.Models {
public class StoreDbContext: DbContext {

public StoreDbContext(DbContextOptions<StoreDbContext> options)
: base(options) { }

public DbSet<Product> Products { get; set; }

The DbContext base class provides access to the Entity Framework Core’s underlying functionality, and the Products property
will provide access to the Product objects in the database. The StoreDbContext class is derived from DbContext and adds the
properties that will be used to read and write the application’s data. There is only one property for now, which will provide access to
Product objects.

Configuring Entity Framework Core

Entity Framework Core must be configured so that it knows the type of database to which it will connect, which connection string
describes that connection, and which context class will present the data in the database. Listing 7-16 shows the required changes to
the Startup class.

Listing 7-16. Configuring Entity Framework Core in the Startup.cs File in the SportsStore Folder

using System;

using System.Collections.Generic;

using System.Lling;

using System.Threading.Tasks;

using Microsoft.AspNetCore.Builder;

using Microsoft.AspNetCore.Hosting;

using Microsoft.AspNetCore.Http;

using Microsoft.Extensions.DependencyInjection;
using Microsoft.Extensions.Hosting;

using Microsoft.Extensions.Configuration;
using Microsoft.EntityFrameworkCore;
using SportsStore.Models;

namespace SportsStore {
public class Startup {

public Startup(IConfiguration config) {
Configuration = config;
}

private IConfiguration Configuration { get; set; }

public void ConfigureServices(IServiceCollection services) {
services.AddControllersWithViews();
services.AddDbContext<StoreDbContexts(opts => {
opts.UseSqlServer(
Configuration[ "ConnectionStrings:SportsStoreConnection"]);
H
}

public void Configure(IApplicationBuilder app, IWebHostEnvironment env) {
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app.UseDeveloperExceptionPage();
app.UseStatusCodePages();
app.UseStaticFiles();

app.UseRouting();
app.UseEndpoints(endpoints => {

endpoints.MapDefaultControllerRoute();
1;

The IConfiguration interface provides access to the ASP.NET Core configuration system, which includes the contents of the
appsettings.json file and which I describe in detail in Chapter 15. The constructor receives an IConfiguration object through its
constructor and assigns it to the Configuration property, which is used to access the connection string.

Entity Framework Core is configured with the AddDbContext method, which registers the database context class and configures
the relationship with the database. The UseSQLServer method declares that SQL Server is being used and the connection string is
read via the IConfiguration object.

Creating a Repository

The next step is to create a repository interface and implementation class. The repository pattern is one of the most widely used, and
it provides a consistent way to access the features presented by the database context class. Not everyone finds a repository useful,
but my experience is that it can reduce duplication and ensures that operations on the database are performed consistently. Add a
class file named IStoreRepository.cs to the Models folder and use it to define the interface shown in Listing 7-17.

Listing 7-17. The Contents of the IStoreRepository.cs File in the SportsStore/Models Folder
using System.Lling;

namespace SportsStore.Models {
public interface IStoreRepository {

IQueryable<Product> Products { get; }

This interface uses IQueryable<T> to allow a caller to obtain a sequence of Product objects. The IQueryable<T> interface is
derived from the more familiar IEnumerable<T> interface and represents a collection of objects that can be queried, such as those
managed by a database.

A class that depends on the IProductRepository interface can obtain Product objects without needing to know the details of
how they are stored or how the implementation class will deliver them.

UNDERSTANDING IENUMERABLE<T> AND IQUERYABLE<T> INTERFACES

The IQueryable<T> interface is useful because it allows a collection of objects to be queried efficiently. Later in this chapter, |
add support for retrieving a subset of Product objects from a database, and using the IQueryable<T> interface allows me to
ask the database for just the objects that | require using standard LINQ statements and without needing to know what database
server stores the data or how it processes the query. Without the IQueryable<T> interface, | would have to retrieve all of the
Product objects from the database and then discard the ones that | don’t want, which becomes an expensive operation as the
amount of data used by an application increases. It is for this reason that the IQueryable<T> interface is typically used instead
of IEnumerable<T> in database repository interfaces and classes.

However, care must be taken with the IQueryable<T> interface because each time the collection of objects is enumerated, the
query will be evaluated again, which means that a new query will be sent to the database. This can undermine the efficiency
gains of using IQueryable<T>. In such situations, you can convert the IQueryable<T> interface to a more predictable form
using the ToList or ToArray extension method.
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To create an implementation of the repository interface, add a class file named EFStoreRepository.cs in the Models folder and
use it to define the class shown in Listing 7-18.

Listing 7-18. The Contents of the EFStoreRepository.cs File in the SportsStore/Models Folder
using System.ling;

namespace SportsStore.Models {
public class EFStoreRepository : IStoreRepository {
private StoreDbContext context;

public EFStoreRepository(StoreDbContext ctx) {
context = ctx;
}

public IQueryable<Product> Products => context.Products;

I'll add additional functionality as I add features to the application, but for the moment, the repository implementation just
maps the Products property defined by the IStoreRepository interface onto the Products property defined by the StoreDbContext
class. The Products property in the context class returns a DbSet<Product> object, which implements the IQueryable<T> interface
and makes it easy to implement the repository interface when using Entity Framework Core.

Earlier in the chapter, I explained that ASP.NET Core supports services that allow objects to be accessed throughout the
application. One benefit of services is they allow classes to use interfaces without needing to know which implementation class is
being used. I explain this in detail in Chapter 14, but for the SportsStore chapters, it means that application components can access
objects that implement the IStoreRepository interface without knowing that it is the EFStoreRepository implementation class
they are using. This makes it easy to change the implementation class the application uses without needing to make changes to the
individual components. Add the statement shown in Listing 7-19 to the Startup class to create a service for the IStoreRepository
interface that uses EFStoreRepository as the implementation class.

Tip Don’t worry if this doesn’t make sense right now. This topic is one of the most confusing aspects of working with ASP.NET Core,
and it can take a while to understand.

Listing 7-19. Creating the Repository Service in the Startup.cs File in the SportsStore Folder

using System;

using System.Collections.Generic;

using System.Ling;

using System.Threading.Tasks;

using Microsoft.AspNetCore.Builder;

using Microsoft.AspNetCore.Hosting;

using Microsoft.AspNetCore.Http;

using Microsoft.Extensions.DependencyInjection;
using Microsoft.Extensions.Hosting;

using Microsoft.Extensions.Configuration;
using Microsoft.EntityFrameworkCore;
using SportsStore.Models;

namespace SportsStore {
public class Startup {
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public Startup(IConfiguration config) {
Configuration = config;
}

private IConfiguration Configuration { get; set; }

public void ConfigureServices(IServiceCollection services) {
services.AddControllersWithViews();

services.AddDbContext<StoreDbContext>(opts => {
opts.UseSqlServer(
Configuration["ConnectionStrings:SportsStoreConnection"]);
D;

services.AddScoped<IStoreRepository, EFStoreRepositorys();

}

public void Configure(IApplicationBuilder app, IWebHostEnvironment env) {

app.UseDeveloperExceptionPage();
app.UseStatusCodePages();
app.UseStaticFiles();

app.UseRouting();
app.UseEndpoints(endpoints => {

endpoints.MapDefaultControllerRoute();
D;

The AddScoped method creates a service where each HTTP request gets its own repository object, which is the way that Entity
Framework Core is typically used.

Creating the Database Migration

Entity Framework Core is able to generate the schema for the database using the data model classes through a feature called
migrations. When you prepare a migration, Entity Framework Core creates a C# class that contains the SQL commands required
to prepare the database. If you need to modify your model classes, then you can create a new migration that contains the SQL
commands required to reflect the changes. In this way, you don’t have to worry about manually writing and testing SQL commands
and can just focus on the C# model classes in the application.

Entity Framework Core commands are performed from the command line. Open a PowerShell command prompt and run the
command shown in Listing 7-20 in the SportsStore folder to create the migration class that will prepare the database for its first use.

Listing 7-20. Creating the Database Migration

dotnet ef migrations add Initial

When this command has finished, the SportsStore project will contain a Migrations folder. This is where Entity Framework
Core stores its migration classes. One of the file names will be a timestamp followed by _Initial.cs, and this is the class that will be
used to create the initial schema for the database. If you examine the contents of this file, you can see how the Product model class
has been used to create the schema.
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WHAT ABOUT THE ADD-MIGRATION AND UPDATE-DATABASE COMMANDS?

If you are an experienced Entity Framework developer, you may be used to using the Add-Migration command to create a

database migration and to using the Update-Database command to apply it to a database.

With the introduction of .NET Core, Entity Framework Core has added commands that are integrated into the dotnet command-
line tool, using the commands added by the Microsoft.EntityFrameworkCore.Tools.DotNet package. These are the
commands that | have used because they are consistent with other .NET commands and they can be used in any command
prompt or PowerShell window, unlike the Add-Migration and Update-Database commands, which work only in a specific

Visual Studio window.

Creating Seed Data

To populate the database and provide some sample data, [ added a class file called SeedData.cs to the Models folder and defined the

class shown in Listing 7-21.

Listing 7-21. The Contents of the SeedData.cs File in the SportsStore/Models Folder

using System.Lling;

using Microsoft.AspNetCore.Builder;
using Microsoft.Extensions.DependencyInjection;
using Microsoft.EntityFrameworkCore;

namespace SportsStore.Models {

public static class

SeedData {

public static void EnsurePopulated(IApplicationBuilder app) {
StoreDbContext context = app.ApplicationServices
.CreateScope().ServiceProvider.GetRequiredService<StoreDbContext>();

if (context.
context.

}

Database.GetPendingMigrations().Any()) {
Database.Migrate();

if (!context.Products.Any()) {

context.

new

b

new

b

new

b

new

1

Products.AddRange(

Product {

Name = "Kayak", Description = "A boat for one person",
Category = "Watersports", Price = 275

Product {

Name = "Lifejacket",

Description = "Protective and fashionable",
Category = "Watersports", Price = 48.95m

Product {
Name = "Soccer Ball",
Description = "FIFA-approved size and weight",

Category = "Soccer", Price = 19.50m

Product {

Name = "Corner Flags",

Description = "Give your playing field a professional touch",
Category = "Soccer", Price = 34.95m
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new Product {
Name = "Stadium",
Description = "Flat-packed 35,000-seat stadium",
Category = "Soccer", Price = 79500

b

new Product {
Name = "Thinking Cap",
Description = "Improve brain efficiency by 75%",
Category = "Chess", Price = 16

b

new Product {
Name = "Unsteady Chair",
Description = "Secretly give your opponent a disadvantage",
Category = "Chess", Price = 29.95m

1

new Product {
Name = "Human Chess Board",
Description = "A fun game for the family",
Category = "Chess", Price = 75

new Product {
Name = "Bling-Bling King",
Description = "Gold-plated, diamond-studded King",
Category = "Chess", Price = 1200
}
)

context.SaveChanges();

The static EnsurePopulated method receives an IApplicationBuilder argument, which is the interface used in the Configure
method of the Startup class to register middleware components to handle HTTP requests. IApplicationBuilder also provides
access to the application’s services, including the Entity Framework Core database context service.

The EnsurePopulated method obtains a StoreDbContext object through the IApplicationBuilder interface and calls the
Database.Migrate method if there are any pending migrations, which means that the database will be created and prepared so that
it can store Product objects. Next, the number of Product objects in the database is checked. If there are no objects in the database,
then the database is populated using a collection of Product objects using the AddRange method and then written to the database
using the SaveChanges method.

The final change is to seed the database when the application starts, which I have done by adding a call to the EnsurePopulated
method from the Startup class, as shown in Listing 7-22.

Listing 7-22. Seeding the Database in the Startup.cs File in the SportsStore Folder

using System;

using System.Collections.Generic;

using System.Ling;

using System.Threading.Tasks;

using Microsoft.AspNetCore.Builder;

using Microsoft.AspNetCore.Hosting;

using Microsoft.AspNetCore.Http;

using Microsoft.Extensions.DependencyInjection;
using Microsoft.Extensions.Hosting;

using Microsoft.Extensions.Configuration;
using Microsoft.EntityFrameworkCore;
using SportsStore.Models;
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namespace SportsStore {
public class Startup {

public Startup(IConfiguration config) {
Configuration = config;
}

private IConfiguration Configuration { get; set; }

public void ConfigureServices(IServiceCollection services) {
services.AddControllersWithViews();

services.AddDbContext<StoreDbContext>(opts => {
opts.UseSqlServer(
Configuration["ConnectionStrings:SportsStoreConnection"]);
1;

services.AddScoped<IStoreRepository, EFStoreRepository>();

}

public void Configure(IApplicationBuilder app, IWebHostEnvironment env) {

app.UseDeveloperExceptionPage();
app.UseStatusCodePages();
app.UseStaticFiles();

app.UseRouting();
app.UseEndpoints(endpoints => {
endpoints.MapDefaultControllerRoute();

1;
SeedData.EnsurePopulated(app);

RESETTING THE DATABASE

If you need to reset the database, then run this command in the SportsStore folder:
dotnet ef database drop --force --context StoreDbContext

Start ASP.NET Core, and the database will be re-created and seeded with data.

Displaying a List of Products

Asyou have seen, the initial preparation work for an ASP.NET Core project can take some time. But the good news is that once the
foundation is in place, the pace improves, and features are added more rapidly. In this section, I am going to create a controller and
an action method that can display details of the products in the repository.

USING THE VISUAL STUDIO SCAFFOLDING

As | noted in Chapter 4, Visual Studio supports scaffolding to add items to a project.

| don’t use the scaffolding in this book. The code and markup that the scaffolding generates are so generic as to be all but
useless, and the scenarios that are supported are narrow and don’t address common development problems. My goal in this
book is not only to make sure you know how to create ASP.NET Core applications but also to explain how everything works
behind the scenes, and that is harder to do when responsibility for creating components is handed to the scaffolding.
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If you are using Visual Scer in the Solution Explorer, selecting Add » New Item from the pop-up menu, and then choosing an
item template from the Add New ltem window.

You may find your development style to be different from mine, and you may find that you prefer working with the scaffolding in
your own projects. That’s perfectly reasonable, although | recommend you take the time to understand what the scaffolding does
s0 you know where to look if you don’t get the results you expect.

Preparing the Controller

Add the statements shown in Listing 7-23 to prepare the controller to display the list of products.
Listing 7-23. Preparing the Controller in the HomeController.cs File in the SportsStore/Controllers Folder

using Microsoft.AspNetCore.Mvc;
using SportsStore.Models;

namespace SportsStore.Controllers {
public class HomeController : Controller {
private IStoreRepository repository;

public HomeController(IStoreRepository repo) {
repository = repo;
}

public IActionResult Index() =»> View(repository.Products);

When ASP.NET Core needs to create a new instance of the HomeController class to handle an HTTP request, it will inspect the
constructor and see that it requires an object that implements the IStoreRepository interface. To determine what implementation
class should be used, ASP.NET Core consults the configuration in the Startup class, which tells it that EFStoreRepository should be
used and that a new instance should be created for every request. ASP.NET Core creates a new EFStoreRepository object and uses it
to invoke the HomeController constructor to create the controller object that will process the HTTP request.

This is known as dependency injection, and its approach allows the HomeController object to access the application’s repository
through the IStoreRepository interface without knowing which implementation class has been configured. I could reconfigure
the service to use a different implementation class—one that doesn’t use Entity Framework Core, for example—and dependency
injection means that the controller will continue to work without changes.

Note Some developers don’t like dependency injection and believe it makes applications more complicated. That’s not my view, but
if you are new to dependency injection, then | recommend you wait until you have read Chapter 14 before you make up your mind.

UNIT TEST: REPOSITORY ACCESS

| can unit test that the controller is accessing the repository correctly by creating a mock repository, injecting it into the
constructor of the HomeController class, and then calling the Index method to get the response that contains the list of
products. | then compare the Product objects | get to what | would expect from the test data in the mock implementation.
See Chapter 6 for details of how to set up unit tests. Here is the unit test | created for this purpose, in a class file called
HomeControllerTests.cs that | added to the SportsStore.Tests project:

using System.Collections.Generic;
using System.Ling;
using Microsoft.AspNetCore.Mvc;
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using Mogq;

using SportsStore.Controllers;
using SportsStore.Models;
using Xunit;

namespace SportsStore.Tests {
public class ProductControllerTests {

[Fact]
public void Can_Use Repository() {
// Arrange
Mock<IStoreRepository> mock = new Mock<IStoreRepository>();
mock.Setup(m => m.Products).Returns((new Product[] {
new Product {ProductID = 1, Name = "P1"},
new Product {ProductID = 2, Name = "P2"}
}) .AsQueryable<Product>());

HomeController controller = new HomeController(mock.Object);

// Act
IEnumerable<Product> result =
(controller.Index() as ViewResult).ViewData.Model
as IEnumerable<Product>;

// Assert

Product[] prodArray = result.ToArray();
Assert.True(prodArray.Length == 2);
Assert.Equal("P1", prodArray[0].Name);
Assert.Equal("P2", prodArray[1].Name);

}

It is a little awkward to get the data returned from the action method. The result is a ViewResult object, and | have to cast the
value of its ViewData.Model property to the expected data type. | explain the different result types that can be returned by action
methods and how to work with them in Part 2.

Updating the View

The Index action method in Listing 7-23 passes the collection of Product objects from the repository to the View method, which
means these objects will be the view model that Razor uses when it generates HTML content from the view. Make the changes to the
view shown in Listing 7-24 to generate content using the Product view model objects.

Listing 7-24. Using the Product Data in the Index.cshtml File in the SportsStore/Views/Home Folder
@model IQueryable<Product>

@foreach (var p in Model) {
<div>
<h3>@p.Name</h3>
@p.Description
<h4>@p.Price.ToString("c")</h4>
</div>
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The @model expression at the top of the file specifies that the view expects to receive a sequence of Product objects from the
action method as its model data. [ use an @foreach expression to work through the sequence and generate a simple set of HTML
elements for each Product object that is received.

The view doesn’t know where the Product objects came from, how they were obtained, or whether they represent all the products
known to the application. Instead, the view deals only with how details of each Product are displayed using HTML elements.

Tip | converted the Price property to a string using the ToString("c") method, which renders numerical values as currency
according to the culture settings that are in effect on your server. For example, if the server is set up as en-Us, then (1002.3).
ToString("c") will return $1,002.30, but if the server is set to en-GB, then the same method will return £1,002. 30.

Running the Application

Start ASP.NET Core and request http://localhost:5000 to see the list of products, which is shown in Figure 7-4. This is the typical
pattern of development for ASP.NET Core. An initial investment of time setting everything up is necessary, and then the basic
features of the application snap together quickly.

m

< C @ localhost:5000 %
Kayak
A boat for one person
£275.00
Lifejacket

Protective and fashionable
£48.95

Soccer Ball
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Figure 7-4. Displaying a list of products

Adding Pagination

You can see from Figure 7-4 that the Index.cshtml view displays the products in the database on a single page. In this section, I will
add support for pagination so that the view displays a smaller number of products on a page, and the user can move from page to
page to view the overall catalog. To do this, I am going to add a parameter to the Index method in the Home controller, as shown in
Listing 7-25.

Listing 7-25. Adding Pagination in the HomeController.cs File in the SportsStore/Controllers Folder

using Microsoft.AspNetCore.Mvc;
using SportsStore.Models;
using System.Linq;

namespace SportsStore.Controllers {
public class HomeController : Controller {
private IStoreRepository repository;
public int PageSize = 4;
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public HomeController(IStoreRepository repo) {
repository = repo;
}

public ViewResult Index(int productPage = 1)
=» View(repository.Products
.OrderBy(p => p.ProductID)
.Skip((productPage - 1) % PageSize)
.Take(PageSize));

The PageSize field specifies that I want four products per page. I have added an optional parameter to the Index method,
which means that if the method is called without a parameter, the call is treated as though I had supplied the value specified in
the parameter definition, with the effect that the action method displays the first page of products when it is invoked without an
argument. Within the body of the action method, I get the Product objects, order them by the primary key, skip over the products
that occur before the start of the current page, and take the number of products specified by the PageSize field.

UNIT TEST: PAGINATION

| can unit test the pagination feature by mocking the repository, requesting a specific page from the controller, and making sure
| get the expected subset of the data. Here is the unit test | created for this purpose and added to the HomeControllerTests.cs
file in the SportsStore.Tests project:

using System.Collections.Generic;
using System.Lling;

using Microsoft.AspNetCore.Mvc;
using Mogq;

using SportsStore.Controllers;
using SportsStore.Models;

using Xunit;

namespace SportsStore.Tests {
public class ProductControllerTests {

[Fact]
public void Can_Use Repository() {

// ...statements omitted for brevity...
}

[Fact]

public void Can_Paginate() {
// Arrange
Mock<IStoreRepository> mock = new Mock<IStoreRepositorys();
mock.Setup(m => m.Products).Returns((new Product[] {

new Product {ProductID = 1, Name = "P1"},
new Product {ProductID = 2, Name = "P2"},
new Product {ProductID = 3, Name = "P3"},
new Product {ProductID = 4, Name = "P4"},
new Product {ProductID = 5, Name = "P5"}

}) .AsQueryable<Product>());

HomeController controller = new HomeController(mock.Object);
controller.PageSize = 3;

// Act
IEnumerable<Producty result =
(controller.Index(2) as ViewResult).ViewData.Model
as IEnumerable<Products;
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// Assert

Product[] prodArray = result.ToArray();
Assert.True(prodArray.Length == 2);
Assert.Equal("P4", prodArray[0].Name);
Assert.Equal("P5", prodArray[1].Name);

You can see the new test follows the pattern of the existing one, relying on Moq to provide a known set of data with which to work.

Displaying Page Links

Restart ASP.NET Core and request http://localhost:5000, and you will see that there are now four items shown on the page, as
shown in Figure 7-5. If you want to view another page, you can append query string parameters to the end of the URL, like this:

http://localhost:5000/?productPage=2

@ SportsStore X
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Figure 7-5. Paging through data

Using these query strings, you can navigate through the catalog of products. There is no way for customers to figure out that
these query string parameters exist, and even if there were, customers are not going to want to navigate this way. Instead, I need to
render some page links at the bottom of each list of products so that customers can navigate between pages. To do this,  am going to
create a fag helper, which generates the HTML markup for the links I require.

Adding the View Model

To support the tag helper, I am going to pass information to the view about the number of pages available, the current page, and
the total number of products in the repository. The easiest way to do this is to create a view model class, which is used specifically
to pass data between a controller and a view. Create a Models/ViewModels folder in the SportsStore project, add to it a class file
named PagingInfo.cs, and define the class shown in Listing 7-26.
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Listing 7-26. The Contents of the PagingInfo.cs File in the SportsStore/Models/ViewModels Folder
using System;
namespace SportsStore.Models.ViewModels {

public class PagingInfo {
public int TotalItems { get; set; }
public int ItemsPerPage { get; set; }
public int CurrentPage { get; set; }

public int TotalPages =>
(int)Math.Ceiling((decimal)TotalItems / ItemsPerPage);

Adding the Tag Helper Class

Now that I have a view model, it is time to create a tag helper class. Create a folder named Infrastructure in the SportsStore
project and add to it a class file called PageLinkTagHelper.cs, with the code shown in Listing 7-27. Tag helpers are a big part of ASP.
NET Core development, and I explain how they work and how to use and create them in Chapters 25-27.

Tip The Infrastructure folder is where | put classes that deliver the plumbing for an application but that are not related to the
application’s main functionality. You don’t have to follow this convention in your own projects.

Listing 7-27. The Contents of the PageLinkTagHelper.cs File in the SportsStore/Infrastructure Folder

using Microsoft.AspNetCore.Mvc;

using Microsoft.AspNetCore.Mvc.Rendering;
using Microsoft.AspNetCore.Mvc.Routing;
using Microsoft.AspNetCore.Mvc.ViewFeatures;
using Microsoft.AspNetCore.Razor.TagHelpers;
using SportsStore.Models.ViewModels;

namespace SportsStore.Infrastructure {
[HtmlTargetElement("div", Attributes = "page-model")]
public class PagelinkTagHelper : TagHelper {
private IUrlHelperFactory urlHelperFactory;
public PagelinkTagHelper(IUrlHelperFactory helperFactory) {
urlHelperFactory = helperFactory;
}

[ViewContext]

[HtmlAttributeNotBound]

public ViewContext ViewContext { get; set; }

public PagingInfo PageModel { get; set; }

public string PageAction { get; set; }

public override void Process(TagHelperContext context,

TagHelperOutput output) {
IUrlHelper urlHelper = urlHelperFactory.GetUrlHelper(ViewContext);
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TagBuilder result = new TagBuilder("div");
for (int i = 1; i <= PageModel.TotalPages; i++) {
TagBuilder tag = new TagBuilder("a");
tag.Attributes["href"] = urlHelper.Action(PageAction,
new { productPage = i });
tag.InnerHtml.Append(i.ToString());
result.InnerHtml.AppendHtml(tag);

}
output.Content.AppendHtml(result.InnerHtml);

This tag helper populates a div element with a elements that correspond to pages of products. I am not going to go into detail
about tag helpers now; it is enough to know that they are one of the most useful ways that you can introduce C# logic into your views.
The code for a tag helper can look tortured because C# and HTML don’t mix easily. But using tag helpers is preferable to including
blocks of C# code in a view because a tag helper can be easily unit tested.

Most ASP.NET Core components, such as controllers and views, are discovered automatically, but tag helpers have to be
registered. In Listing 7-28, I have added a statement to the _ViewImports.cshtml file in the Views folder that tells ASP.NET Core to
look for tag helper classes in the SportsStore project. I also added an @using expression so that I can refer to the view model classes
in views without having to qualify their names with the namespace.

Listing 7-28. Registering a Tag Helper in the _ViewImports.cshtml File in the SportsStore/Views Folder

@using SportsStore.Models

@using SportsStore.Models.ViewModels

@addTagHelper *, Microsoft.AspNetCore.Mvc.TagHelpers
@addTagHelper *, SportsStore

UNIT TEST: CREATING PAGE LINKS

To test the PageLinkTagHelper tag helper class, | call the Process method with test data and provide a TagHelperOutput
object that | inspect to see the HTML that is generated, as follows, which | defined in a new PageLinkTagHelperTests.cs file in
the SportsStore.Tests project:

using System.Collections.Generic;

using System.Threading.Tasks;

using Microsoft.AspNetCore.Mvc;

using Microsoft.AspNetCore.Mvc.Routing;
using Microsoft.AspNetCore.Razor.TagHelpers;
using Mog;

using SportsStore.Infrastructure;

using SportsStore.Models.ViewModels;

using Xunit;

namespace SportsStore.Tests {
public class PagelLinkTagHelperTests {

[Fact]
public void Can_Generate Page Links() {
// Arrange
var urlHelper = new Mock<IUrlHelper>();
urlHelper.SetupSequence(x => x.Action(It.IsAny<UrlActionContext>()))
.Returns("Test/Page1")
.Returns("Test/Page2")
.Returns("Test/Page3");
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var urlHelperFactory = new Mock<IUrlHelperFactory>();
urlHelperFactory.Setup(f =>
f.GetUrlHelper(It.IsAny<ActionContext>()))
.Returns(urlHelper.Object);

PagelLinkTagHelper helper =
new PagelinkTagHelper(urlHelperFactory.Object) {
PageModel = new PagingInfo {
CurrentPage = 2,
TotalItems = 28,
ItemsPerPage = 10

}s
PageAction = "Test"

b
TagHelperContext ctx = new TagHelperContext(

new TagHelperAttributelist(),
new Dictionary<object, object>(), "");

var content = new Mock<TagHelperContent>();
TagHelperOutput output = new TagHelperOutput(“div",

new TagHelperAttributelist(),

(cache, encoder) => Task.FromResult(content.Object));

// Act
helper.Process(ctx, output);

// Assert

Assert.Equal(@"<a href=""Test/Page1"">1</a>"
+ @"<a href=""Test/Page2"">2</a>"
+ @"<a href=""Test/Page3"">3</a>",
output.Content.GetContent());

}

The complexity in this test is in creating the objects that are required to create and use a tag helper. Tag helpers use
IUrlHelperFactory objects to generate URLs that target different parts of the application, and | have used Moq to create an
implementation of this interface and the related TUr1lHelper interface that provides test data.

The core part of the test verifies the tag helper output by using a literal string value that contains double quotes. C# is perfectly
capable of working with such strings, as long as the string is prefixed with @ and uses two sets of double quotes ("") in place
of one set of double quotes. You must remember not to break the literal string into separate lines unless the string you are
comparing to is similarly broken. For example, the literal | use in the test method has wrapped onto several lines because the
width of a printed page is narrow. | have not added a newline character; if | did, the test would fail.

Adding the View Model Data

I am not quite ready to use the tag helper because I have yet to provide an instance of the PagingInfo view model class to the view.
To do this, I added a class file called ProductsListViewModel.cs to the Models/ViewModels folder of the SportsStore project with
the content shown in Listing 7-29.

Listing 7-29. The Contents of the ProductsListViewModel.cs File in the SportsStore/Models/ViewModels Folder

using System.Collections.Generic;
using SportsStore.Models;

namespace SportsStore.Models.ViewModels {
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public class ProductsListViewModel {
public IEnumerable<Product> Products { get; set; }
public PagingInfo PagingInfo { get; set; }

I can update the Index action method in the HomeController class to use the ProductsListViewModel class to provide the view
with details of the products to display on the page and with details of the pagination, as shown in Listing 7-30.

Listing 7-30. Updating the Action Method in the HomeController.cs File in the SportsStore/Controllers Folder

using Microsoft.AspNetCore.Mvc;
using SportsStore.Models;

using System.Ling;

using SportsStore.Models.ViewModels;

namespace SportsStore.Controllers {
public class HomeController : Controller {
private IStoreRepository repository;
public int PageSize = 4;

public HomeController(IStoreRepository repo) {
repository = repo;
}

public ViewResult Index(int productPage = 1)
=>» View(new ProductsListViewModel {

Products = repository.Products
.OxderBy(p => p.ProductID)
.Skip((productPage - 1) * PageSize)
.Take(PageSize),

PagingInfo = new PagingInfo {
CurrentPage = productPage,
ItemsPerPage = PageSize,
TotalItems = repository.Products.Count()

These changes pass a ProductsListViewModel object as the model data to the view.

UNIT TEST: PAGE MODEL VIEW DATA

| need to ensure that the controller sends the correct pagination data to the view. Here is the unit test | added to the
HomeControllerTests class in the test project to make sure:

[Fact]
public void Can_Send_Pagination_View_Model() {
// Arrange
Mock<IStoreRepository> mock = new Mock<IStoreRepository>();
mock.Setup(m => m.Products).Returns((new Product[] {
new Product {ProductID = 1, Name = "P1"},
new Product {ProductID = 2, Name = "P2"},
new Product {ProductID = 3, Name = "P3"},
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new Product {ProductID = 4, Name = "P4"},
new Product {ProductID = 5, Name = "P5"}
}) .AsQueryable<Product>());

// Arrange
HomeController controller =
new HomeController(mock.Object) { PageSize = 3 };

// Act
ProductsListViewModel result =
controller.Index(2).ViewData.Model as ProductsListViewModel;

// Assert

PagingInfo pageInfo = result.PagingInfo;
Assert.Equal(2, pageInfo.CurrentPage);
Assert.Equal(3, pageInfo.ItemsPerPage);
Assert.Equal(5, pageInfo.TotalItems);
Assert.Equal(2, pageInfo.TotalPages);

SPORTSSTORE: A REAL APPLICATION

| also need to modify the earlier unit tests to reflect the new result from the Index action method. Here are the revised tests:

[Fact]
public void Can Use Repository() {

}

// Arrange
Mock<IStoreRepository> mock = new Mock<IStoreRepository>();
mock.Setup(m => m.Products).Returns((new Product[] {

new Product {ProductID = 1, Name = "P1"},

new Product {ProductID = 2, Name =
}) .AsQueryable<Product>());

]
o
IN]

-

HomeController controller = new HomeController(mock.Object);

// Act
ProductsListViewModel result =
controller.Index().ViewData.Model as ProductsListViewModel;

// Assert

Product[] prodArray = result.Products.ToArray();
Assert.True(prodArray.Length == 2);
Assert.Equal("P1", prodArray[0].Name);
Assert.Equal("P2", prodArray[1].Name);

[Fact]
public void Can_Paginate() {

// Arrange
Mock<IStoreRepository> mock = new Mock<IStoreRepository>();
mock.Setup(m => m.Products).Returns((new Product[] {

new Product {ProductID = 1, Name = "P1"},

new Product {ProductID = 2, Name = "P2"},

new Product {ProductID = 3, Name = "P3"},
new Product {ProductID = 4, Name = "P4"},
new Product {ProductID = 5, Name = "P5"}

}) .AsQueryable<Product>());

HomeController controller = new HomeController(mock.Object);
controller.PageSize = 3;

// Act
ProductsListViewModel result =
controller.Index(2).ViewData.Model as ProductsListViewModel;
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// Assert

Product[] prodArray = result.Products.ToArray();
Assert.True(prodArray.Length == 2);
Assert.Equal("P4", prodArray[0].Name);
Assert.Equal("P5", prodArray[1].Name);

| would usually create a common setup method, given the degree of duplication between these two test methods. However, since
| am delivering the unit tests in individual sidebars like this one, | am going to keep everything separate so you can see each test
on its own.

The view is currently expecting a sequence of Product objects, so I need to update the Index.cshtml file, as shown in Listing 7-31,
to deal with the new view model type.

Listing 7-31. Updating the Index.cshtml File in the SportsStore/Views/Home Folder
@model ProductsListViewModel

@foreach (var p in Model.Products) {
<div>
<h3>@p.Name</h3>
@p.Description
<h4>@p.Price.ToString("c")</h4>
</div>

I have changed the @model directive to tell Razor that I am now working with a different data type. I updated the foreach loop so
that the data source is the Products property of the model data.

Displaying the Page Links

I have everything in place to add the page links to the Index view. I created the view model that contains the paging information,
updated the controller so that it passes this information to the view, and changed the @model directive to match the new model view
type. All that remains is to add an HTML element that the tag helper will process to create the page links, as shown in Listing 7-32.

Listing 7-32. Adding the Pagination Links in the Index.cshtml File in the SportsStore/Views/Home Folder
@model ProductsListViewModel

@foreach (var p in Model.Products) {
<div>
<h3>@p.Name</h3>
@p.Description
<h4>@p.Price.ToString("c")</h4>
</div>

}
<div page-model="@Model.PagingInfo" page-action="Index"s</div>

Restart ASP.NET Core and request http://localhost:5000, and you will see the new page links, as shown in Figure 7-6. The
style is still basic, which I will fix later in the chapter. What is important for the moment is that the links take the user from page to

page in the catalog and allow for exploration of the products for sale. When Razor finds the page-model attribute on the div element,
it asks the PageLinkTagHelper class to transform the element, which produces the set of links shown in the figure.
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Figure 7-6. Displaying page navigation links

Improving the URLs

I have the page links working, but they still use the query string to pass page information to the server, like this:

http://localhost/?productPage=2

I can create URLs that are more appealing by creating a scheme that follows the pattern of composable URLs. A composable URL
is one that makes sense to the user, like this one:

http://localhost/Page2

The ASP.NET Core routing feature makes it easy to change the URL scheme in an application. All I need to do is add a new route
in the Startup class, as shown in Listing 7-33.

Listing 7-33. Adding a New Route in the Startup.cs File in the SportsStore Folder

using System;

using System.Collections.Generic;
using System.Ling;

using System.Threading.Tasks;

using Microsoft.AspNetCore.Builder;
using Microsoft.AspNetCore.Hosting;
using Microsoft.AspNetCore.Http;

using Microsoft.Extensions

using Microsoft.Extensions.Hosting;

.DependencyInjection;

149



CHAPTER 7 © SPORTSSTORE: A REAL APPLICATION

using Microsoft.Extensions.Configuration;
using Microsoft.EntityFrameworkCore;
using SportsStore.Models;

namespace SportsStore {
public class Startup {

public Startup(IConfiguration config) {
Configuration = config;
}

private IConfiguration Configuration { get; set; }

public void ConfigureServices(IServiceCollection services) {
services.AddControllersWithViews();

services.AddDbContext<StoreDbContext>(opts => {
opts.UseSqlServer(
Configuration["ConnectionStrings:SportsStoreConnection"]);
D;

services.AddScoped<IStoreRepository, EFStoreRepository>();

}

public void Configure(IApplicationBuilder app, IWebHostEnvironment env) {

app.UseDeveloperExceptionPage();
app.UseStatusCodePages();
app.UseStaticFiles();

app.UseRouting();
app.UseEndpoints(endpoints => {
endpoints.MapControllerRoute("pagination”,
"Products/Page{productPage}",
new { Controller = "Home", action = "Index" });
endpoints.MapDefaultControllerRoute();

};

SeedData.EnsurePopulated(app);

It is important that you add the new route before the call to the MapDefaultControllerRoute method. As you will learn in
Chapter 13, the routing system processes routes in the order they are listed, and I need the new route to take precedence over the
existing one.

This is the only alteration required to change the URL scheme for product pagination. ASP.NET Core and the routing function
are tightly integrated, so the application automatically reflects a change like this in the URLs used by the application, including those
generated by tag helpers like the one I use to generate the page navigation links.

Restart ASP.NET Core, request http://localhost:5000, and click one of the pagination links. The browser will navigate to a
URL that uses the new URL scheme, as shown in Figure 7-7.
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@ SportsStore
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Flat-packed 35,000-seat stadium

Figure 7-7. The new URL scheme displayed in the browser

Styling the Content

I'have built a great deal of infrastructure, and the basic features of the application are starting to come together, but I have not paid
any attention to appearance. Even though this book is not about design or CSS, the SportsStore application design is so miserably
plain that it undermines its technical strengths. In this section, I will put some of that right. I am going to implement a classic two-
column layout with a header, as shown in Figure 7-8.

Sports Store (header)

Home e Productl
e Watersports e Product?2
e Soccer (

e Chess (main body)
[ ]

Figure 7-8. The design goal for the SportsStore application

Installing the Bootstrap Package

I am going to use the Bootstrap package to provide the CSS styles I will apply to the application. As explained in Chapter 4, client-
side packages are installed using LibMan. If you did not install the LibMan package when following the examples in Chapter 4, use a
PowerShell command prompt to run the commands shown in Listing 7-34, which remove any existing LibMan package and install
the version required for this book.
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Listing 7-34. Installing the LibMan Tool Package

dotnet tool uninstall --global Microsoft.Web.LibraryManager.Cli
dotnet tool install --global Microsoft.Web.LibraryManager.Cli --version 2.0.96

Once you have installed LibMan, run the commands shown in Listing 7-35 in the SportsStore folder to initialize the example
project and install the Bootstrap package.

Listing 7-35. Initializing the Example Project

libman init -p cdnjs
libman install twitter-bootstrap@4.3.1 -d wwwroot/lib/twitter-bootstrap

Applying Bootstrap Styles

Razor layouts provide common content so that it doesn’t have to be repeated in multiple views. Add the elements shown in Listing 7-36
to the Layout.cshtml file in the Views/Shared folder to include the Bootstrap CSS stylesheet in the content sent to the browser and
define a common header that will be used throughout the SportsStore application.

Listing 7-36. Applying Bootstrap CSS to the _Layout.cshtml File in the SportsStore/Views/Shared Folder

<!DOCTYPE html>
<html>
<head>
<meta name="viewport" content="width=device-width" />
<title>SportsStore</title>
<link href="/1ib/twitter-bootstrap/css/bootstrap.min.css" rel="stylesheet" />
</head>
<body>
<div class="bg-dark text-white p-2"»
<span class="navbar-brand ml-2">SPORTS STORE</span>
</div>
<div class="row m-1 p-1"»
<div id="categories" class="col-3"»
Put something useful here later
</div>
<div class="col-9"»
@RenderBody()
</div>
</div>
</body>
</html>

Adding the Bootstrap CSS stylesheet to the layout means that I can use the styles it defines in any of the views that rely on the
layout. Listing 7-37 shows the styling I applied to the Index.cshtml file.

Listing 7-37. Styling Content in the Index.cshtml File in the SportsStore/Views/HomeFolder
@model ProductslListViewModel

@foreach (var p in Model.Products) {
<div class="card card-outline-primary m-1 p-1"»
<div class="bg-faded p-1"»
<ha>
@p.Name
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<span class="badge badge-pill badge-primary" style="float:right"»
<smally@p.Price.ToString("c")</smally
</span>

</hay

</divy

<div class="card-text p-1"»>@p.Description</divy

</divy

}

<div page-model="@Model.PagingInfo" page-action="Index" page-classes-enabled="true"
page-class="btn" page-class-normal="btn-outline-dark"
page-class-selected="btn-primary" class="btn-group pull-right m-1"»

</divy

SPORTSSTORE: A REAL APPLICATION

Ineed to style the buttons generated by the PageLinkTagHelper class, but I don’t want to hardwire the Bootstrap classes
into the C# code because it makes it harder to reuse the tag helper elsewhere in the application or change the appearance of the
buttons. Instead, I have defined custom attributes on the div element that specify the classes that I require, and these correspond to
properties I added to the tag helper class, which are then used to style the a elements that are produced, as shown in Listing 7-38.

Listing 7-38. Adding Classes to Elements in the PageLinkTagHelper.cs File in the SportsStore/Infrastructure Folder

using Microsoft.AspNetCore.Mvc;

using Microsoft.AspNetCore.Mvc.Rendering;
using Microsoft.AspNetCore.Mvc.Routing;
using Microsoft.AspNetCore.Mvc.ViewFeatures;
using Microsoft.AspNetCore.Razor.TagHelpers;
using SportsStore.Models.ViewModels;

namespace SportsStore.Infrastructure {

[HtmlTargetElement("div", Attributes = "page-model")]
public class PagelLinkTagHelper : TagHelper {
private IUrlHelperFactory urlHelperFactory;

public

PageLinkTagHelper (IUrlHelperFactory helperFactory) {

urlHelperFactory = helperFactory;

}

[ViewContext]
[HtmlAttributeNotBound]

public
public
public
public
public
public
public

public

ViewContext ViewContext { get; set; }
PagingInfo PageModel { get; set; }

string PageAction { get; set; }

bool PageClassesEnabled { get; set; } = false;
string PageClass { get; set; }

string PageClassNormal { get; set; }

string PageClassSelected { get; set; }

override void Process(TagHelperContext context,
TagHelperOutput output) {

IUrlHelper urlHelper = urlHelperFactory.GetUrlHelper(ViewContext);
TagBuilder result = new TagBuilder("div");
for (int i = 1; i <= PageModel.TotalPages; i++) {

TagBuilder tag = new TagBuilder("a");
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tag.Attributes["href"] = urlHelper.Action(PageAction,
new { productPage = i });
if (PageClassesEnabled) {
tag.AddCssClass(PageClass);
tag.AddCssClass(i == PageModel.CurrentPage
? PageClassSelected : PageClassNormal);
}
tag.InnerHtml.Append(i.ToString());
result.InnerHtml.AppendHtml(tag);

}
output.Content.AppendHtml (result.InnerHtml);

The values of the attributes are automatically used to set the tag helper property values, with the mapping between the HTML
attribute name format (page-class-normal) and the C# property name format (PageClassNormal) taken into account. This allows
tag helpers to respond differently based on the attributes of an HTML element, creating a more flexible way to generate content in an
ASP.NET Core application.

Restart ASP.NET Core and request http://localhost:5000, and you will see the appearance of the application has been
improved—at least a little, anyway—as illustrated by Figure 7-9.

@ SportsStore

— C @ localhost:5000/Products/Page3

SPORTS STORE

Put something . ; -
usefulhere later  Bling-Bling King

Gold-plated, diamond-studded King
HE -

Figure 7-9. Applying styles to the SportsStore application

Creating a Partial View

As a finishing flourish for this chapter, I am going to refactor the application to simplify the Index.cshtml view. I am going to
create a partial view, which is a fragment of content that you can embed into another view, rather like a template. I describe partial
views in detail in Chapter 22, and they help reduce duplication when you need the same content to appear in different places in
an application. Rather than copy and paste the same Razor markup into multiple views, you can define it once in a partial view.

To create the partial view, I added a Razor View called ProductSummary.cshtml to the Views/Shared folder and added the markup
shown in Listing 7-39.
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Listing 7-39. The Contents of the ProductSummary.cshtml File in the SportsStore/Views/Shared Folder
@model Product

<div class="card card-outline-primary m-1 p-1">
<div class="bg-faded p-1">
<h4g>
@Model.Name
<span class="badge badge-pill badge-primary" style="float:right">
<small>@Model.Price.ToString("c")</small>

</span>
</h4>
</div>
<div class="card-text p-1">@Model.Description</div>
</div>

Now I need to update the Index.cshtml file in the Views/Home folder so that it uses the partial view, as shown in Listing 7-40.

Listing 7-40. Using a Partial View in the Index.cshtml File in the SportsStore/Views/Home Folder
@model ProductslListViewModel

@foreach (var p in Model.Products) {
<partial name="ProductSummary” model="p" />
}

<div page-model="@Model.PagingInfo" page-action="Index" page-classes-enabled="true"
page-class="btn" page-class-normal="btn-outline-dark"
page-class-selected="btn-primary" class="btn-group pull-right m-1">

</div>

I have taken the markup that was previously in the @foreach expression in the Index.cshtml view and moved it to the new
partial view. I call the partial view using a partial element, using the name and model attributes to specify the name of the partial
view and its view model. Using a partial view allows the same markup to be inserted into any view that needs to display a summary
of a product.

Restart ASP.NET Core and request http://localhost:5000, and you will see that introducing the partial view doesn’t change
the appearance of the application; it just changes where Razor finds the content that is used to generate the response sent to the
browser.

Summary

In this chapter, I built the core infrastructure for the SportsStore application. It does not have many features that you could
demonstrate to a client at this point, but behind the scenes, there are the beginnings of a domain model with a product repository
backed by SQL Server and Entity Framework Core. There is a single controller, HomeController, that can produce paginated lists of
products, and I have set up a clean and friendly URL scheme.

If this chapter felt like a lot of setup for little benefit, then the next chapter will balance the equation. Now that the
fundamental structure is in place, we can forge ahead and add all the customer-facing features: navigation by category and the
start of a shopping cart.
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SportsStore: Navigation and Cart

In this chapter, I continue to build out the SportsStore example app. I add support for navigating around the application and start
building a shopping cart.

Tip You can download the example project for this chapter—and for all the other chapters in this book—from https://github.
com/apress/pro-asp.net-core-3. See Chapter 1 for how to get help if you have problems running the examples.

Adding Navigation Controls

The SportsStore application will be more useful if customers can navigate products by category. I will do this in three phases.

¢ Enhance the Index action method in the HomeController class so that it can filter the Product objects in the
repository
e Revisit and enhance the URL scheme

o  Create a category list that will go into the sidebar of the site, highlighting the current category and linking to
others

Filtering the Product List

I am going to start by enhancing the view model class, ProductsListViewModel, which I added to the SportsStore project in the
previous chapter. I need to communicate the current category to the view to render the sidebar, and this is as good a place to start as
any. Listing 8-1 shows the changes I made to the ProductsListViewModel. cs file in the Models/ViewModels folder.

Listing 8-1. Modifying the ProductsListViewModel.cs File in the SportsStore/Models/ViewModels Folder

using System.Collections.Generic;
using SportsStore.Models;

namespace SportsStore.Models.ViewModels {

public class ProductsListViewModel {
public IEnumerable<Product> Products { get; set; }
public PagingInfo PagingInfo { get; set; }
public string CurrentCategory { get; set; }

Tadded a property called CurrentCategory. The next step is to update the Home controller so that the Index action method will
filter Product objects by category and use the property I added to the view model to indicate which category has been selected, as
shown in Listing 8-2.
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Listing 8-2. Adding Category Support in the HomeController.cs File in the SportsStore/Controllers Folder

using Microsoft.AspNetCore.Mvc;
using SportsStore.Models;

using System.Ling;

using SportsStore.Models.ViewModels;

namespace SportsStore.Controllers {
public class HomeController : Controller {
private IStoreRepository repository;
public int PageSize = 4;

public HomeController(IStoreRepository repo) {
repository = repo;
}

public ViewResult Index(string category, int productPage = 1)
=> View(new ProductslListViewModel {
Products = repository.Products
Where(p => category == null || p.Category == category)
.OrderBy(p => p.ProductID)
.Skip((productPage - 1) * PageSize)
.Take(PageSize),
PagingInfo = new PagingInfo {
CurrentPage = productPage,
ItemsPerPage = PageSize,
TotalItems = repository.Products.Count()

1

CurrentCategory = category

1

I'made three changes to the action method. First, I added a parameter called category. This category parameter is used by

the second change in the listing, which is an enhancement to the LINQ query: if category is not null, only those Product objects
with a matching Category property are selected. The last change is to set the value of the CurrentCategory property I added to the
ProductsListViewModel class. However, these changes mean that the value of PagingInfo.TotalItems is incorrectly calculated
because it doesn’t take the category filter into account. I will fix this in a while.

UNIT TEST: UPDATING EXISTING UNIT TESTS

| changed the signature of the Index action method, which will prevent some of the existing unit test methods from
compiling. To address this, | need to pass null as the first parameter to the Index method in those unit tests that work with
the controller. For example, in the Can_Use_Repository test in the HomeControllerTests.cs file, the action section of the
unit test becomes as follows:

[Fact]

public void Can_Use Repository() {
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// Arrange
Mock<IStoreRepository> mock = new Mock<IStoreRepository>();
mock.Setup(m => m.Products).Returns((new Product[] {
new Product {ProductID = 1, Name = "P1"},
new Product {ProductID = 2, Name = "P2"}
}) .AsQueryable<Product>());

HomeController controller = new HomeController(mock.Object);
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// Act
ProductsListViewModel result =
controller.Index(null).ViewData.Model as ProductsListViewModel;

// Assert

Product[] prodArray = result.Products.ToArray();
Assert.True(prodArray.Length == 2);
Assert.Equal("P1", prodArray[0].Name);
Assert.Equal("P2", prodArray[1].Name);

By using null for the category argument, | receive all the Product objects that the controller gets from the repository, which
is the same situation | had before adding the new parameter. | need to make the same change to the Can_Paginate and Can_
Send_Pagination View Model tests as well.

[Fact]
public void Can_Paginate() {
// Arrange
Mock<IStoreRepository> mock = new Mock<IStoreRepository>();
mock.Setup(m => m.Products).Returns((new Product[] {
new Product {ProductID = 1, Name = "P1"},

new Product {ProductID = 2, Name = "P2"},
new Product {ProductID = 3, Name = "P3"},
new Product {ProductID = 4, Name = "P4"},
new Product {ProductID = 5, Name = "P5"}

}) .AsQueryable<Product>());

HomeController controller = new HomeController(mock.Object);
controller.PageSize = 3;

// Act
ProductsListViewModel result =
controller.Index(null, 2).ViewData.Model as ProductsListViewModel;

// Assert
Product[] prodArray = result.Products.ToArray();

Assert.True(prodArray.Length == 2);
Assert.Equal("P4", prodArray[0].Name);
Assert.Equal("P5", prodArray[1].Name);

}

[Fact]
public void Can_Send_Pagination_View_Model() {

// Arrange
Mock<IStoreRepository> mock = new Mock<IStoreRepository>();
mock.Setup(m => m.Products).Returns((new Product[] {
new Product {ProductID = 1, Name = "P1"},
new Product {ProductID = 2, Name = "P2"},
new Product {ProductID = 3, Name = "P3"},
new Product {ProductID = 4, Name = "P4"},
new Product {ProductID = 5, Name = "P5"}
}) .AsQueryable<Product>());

// Arrange
HomeController controller =
new HomeController(mock.Object) { PageSize = 3 };
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// Act
ProductsListViewModel result =
controller.Index(null, 2).ViewData.Model as ProductsListViewModel;

// Assert

PagingInfo pageInfo = result.PagingInfo;
Assert.Equal(2, pageInfo.CurrentPage);
Assert.Equal(3, pageInfo.ItemsPerPage);
Assert.Equal(5, pageInfo.Totalltems);
Assert.Equal(2, pagelInfo.TotalPages);

Keeping your unit tests synchronized with your code changes quickly becomes second nature when you get into the testing
mindset.

To see the effect of the category filtering, start ASP.NET Core and select a category using the following URL, taking care to use an
uppercase S for Soccer:

http://localhost:5000/?category=Soccer

You will see only the products in the Soccer category, as shown in Figure 8-1.

@ SportsStore x

< C @ localhost:5000/?category=Saccer r :
SPORTS STORE
Put something useful
here later Soccer Ball (51950 ]
FIFA-approved size and weight
Corner Flags

Give your playing field a professional touch

Stadium

Flat-packed 35,000-seat stadium
B

Figure 8-1. Using the query string to filter by category

Obviously, users won'’t want to navigate to categories using URLSs, but you can see how small changes can have a big impact
once the basic structure of an ASP.NET Core application is in place.
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UNIT TEST: CATEGORY FILTERING

| need a unit test to properly test the category filtering function to ensure that the filter can correctly generate products in a
specified category. Here is the test method | added to the ProductControllerTests class:

[Fact]
public void Can _Filter Products() {
// Arrange
// - create the mock repository
Mock<IStoreRepository> mock = new Mock<IStoreRepository>();
mock.Setup(m => m.Products).Returns((new Product[] {
new Product {ProductID = 1, Name = "P1", Category = "Cat1"},
new Product {ProductID = 2, Name = "P2", Category = "Cat2"},
new Product {ProductID = 3, Name = "P3", Category = "Cat1"},
new Product {ProductID = 4, Name = "P4", Category = "Cat2"},
new Product {ProductID = 5, Name = "P5", Category = "Cat3"}
}) .AsQueryable<Product>());

// Arrange - create a controller and make the page size 3 items
HomeController controller = new HomeController(mock.Object);
controller.PageSize = 3;

// Action
Product[] result =
(controller.Index("Cat2", 1).ViewData.Model as ProductsListViewModel)
.Products.ToArray();

// Assert

Assert.Equal(2, result.length);

Assert.True(result[0].Name == "P2" && result[o0].Category == "Cat2");
Assert.True(result[1].Name == "P4" 8& result[1].Category == "Cat2");

This test creates a mock repository containing Product objects that belong to a range of categories. One specific category is
requested using the action method, and the results are checked to ensure that the results are the right objects in the right order.

Refining the URL Scheme

No one wants to see or use ugly URLs such as /?category=Soccer. To address this, I am going to change the routing configuration in
the Configure method of the Startup class to create a more useful set of URLs, as shown in Listing 8-3.

Caution It is important to add the new routes in Listing 8-3 in the order they are shown. Routes are applied in the order in which
they are defined, and you will get some odd effects if you change the order.

Listing 8-3. Changing the Routing Schema in the Startup.cs File in the SportsStore Folder

using System;

using System.Collections.Generic;
using System.Ling;

using System.Threading.Tasks;

using Microsoft.AspNetCore.Builder;
using Microsoft.AspNetCore.Hosting;
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using Microsoft.AspNetCore.Http;

using Microsoft.Extensions.DependencyInjection;
using Microsoft.Extensions.Hosting;

using Microsoft.Extensions.Configuration;

using Microsoft.EntityFrameworkCore;

using SportsStore.Models;

namespace SportsStore {
public class Startup {

public Startup(IConfiguration config) {
Configuration = config;
}

private IConfiguration Configuration { get; set; }

public void ConfigureServices(IServiceCollection services) {
services.AddControllersWithViews();

services.AddDbContext<StoreDbContext> (opts => {
opts.UseSqlServer(
Configuration["ConnectionStrings:SportsStoreConnection"]);
1;

services.AddScoped<IStoreRepository, EFStoreRepository>();

}

public void Configure(IApplicationBuilder app, IWebHostEnvironment env) {
app.UseDeveloperExceptionPage();
app.UseStatusCodePages();
app.UseStaticFiles();

app.UseRouting();
app.UseEndpoints(endpoints => {
endpoints.MapControllerRoute("catpage”,
"{category}/Page{productPage:int}",
new { Controller = "Home", action = "Index" });

endpoints.MapControllerRoute("page"”, "Page{productPage:int}",
new { Controller = "Home", action = "Index", productPage = 1 });

endpoints.MapControllerRoute("category”, "{category}”,

new { Controller = "Home", action = "Index", productPage = 1 });
endpoints.MapControllerRoute("pagination”,

"Products/Page{productPage}",

new { Controller = "Home", action = "Index", productPage = 1 });

endpoints.MapDefaultControllerRoute();
D;

SeedData.EnsurePopulated(app);

Table 8-1 describes the URL scheme that these routes represent. I explain the routing system in detail in Chapter 13.
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Table 8-1. Route Summary

URL Leads To

/ Lists the first page of products from all categories

/Page2 Lists the specified page (in this case, page 2), showing items from all categories
/Soccer Shows the first page of items from a specific category (in this case, the Soccer category)

/Soccer/Page2  Shows the specified page (in this case, page 2) of items from the specified category (in this case, Soccer)

The ASP.NET Core routing system handles incoming requests from clients, but it also generates outgoing URLs that conform
to the URL scheme and that can be embedded in web pages. By using the routing system both to handle incoming requests and to
generate outgoing URLs, I can ensure that all the URLs in the application are consistent.

The IUrlHelper interface provides access to URL-generating functionality. I used this interface and the Action method it defines
in the tag helper I created in the previous chapter. Now that I want to start generating more complex URLSs, I need a way to receive
additional information from the view without having to add extra properties to the tag helper class. Fortunately, tag helpers have a
nice feature that allows properties with a common prefix to be received all together in a single collection, as shown in Listing 8-4.

Listing 8-4. Prefixed Values in the PageLinkTagHelper.cs File in the SportsStore/Infrastructure Folder

using Microsoft.AspNetCore.Mvc;

using Microsoft.AspNetCore.Mvc.Rendering;
using Microsoft.AspNetCore.Mvc.Routing;
using Microsoft.AspNetCore.Mvc.ViewFeatures;
using Microsoft.AspNetCore.Razor.TagHelpers;
using SportsStore.Models.ViewModels;

using System.Collections.Generic;

namespace SportsStore.Infrastructure {

[HtmlTargetElement("div", Attributes = "page-model")]
public class PagelLinkTagHelper : TagHelper {
private IUrlHelperFactory urlHelperFactory;

public PagelinkTagHelper(IUrlHelperFactory helperFactory) {
urlHelperFactory = helperFactory;
}

[ViewContext]
[HtmlAttributeNotBound]
public ViewContext ViewContext { get; set; }

public PagingInfo PageModel { get; set; }
public string PageAction { get; set; }

[HtmlAttributeName(DictionaryAttributePrefix = "page-url-")]
public Dictionary<string, object> PageUrlValues { get; set; }
= new Dictionary<string, object>();

public bool PageClassesEnabled { get; set; } = false;
public string PageClass { get; set; }

public string PageClassNormal { get; set; }

public string PageClassSelected { get; set; }

public override void Process(TagHelperContext context,

TagHelperOutput output) {
IUrlHelper urlHelper = urlHelperFactory.GetUrlHelper(ViewContext);
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TagBuilder result = new TagBuilder("div");
for (int i = 1; i <= PageModel.TotalPages; i++) {
TagBuilder tag = new TagBuilder("a");
PageUrlValues|[ "productPage”] = i;
tag.Attributes[ "href"] = urlHelper.Action(PageAction, PageUrlValues);
if (PageClassesEnabled) {
tag.AddCssClass(PageClass);
tag.AddCssClass(i == PageModel.CurrentPage
? PageClassSelected : PageClassNormal);
}
tag.InnerHtml.Append(i.ToString());
result.InnerHtml.AppendHtml(tag);

}
output.Content.AppendHtml(result.InnerHtml);

Decorating a tag helper property with the HtmlAttributeName attribute allows me to specify a prefix for attribute names on the
element, which in this case will be page-url-. The value of any attribute whose name begins with this prefix will be added to the
dictionary that is assigned to the PageUr1Values property, which is then passed to the IUrlHelper.Action method to generate the
URL for the href attribute of the a elements that the tag helper produces.

In Listing 8-5, I have added a new attribute to the div element that is processed by the tag helper, specifying the category that
will be used to generate the URL. I have added only one new attribute to the view, but any attribute with the same prefix would be
added to the dictionary.

Listing 8-5. Adding a New Attribute in the Index.cshtml File in the SportsStore/Views/Home Folder

@model ProductslListViewModel

@foreach (var p in Model.Products) {
<partial name="ProductSummary" model=
}

p" />

<div page-model="@Model.PagingInfo" page-action="Index" page-classes-enabled="true"
page-class="btn" page-class-normal="btn-outline-dark"
page-class-selected="btn-primary" page-url-category="@Model.CurrentCategory"
class="btn-group pull-right m-1">

</div>

Prior to this change, the links generated for the pagination links looked like this:
http://localhost:5000/Pagel

If the user clicked a page link like this, the category filter would be lost, and the application would present a page containing
products from all categories. By adding the current category, taken from the view model, I generate URLs like this instead:

http://localhost:5000/Chess/Pagel

When the user clicks this kind of link, the current category will be passed to the Index action method, and the filtering will be
preserved. To see the effect of this change, start ASP.NET Core and request http://localhost:5000/Chess, which will display just
the products in the Chess category, as shown in Figure 8-2.
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@ SportsStore

“ C @ localhost:5000/Chess

SPORTS STORE

Put something useful S
e Thinking Cap 51600

Improve brain efficiency by 75%

Unsteady Chair

Secretly give your opponent a disadvantage

Human Chess Board

A fun game for the family
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Gold-plated, diamond-studded King
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Figure 8-2. Filtering data by category

Building a Category Navigation Menu

Ineed to provide users with a way to select a category that does not involve typing in URLs. This means presenting a list of the
available categories and indicating which, if any, is currently selected.

ASP.NET Core has the concept of view components, which are perfect for creating items such as reusable navigation controls. A
view component is a C# class that provides a small amount of reusable application logic with the ability to select and display Razor
partial views. I describe view components in detail in Chapter 24.

In this case, I will create a view component that renders the navigation menu and integrate it into the application by invoking
the component from the shared layout. This approach gives me a regular C# class that can contain whatever application logic I need
and that can be unit tested like any other class.

Creating the Navigation View Component

I created a folder called Components, which is the conventional home of view components, in the SportsStore project and added to it
a class file named NavigationMenuViewComponent.cs, which I used to define the class shown in Listing 8-6.

Listing 8-6. The Contents of the NavigationMenuViewComponent.cs File in the SportsStore/Components Folder
using Microsoft.AspNetCore.Mvc;
namespace SportsStore.Components {

public class NavigationMenuViewComponent : ViewComponent {

public string Invoke() {
return "Hello from the Nav View Component"”;
}
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The view component’s Invoke method is called when the component is used in a Razor view, and the result of the Invoke
method is inserted into the HTML sent to the browser. I have started with a simple view component that returns a string, but I'll
replace this with HTML shortly.

I want the category list to appear on all pages, so I am going to use the view component in the shared layout, rather than in a
specific view. Within a view, view components are applied using a tag helper, as shown in Listing 8-7.

Listing 8-7. Using a View Component in the _Layout.cshtml File in the SportsStore/Views/Shared Folder

<!DOCTYPE html>
<html>
<head>
<meta name="viewport" content="width=device-width" />
<title>SportsStore</title>
<link href="/1ib/twitter-bootstrap/css/bootstrap.min.css" rel="stylesheet" />
</head>
<body>
<div class="bg-dark text-white p-2">
<span class="navbar-brand ml-2">SPORTS STORE</span>
</div>
<div class="row m-1 p-1">
<div id="categories" class="col-3">
<vc:navigation-menu />

</div>
<div class="col-9">
@RenderBody()
</div>
</div>
</body>
</html>

Iremoved the placeholder text and replaced it with the vc:navigation-menu element, which inserts the view component.
The element omits the ViewComponent part of the class name and hyphenates it, such that vc:navigation-menu specifies the
NavigationMenuViewComponent class.

Restart ASP.NET Core and request http://localhost:5000, and you will see that the output from the Invoke method is
included in the HTML sent to the browser, as shown in Figure 8-3.

< C @ localhost:5000 *

SPORTS STORE
Hello from the Nav
View Component Kayak
A boat for one person

Lifejacket $48.95

P - PG icastn ot P e,

Figure 8-3. Using a view component
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Generating Category Lists

I can now return to the navigation view component and generate a real set of categories. I could build the HTML for the categories
programmatically, as I did for the page tag helper, but one of the benefits of working with view components is they can render Razor
partial views. That means I can use the view component to generate the list of components and then use the more expressive Razor
syntax to render the HTML that will display them. The first step is to update the view component, as shown in Listing 8-8.

Listing 8-8. Adding Categories in the NavigationMenuViewComponent.cs File in the SportsStore/Components Folder

using Microsoft.AspNetCore.Mvc;
using System.Ling;
using SportsStore.Models;

namespace SportsStore.Components {

public class NavigationMenuViewComponent : ViewComponent {
private IStoreRepository repository;

public NavigationMenuViewComponent(IStoreRepository repo) {
repository = repo;
}

public IViewComponentResult Invoke() {
return View(repository.Products
.Select(x =»> x.Category)
.Distinct()
.OrderBy(x => x));

The constructor defined in Listing 8-8 defines an IStoreRepository parameter. When ASP.NET Core needs to create an
instance of the view component class, it will note the need to provide a value for this parameter and inspect the configuration in
the Startup class to determine which implementation object should be used. This is the same dependency injection feature that I
used in the controller in Chapter 7, and it has the same effect, which is to allow the view component to access data without knowing
which repository implementation will be used, a feature I describe in detail in Chapter 14.

In the Invoke method, I use LINQ to select and order the set of categories in the repository and pass them as the argument
to the View method, which renders the default Razor partial view, details of which are returned from the method using an
IViewComponentResult object, a process I describe in more detail in Chapter 24.

UNIT TEST: GENERATING THE CATEGORY LIST

The unit test for my ability to produce a category list is relatively simple. The goal is to create a list that is sorted in alphabetical
order and contains no duplicates, and the simplest way to do this is to supply some test data that does have duplicate categories
and that is not in order, pass this to the tag helper class, and assert that the data has been properly cleaned up. Here is the unit
test, which I defined in a new class file called NavigationMenuViewComponentTests.cs in the SportsStore.Tests project:

using System.Collections.Generic;

using System.Ling;

using Microsoft.AspNetCore.Components;

using Microsoft.AspNetCore.Mvc.Rendering;
using Microsoft.AspNetCore.Mvc.ViewComponents;
using Mogq;

using SportsStore.Components;

using SportsStore.Models;

using Xunit;
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namespace SportsStore.Tests {
public class NavigationMenuViewComponentTests {

[Fact]
public void Can_Select Categories() {
// Arrange
Mock<IStoreRepository> mock = new Mock<IStoreRepository>();
mock.Setup(m => m.Products).Returns((new Product[] {
new Product {ProductID = 1, Name = "P1", Category = "Apples"},
new Product {ProductID = 2, Name = "P2", Category = "Apples"},
new Product {ProductID = 3, Name = "P3", Category = "Plums"},
new Product {ProductID = 4, Name = "P4", Category = "Oranges"},
}) .AsQueryable<Product>());

NavigationMenuViewComponent target =
new NavigationMenuViewComponent(mock.Object);

// Act = get the set of categories
string[] results = ((IEnumerable<string>)(target.Invoke()
as ViewViewComponentResult).ViewData.Model).ToArray();

// Assert
Assert.True(Enumerable.SequenceEqual(new string[] { "Apples",
"Oranges", "Plums" }, results));

}

| created a mock repository implementation that contains repeating categories and categories that are not in order. | assert that
the duplicates are removed and that alphabetical ordering is imposed.

Creating the View

Razor uses different conventions for locating with views that are selected by view components. Both the default name of the view
and the locations that are searched for the view are different from those used for controllers. To that end, I created the Views/
Shared/Components/NavigationMenu folder in the SportsStore project and added to it a Razor view named Default.cshtml, to
which I added the content shown in Listing 8-9.

Listing 8-9. The Contents of the Default.cshtml File in the SportsStore/Views/Shared/Components/NavigationMenu Folder

@model IEnumerable<string>

<a class="btn btn-block btn-outline-secondary"asp-action="Index"
asp-controller="Home" asp-route-category="">
Home

</a>

@foreach (string category in Model) {
<a class="btn btn-block btn-outline-secondary"
asp-action="Index" asp-controller="Home"
asp-route-category="@category"
asp-route-productPage="1">
@category

</a>

This view uses one of the built-in tag helpers, which I describe in Chapters 25-27, to create anchor elements whose href
attribute contains a URL that selects a different product category.
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Restart ASPNET Core and request http://localhost:5000 to see the category navigation buttons. If you click a button, the list
of items is updated to show only items from the selected category, as shown in Figure 8-4.

@ SportsStore

-

o | Thinking Cap

Chess ‘ Improve brain efficiency by 75%

Soccer | Unsteady Chair

Watersports ‘ Secretly give your opponent a disadvantage

Human Chess Board

N Sy f-f" O SR T Y 20 4 4™ 4

Figure 8-4. Generating category links with a view component

Highlighting the Current Category

There is no feedback to the user to indicate which category has been selected. It might be possible to infer the category from the
items in the list, but some clear visual feedback seems like a good idea. ASP.NET Core components such as controllers and view
components can receive information about the current request by asking for a context object. Most of the time, you can rely on
the base classes that you use to create components to take care of getting the context object for you, such as when you use the
Controller base class to create controllers.

The ViewComponent base class is no exception and provides access to context objects through a set of properties. One of the
properties is called RouteData, which provides information about how the request URL was handled by the routing system.

In Listing 8-10, I use the RouteData property to access the request data in order to get the value for the currently selected
category. I could pass the category to the view by creating another view model class (and that’s what I would do in a real project), but
for variety, I am going to use the view bag feature, which allows unstructured data to be passed to a view alongside the view model
object. I describe how this feature works in detail in Chapter 22.

Listing 8-10. Passing the Selected Category in the NavigationMenuViewComponent.cs File in the SportsStore/Components Folder

using Microsoft.AspNetCore.Mvc;
using System.Ling;
using SportsStore.Models;

namespace SportsStore.Components {

public class NavigationMenuViewComponent : ViewComponent {
private IStoreRepository repository;

public NavigationMenuViewComponent(IStoreRepository repo) {
repository = repo;
}
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public IViewComponentResult Invoke() {
ViewBag.SelectedCategory = RouteData?.Values["category"];
return View(repository.Products
.Select(x => x.Category)
.Distinct()
.OrderBy(x => x));

Inside the Invoke method, I have dynamically assigned a SelectedCategory property to the ViewBag object and set its value to
be the current category, which is obtained through the context object returned by the RouteData property. The ViewBag is a dynamic
object that allows me to define new properties simply by assigning values to them.

UNIT TEST: REPORTING THE SELECTED CATEGORY

| can test that the view component correctly adds details of the selected category by reading the value of the ViewBag
property in a unit test, which is available through the vViewviewComponentResult class. Here is the test, which | added to the
NavigatioMenuViewComponentTests class:

[Fact]
public void Indicates Selected Category() {
// Arrange
string categoryToSelect = "Apples";
Mock<IStoreRepository> mock = new Mock<IStoreRepository>();
mock.Setup(m => m.Products).Returns((new Product[] {
new Product {ProductID = 1, Name = "P1", Category = "Apples"},
new Product {ProductID = 4, Name = "P2", Category = "Oranges"},
}) .AsQueryable<Product>());

NavigationMenuViewComponent target =
new NavigationMenuViewComponent(mock.Object);
target.ViewComponentContext = new ViewComponentContext {
ViewContext = new ViewContext {
RouteData = new Microsoft.AspNetCore.Routing.RouteData()
}

};
target.RouteData.Values["category"] = categoryToSelect;
// Action

string result = (string)(target.Invoke() as
ViewViewComponentResult).ViewData[ "SelectedCategory"];

// Assert
Assert.Equal(categoryToSelect, result);

This unit test provides the view component with routing data through the viewComponentContext property, which is how view
components receive all their context data. The viewComponentContext property provides access to view-specific context data
through its ViewContext property, which in turn provides access to the routing information through its RouteData property. Most
of the code in the unit test goes into creating the context objects that will provide the selected category in the same way that it
would be presented when the application is running and the context data is provided by ASP.NET Core MVC.

Now that I am providing information about which category is selected, I can update the view selected by the view component
and vary the CSS classes used to style the links so that the one representing the current category is distinct. Listing 8-11 shows the
change I made to the Default.cshtml file
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Listing 8-11. Highlighting in the Default.cshtml File in the SportsStore/Views/Shared/Components/NavigationMenu Folder

@model IEnumerable<string>

<a class="btn btn-block btn-outline-secondary"asp-action="Index"
asp-controller="Home" asp-route-category="">
Home

</a>

@foreach (string category in Model) {

<a class="btn btn-block

@(category == ViewBag.SelectedCategory
? "btn-primary": "btn-outline-secondary")"

asp-action="Index" asp-controller="Home"
asp-route-category="@category"
asp-route-productPage="1">
@category

</a>

—

I have used a Razor expression within the class attribute to apply the btn-primary class to the element that represents the
selected category and the btn-secondary class otherwise. These classes apply different Bootstrap styles and make the active button
obvious, which you can see by restarting ASP.NET Core, requesting http://localhost:5000, and clicking one of the category
buttons, as shown in Figure 8-5.

m

= C @ localhost:5000/Chess/Page1 o

SPORTS STORE

Home ‘ Thmklng Cap

Improve brain efficiency by 75%

Soccer | Unsteady Chair

Watersports ‘ Secretly give your opponent a disadvantage
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Figure 8-5. Highlighting the selected category

Correcting the Page Count

Ineed to correct the page links so that they work correctly when a category is selected. Currently, the number of page links is
determined by the total number of products in the repository and not the number of products in the selected category. This means
that the customer can click the link for page 2 of the Chess category and end up with an empty page because there are not enough
chess products to fill two pages. You can see the problem in Figure 8-6.
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@ SportsStore X
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Figure 8-6. Displaying the wrong page links when a category is selected

I can fix this by updating the Index action method in the Home controller so that the pagination information takes the categories
into account, as shown in Listing 8-12.

Listing 8-12. Creating Category Pagination Data in the HomeController.cs File in the SportsStore/Controllers Folder

using Microsoft.AspNetCore.Mvc;
using SportsStore.Models;

using System.Ling;

using SportsStore.Models.ViewModels;

namespace SportsStore.Controllers {
public class HomeController : Controller {
private IStoreRepository repository;
public int PageSize = 4;

public HomeController(IStoreRepository repo) {
repository = repo;
}

public ViewResult Index(string category, int productPage = 1)
=> View(new ProductsListViewModel {
Products = repository.Products

.Where(p => category == null || p.Category == category)

.OrderBy(p => p.ProductID)

.Skip((productPage - 1) * PageSize)

.Take(PageSize),

PagingInfo = new PagingInfo {

CurrentPage = productPage,

ItemsPerPage = PageSize,

TotalItems = category == null ?
repository.Products.Count() :
repository.Products.llhere(e =»

e.Category == category).Count()
1
CurrentCategory = category

1
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If a category has been selected, I return the number of items in that category; if not, I return the total number of products.
Restart ASP.NET Core and request http://localhost:5000 to see the changes when a category is selected, as shown in Figure 8-7.

@ SportsStore X

SPORTS STORE

— C @ localhost:5000/Chess/Page1

Human Chess Board
A fun game for the family
Bling-Bling King

Gold-plated, diamond-studded King

| Thinking Cap
Improve brain efficiency by 75%
Soccer s
| it | Unsteady Chair
‘ Watersports ‘ Secretly give your opponent a disadvantage

W

Figure 8-7. Displaying category-specific page counts

UNIT TEST: CATEGORY-SPECIFIC PRODUCT COUNTS

Testing that | am able to generate the current product count for different categories is simple. | create a mock repository that
contains known data in a range of categories and then call the List action method requesting each category in turn. Here is the
unit test method that | added to the HomeControllerTests class (you will need to import the System namespace for this test):

[Fact]

public void Generate Category Specific Product Count() {

// Arrange

Mock<IStoreRepository> mock = new Mock<IStoreRepository>();
mock.Setup(m => m.Products).Returns((new Product[] {

new Product {ProductID
new Product {ProductID
new Product {ProductID
new Product {ProductID
new Product {ProductID

}) .AsQueryable<Product>());

HomeController target = new HomeController(mock.Object);

target.PageSize = 3;

1,
2,
3,
4,
5,

Name
Name
Name
Name
Name

"P1", Category
"P2", Category
"P3", Category
"P4", Category
"P5", Category

"Cat1"},
"Cat2"},
"Cat1"},
"Cat2"},
"Cat3"}
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Func<ViewResult, ProductslListViewModel> GetModel = result =>
result?.ViewData?.Model as ProductsListViewModel;

// Action
resl = GetModel(target.Index("Cat1"))?.PagingInfo.Totalltems;

int?
int?
int?
int?

res2

GetModel (target.Index("Cat2"))?.PagingInfo.Totalltems;

res3 = GetModel(target.Index("Cat3"))?.PagingInfo.Totalltems;
resAll = GetModel(target.Index(null))?.PagingInfo.TotalItems;

// Assert

Assert.Equal(2,
Assert.Equal(2,
Assert.Equal(1,
Assert.Equal(s,

Notice that | also call the Index method, specifying no category, to make sure | get the correct total count as well.

resl);
res2);
res3);
resAll);

Building the Shopping Cart

The application is progressing nicely, but I cannot sell any products until I implement a shopping cart. In this section, I will create
the shopping cart experience shown in Figure 8-8. This will be familiar to anyone who has ever made a purchase online.

Products

Soccer Ball
Comer Flags
Stadium

Add to cart

Add to cart

—

Your Cart
1xStadium  $79,500.00
Total: $79,500.00

I Check out now I—

—| Continue shopping I

Enter shipping details

...etc...

Figure 8-8. The basic shopping cart flow

An Add To Cart button will be displayed alongside each of the products in the catalog. Clicking this button will show a summary
of the products the customer has selected so far, including the total cost. At this point, the user can click the Continue Shopping
button to return to the product catalog or click the Checkout Now button to complete the order and finish the shopping session.

Configuring Razor Pages

So far, I have used the MVC Framework to define the SportsStore project features. For variety, I am going to use Razor Pages—
another application framework supported by ASP.NET Core—to implement the shopping cart. Listing 8-13 configures the Startup

class to enable Razor Pages in the SportsStore application.

Listing 8-13. Enabling Razor Pages in the Startup.cs File in the SportsStore Folder

using System;
using System.Collections.Generic;
using System.Ling;
using System.Threading.Tasks;
using Microsoft.AspNetCore.Builder;
using Microsoft.AspNetCore.Hosting;
using Microsoft.AspNetCore.Http;
using Microsoft.Extensions.DependencyInjection;
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using Microsoft.Extensions.Hosting;

using Microsoft.Extensions.Configuration;
using Microsoft.EntityFrameworkCore;
using SportsStore.Models;

namespace SportsStore {
public class Startup {

public Startup(IConfiguration config) {
Configuration = config;
}

private IConfiguration Configuration { get; set; }

public void ConfigureServices(IServiceCollection services) {
services.AddControllersWithViews();
services.AddDbContext<StoreDbContext>(opts => {
opts.UseSqlServer(
Configuration["ConnectionStrings:SportsStoreConnection"]);
1;
services.AddScoped<IStoreRepository, EFStoreRepository>();
services.AddRazorPages();

}

public void Configure(IApplicationBuilder app, IWebHostEnvironment env) {
app.UseDeveloperExceptionPage();
app.UseStatusCodePages();
app.UseStaticFiles();

app.UseRouting();
app.UseEndpoints(endpoints => {
endpoints.MapControllerRoute("catpage”,
"{category}/Page{productPage:int}",
new { Controller = "Home", action = "Index" });

endpoints.MapControllerRoute("page", "Page{productPage:int}",
new { Controller = "Home", action = "Index", productPage = 1 });

endpoints.MapControllerRoute("category", "{category}",

new { Controller = "Home", action = "Index", productPage = 1 });
endpoints.MapControllerRoute("pagination",

"Products/Page{productPage}",

new { Controller = "Home", action = "Index", productPage = 1 });

endpoints.MapDefaultControllerRoute();
endpoints.MapRazorPages();

1

SeedData.EnsurePopulated(app);

The AddRazorPages method sets up the services used by Razor Pages, and the MapRazorPages method registers Razor Pages as
endpoints that the URL routing system can use to handle requests.

Add a folder named Pages, which is the conventional location for Razor Pages, to the SportsStore project. Add a Razor View
Imports file named ViewImports.cshtml to the Pages folder with the content shown in Listing 8-14. These expressions set the
namespace that the Razor Pages will belong to and allow the SportsStore classes to be used in Razor Pages without needing to
specify their namespace.

175



CHAPTER 8 © SPORTSSTORE: NAVIGATION AND CART

Listing 8-14. The Contents of the _ViewImports.cshtml File in the SportsStore/Pages Folder

@namespace SportsStore.Pages

@using Microsoft.AspNetCore.Mvc.RazorPages

@using SportsStore.Models

@using SportsStore.Infrastructure

@addTagHelper *, Microsoft.AspNetCore.Mvc.TagHelpers

Next, add a Razor View Start file named ViewStart.cshtml to the Pages folder, with the content shown in Listing 8-15. Razor
Pages have their own configuration files, and this one specifies that the Razor Pages in the SportsStore project will use a layout file
named Cartlayout by default.

Listing 8-15. The Contents of the _ViewStart.cshtml File in the SportsStore/Pages Folder

o
}

Layout = " CartlLayout";

Finally, to provide the layout the Razor Pages will use, add a Razor View named _CartLayout.cshtml to the Pages folder with
the content shown in Listing 8-16.

Listing 8-16. The Contents of the _CartLayout.cshtml File in the SportsStore/Pages Folder

<!DOCTYPE html>
<html>
<head>
<meta name="viewport" content="width=device-width" />
<title>SportsStore</title>
<link href="/1ib/twitter-bootstrap/css/bootstrap.min.css" rel="stylesheet" />
</head>
<body>
<div class="bg-dark text-white p-2">
<span class="navbar-brand ml-2">SPORTS STORE</span>

</div>
<div class="m-1 p-1">
@RenderBody()
</div>
</body>
</html>

Creating a Razor Page

If you are using Visual Studio, use the Razor Page template item and set the item name to Cart.cshtml. This will create a Cart.cshtml
file and a Cart.cshtml.cs class file. Replace the contents of the file with those shown in Listing 8-17. If you are using Visual Studio
Code, just create a Cart.cshtml file with the content shown in Listing 8-17.

Listing 8-17. The Contents of the Cart.cshtml File in the SportsStore/Pages Folder
@page
<h4>This is the Cart Page</h4>
Restart ASP.NET Core and request http://localhost:5000/cart to see the placeholder content from Listing 8-17, which is

shown in Figure 8-9. Notice that I have not had to register the page and that the mapping between the /cart URL path and the Razor
Page has been handled automatically.
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@ SportsStore

< C @ localhost:5000/cart

SPORTS STORE

This is the Cart Page

Figure 8-9. Placeholder content from a Razor Page

Creating the Add To Cart Buttons

I have some preparation to do before I can implement the cart feature. First, I need to create the buttons that will add products to
the cart. To prepare for this, I added a class file called UrlExtensions.cs to the Infrastructure folder and defined the extension
method shown in Listing 8-18.

Listing 8-18. The Contents of the UrlExtensions.cs File in the SportsStore/Infrastructure Folder

using Microsoft.AspNetCore.Http;
namespace SportsStore.Infrastructure {
public static class UrlExtensions {

public static string PathAndQuery(this HttpRequest request) =>
request.QueryString.HasValue
? $"{request.Path}{request.QueryString}"
: request.Path.ToString();

The PathAndQuery extension method operates on the HttpRequest class, which ASP.NET Core uses to describe an HTTP
request. The extension method generates a URL that the browser will be returned to after the cart has been updated, taking into
account the query string, if there is one. In Listing 8-19, I have added the namespace that contains the extension method to the view
imports file so that I can use it in the partial view.

Note This is the view imports file in the Views folder and not the one added to the Pages folder.

Listing 8-19. Adding a Namespace in the _ViewImports.cshtml File in the SportsStore/Views Folder

@using SportsStore.Models

@using SportsStore.Models.ViewModels

@using SportsStore.Infrastructure

@addTagHelper *, Microsoft.AspNetCore.Mvc.TagHelpers
@addTagHelper *, SportsStore

In Listing 8-20, I have updated the partial view that describes each product so that it contains an Add to Cart button.
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Listing 8-20. Adding the Buttons to the ProductSummary.cshtml File View in the SportsStore/Views/Shared Folder

@model Product

<div class="card card-outline-primary m-1 p-1">
<div class="bg-faded p-1">
<h4>
@odel .Name
<span class="badge badge-pill badge-primary" style="float:right">
<small>@Model.Price.ToString("c")</small>
</span>
</h4>
</div>
<form id="@Model.ProductID" asp-page="/Cart" method="post"»
<input type="hidden" asp-for="ProductID" />
<input type="hidden" name="returnUrl"
value="@ViewContext.HttpContext.Request.PathAndQuexry()" />
<span class="card-text p-1"»
@Model.Description
<button type="submit"
class="btn btn-success btn-sm pull-right" style="float:right"s
Add To Cart
</button>
</span>
</foxm>
</div>

I have added a form element that contains hidden input elements specifying the ProductID value from the view model and
the URL that the browser should be returned to after the cart has been updated. The form element and one of the input elements
are configured using built-in tag helpers, which are a useful way of generating forms that contain model values and that target
controllers or Razor Pages, as described in Chapter 27. The other input element uses the extension method I created to set the
return URL. I also added a button element that will submit the form to the application.

Note Notice that | have set the method attribute on the form element to post, which instructs the browser to submit the form data
using an HTTP POST request. You can change this so that forms use the GET method, but you should think carefully about doing so. The
HTTP specification requires that GET requests must be idempotent, meaning that they must not cause changes, and adding a product to
a cart is definitely a change.

Enabling Sessions

I am going to store details of a user’s cart using session state, which is data associated with a series of requests made by a user. ASP.
NET provides a range of different ways to store session state, including storing it in memory, which is the approach that I am going
to use. This has the advantage of simplicity, but it means that the session data is lost when the application is stopped or restarted.
Enabling sessions requires adding services and middleware in the Startup class, as shown in Listing 8-21.

Listing 8-21. Enabling Sessions in the Startup.cs File in the SportsStore Folder

using System;

using System.Collections.Generic;

using System.Lling;

using System.Threading.Tasks;

using Microsoft.AspNetCore.Builder;

using Microsoft.AspNetCore.Hosting;

using Microsoft.AspNetCore.Http;

using Microsoft.Extensions.DependencyInjection;
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using Microsoft.Extensions.Hosting;

using Microsoft.Extensions.Configuration;
using Microsoft.EntityFrameworkCore;
using SportsStore.Models;

namespace SportsStore {
public class Startup {

public Startup(IConfiguration config) {
Configuration = config;
}

private IConfiguration Configuration { get; set; }

public void ConfigureServices(IServiceCollection services) {

services.AddControllersWithViews();
services.AddDbContext<StoreDbContext>(opts => {

opts.UseSqlServer(

Configuration["ConnectionStrings:SportsStoreConnection"]);

1;
services.AddScoped<IStoreRepository, EFStoreRepository>();
services.AddRazorPages();
services.AddDistributedMemoryCache();
services.AddSession();

}

public void Configure(IApplicationBuilder app, IWebHostEnvironment env) {

app.UseDeveloperExceptionPage();

app.UseStatusCodePages();

app.UseStaticFiles();

app.UseSession();

app.UseRouting();

app.UseEndpoints(endpoints => {

endpoints.MapControllerRoute("catpage”,

"{category}/Page{productPage:int}",
new { Controller = "Home", action = "Index" });

endpoints.MapControllerRoute("page", "Page{productPage:int}",
new { Controller = "Home", action = "Index", productPage = 1 });

endpoints.MapControllerRoute("category", "{category}",

new { Controller = "Home", action = "Index", productPage = 1 });
endpoints.MapControllerRoute("pagination",

"Products/Page{productPage}",

new { Controller = "Home", action = "Index", productPage = 1 });

endpoints.MapDefaultControllerRoute();
endpoints.MapRazorPages();

1;

SeedData.EnsurePopulated(app);

The AddDistributedMemoryCache method call sets up the in-memory data store. The AddSession method registers the services
used to access session data, and the UseSession method allows the session system to automatically associate requests with sessions
when they arrive from the client.
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Implementing the Cart Feature

Now that the preparations are complete, I can implement the cart features. I started by adding a class file called Cart.cs to the
Models folder in the SportsStore project and used it to define the classes shown in Listing 8-22.

Listing 8-22. The Contents of the Cart.cs File in the SportsStore/Models Folder

using System.Collections.Generic;
using System.Ling;

namespace SportsStore.Models {
public class Cart {
public List<CartLine> Lines { get; set; } = new List<CartLine>();

public void AddItem(Product product, int quantity) {
CartlLine line = Lines
.Where(p => p.Product.ProductID == product.ProductID)
.FirstOrDefault();

if (line == null) {
Lines.Add(new Cartline {
Product = product,
Quantity = quantity
1;
} else {
line.Quantity += quantity;
}

}

public void Removeline(Product product) =>
Lines.RemoveAll(1l => 1.Product.ProductID == product.ProductID);

public decimal ComputeTotalValue() =>
Lines.Sum(e => e.Product.Price * e.Quantity);

public void Clear() => Lines.Clear();
}

public class CartLine {
public int CartLineID { get; set; }
public Product Product { get; set; }
public int Quantity { get; set; }

The Cart class uses the CartlLine class, defined in the same file, to represent a product selected by the customer and the
quantity the user wants to buy. I defined methods to add an item to the cart, remove a previously added item from the cart, calculate
the total cost of the items in the cart, and reset the cart by removing all the items.

UNIT TEST: TESTING THE CART

The Cart class is relatively simple, but it has a range of important behaviors that must work properly. A poorly functioning cart
would undermine the entire SportsStore application. | have broken down the features and tested them individually. | created a
new unit test file called CartTests.cs in the SportsStore.Tests project to contain these tests.
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The first behavior relates to when | add an item to the cart. If this is the first time that a given Product has been added to the
cart, | want a new CartLine to be added. Here is the test, including the unit test class definition:

using System.Ling;

using SportsStore.Models;

using Xunit;

namespace SportsStore.Tests {
public class CartTests {

[Fact]
public void Can_Add New Lines() {

// Arrange - create some test products
Product p1 = new Product { ProductID = 1, Name = "P1" };
Product p2 = new Product { ProductID = 2, Name = "P2" };

// Arrange - create a new cart
Cart target = new Cart();

// Act

target.AddItem(p1, 1);

target.AddItem(p2, 1);

CartlLine[] results = target.Lines.ToArray();

// Assert

Assert.Equal(2, results.Length);
Assert.Equal(p1, results[0].Product);
Assert.Equal(p2, results[1].Product);

}

However, if the customer has already added a Product to the cart, | want to increment the quantity of the corresponding
CartLine and not create a new one. Here is the test:

[Fact]
public void Can_Add Quantity For Existing Lines() {
// Arrange - create some test products
Product p1 = new Product { ProductID
Product p2 = new Product { ProductID

1, Name = "P1" };
2, Name = "P2" };

// Arrange - create a new cart
Cart target = new Cart();

// Act
target.AddItem(p1, 1);
target.AddItem(p2, 1);
target.AddItem(p1, 10);
CartlLine[] results = target.Lines
.OrderBy(c => c.Product.ProductID).ToArray();

// Assert

Assert.Equal(2, results.Length);
Assert.Equal(11, results[0].Quantity);
Assert.Equal(1, results[1].Quantity);
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| also need to check that users can change their mind and remove products from the cart. This feature is implemented by the
Removeline method. Here is the test:

[Fact]

public void Can_Remove_Line() {
// Arrange - create some test products
Product p1 = new Product { ProductID = 1, Name = "P1" };
Product p2 = new Product { ProductID = 2, Name = "P2" };
Product p3 = new Product { ProductID = 3, Name = "P3" };

// Arrange - create a new cart

Cart target = new Cart();

// Arrange - add some products to the cart
target.AddItem(p1, 1);

target.AddItem(p2, 3);

target.AddItem(p3, 5);

target.AddItem(p2, 1);

// Act
target.Removeline(p2);

// Assert
Assert.Empty(target.Lines.Where(c => c.Product == p2));
Assert.Equal(2, target.Lines.Count());

The next behavior | want to test is the ability to calculate the total cost of the items in the cart. Here’s the test for this behavior:

[Fact]

public void Calculate Cart Total() {
// Arrange - create some test products
Product p1 = new Product { ProductID = 1, Name = "P1", Price = 100M };
Product p2 = new Product { ProductID = 2, Name = "P2", Price = 50M };

// Arrange - create a new cart
Cart target = new Cart();

// Act

target.AddItem(p1, 1);

target.AddItem(p2, 1);

target.AddItem(p1, 3);

decimal result = target.ComputeTotalValue();

// Assert
Assert.Equal(450M, result);

The final test is simple. | want to ensure that the contents of the cart are properly removed when reset. Here is the test:

[Fact]

public void Can_Clear Contents() {
// Arrange - create some test products
Product p1 = new Product { ProductID = 1, Name = "P1", Price = 100M };
Product p2 = new Product { ProductID = 2, Name = "P2", Price = 50M };

// Arrange - create a new cart
Cart target = new Cart();
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// Arrange - add some items
target.AddItem(p1, 1);
target.AddItem(p2, 1);

// Act - reset the cart
target.Clear();

// Assert
Assert.Empty(target.Lines);

Sometimes, as in this case, the code required to test the functionality of a class is longer and more complex than the class itself.
Do not let that put you off writing the unit tests. Defects in simple classes can have huge impacts, especially ones that play such
an important role as Cart does in the example application.

Defining Session State Extension Methods

The session state feature in ASP.NET Core stores only int, string, and byte[ ] values. Since I want to store a Cart object, I need

to define extension methods to the ISession interface, which provides access to the session state data to serialize Cart objects
into JSON and convert them back. I added a class file called SessionExtensions.cs to the Infrastructure folder and defined the
extension methods shown in Listing 8-23.

Listing 8-23. The Contents of the SessionExtensions.cs File in the SportsStore/Infrastructure Folder

using Microsoft.AspNetCore.Http;
using System.Text.Json;

namespace SportsStore.Infrastructure {
public static class SessionExtensions {
public static void SetJson(this ISession session, string key, object value) {

session.SetString(key, JsonSerializer.Serialize(value));
}

public static T GetJson<T>(this ISession session, string key) {
var sessionData = session.GetString(key);
return sessionData == null
? default(T) : JsonSerializer.Deserialize<T>(sessionData);

}
}
}
These methods serialize objects into the JavaScript Object Notation format, making it easy to store and retrieve Cart objects.
Completing the Razor Page

The Cart Razor Page will receive the HTTP POST request that the browser sends when the user clicks an Add To Cart button. It will
use the request form data to get the Product object from the database and use it to update the user’s cart, which will be stored as
session data for use by future requests. Listing 8-24 implements these features.
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Listing 8-24. Handling Requests in the Cart.cshtml File in the SportsStore/Pages Folder

@page
@model CartModel

<h2>Your cart</h2>
<table class="table table-bordered table-striped">
<thead>
<tr>
<th>Quantity</th>
<th>Item</th>
<th class="text-right">Price</th>
<th class="text-right">Subtotal</th>

</tr>
</thead>
<tbody>
@foreach (var line in Model.Cart.Lines) {
<tr>
<td class="text-center">@line.Quantity</td>
<td class="text-left">@line.Product.Name</td>
<td class="text-right">@line.Product.Price.ToString("c")</td>
<td class="text-right">
@((1line.Quantity * line.Product.Price).ToString("c"))
</td>
</tr>
}
</tbody>
<tfoot>
<tr>

<td colspan="3" class="text-right">Total:</td>
<td class="text-right">
@Model.Cart.ComputeTotalValue().ToString("c")
</td>
</tr>
</tfoot>
</table>

<div class="text-center">
<a class="btn btn-primary" href="@Model.ReturnUrl">Continue shopping</a>
</div>

Razor Pages allow HTML content, Razor expressions, and code to be combined in a single file, as I explain in Chapter 23, but
if you want to unit test a Razor Page, then you need to use a separate class file. If you are using Visual Studio, there will already be
a class file named Cart.cshtml.cs in the Pages folder, which was created by the Razor Page template item. If you are using Visual
Studio Code, you will need to create the class file separately. Use the class file, however it has been created, to define the class shown
in Listing 8-25.

Listing 8-25. The Contents of the Cart.cshtml.cs File in the SportsStore/Pages Folder

using Microsoft.AspNetCore.Mvc;

using Microsoft.AspNetCore.Mvc.RazorPages;
using SportsStore.Infrastructure;

using SportsStore.Models;

using System.Lling;

namespace SportsStore.Pages {
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public class CartModel : PageModel {
private IStoreRepository repository;

public CartModel(IStoreRepository repo) {
repository = repo;
}

public Cart Cart { get; set; }
public string ReturnUrl { get; set; }

public void OnGet(string returnUrl) {
ReturnUrl = returnUrl ?? "/";
Cart = HttpContext.Session.GetJson<Cart>("cart") ?? new Cart();

}

public IActionResult OnPost(long productId, string returnUrl) {
Product product = repository.Products
.FirstOrDefault(p => p.ProductID == productId);
Cart = HttpContext.Session.GetJson<Cart>("cart") ?? new Cart();
Cart.AddItem(product, 1);
HttpContext.Session.SetJson("cart", Cart);
return RedirectToPage(new { returnUrl = returnUrl });

The class associated with a Razor Page is known as its page model class, and it defines handler methods that are invoked for
different types of HTTP requests, which update state before rendering the view. The page model class in Listing 8-25, which is
named CartModel, defines an OnPost hander method, which is invoked to handle HTTP POST requests. It does this by retrieving
a Product from the database, retrieving the user’s Cart from the session data, and updating its content using the Product. The
modified Cart is stored, and the browser is redirected to the same Razor Page, which it will do using a GET request (which prevents
reloading the browser from triggering a duplicate POST request).

The GET request is handled by the OnGet handler method, which sets the values of the ReturnUrl and Cart properties, after
which the Razor content section of the page is rendered. The expressions in the HTML content are evaluated using the CartModel
as the view model object, which means that the values assigned to the ReturnUrl and Cart properties can be accessed within the
expressions. The content generated by the Razor Page details the products added to the user’s cart and provides a button to navigate
back to the point where the product was added to the cart.

The handler methods use parameter names that match the input elements in the HTML forms produced by the
ProductSummary.cshtml view. This allows ASP.NET Core to associate incoming form POST variables with those parameters,
meaning I do not need to process the form directly. This is known as model binding and is a powerful tool for simplifying
development, as I explain in detail in Chapter 28.

UNDERSTANDING RAZOR PAGES

Razor Pages can feel a little odd when you first start using them, especially if you have previous experience with the MVC
Framework features provided by ASP.NET Core. But Razor Pages are complementary to the MVC Framework, and | find myself
using them alongside controllers and views because they are well-suited to self-contained features that don’t require the
complexity of the MVC Framework. | describe Razor Pages in Chapter 23 and show their use alongside controllers throughout
Part 3 and Part 4 of this book.

The result is that the basic functions of the shopping cart are in place. First, products are listed along with a button to add them
to the cart, which you can see by restarting ASP.NET Core and requesting http://localhost:5000, as shown in Figure 8-10.
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& SportsStore

< C @ localhost:5000/Page1

SPORTS STORE

i Kayak
Chess A boat for one person
soccer | Lifejacket
Watersports Protective and fashionable
Soccer Ball _,@

} . ot b b -ttt A A senss B e . Y

Figure 8-10. The Add To Cart buttons

Second, when the user clicks an Add To Cart button, the appropriate product is added to their cart, and a summary of the cart is
displayed, as shown in Figure 8-11. Clicking the Continue Shopping button returns the user to the product page they came from.

@ SportsStore

< C @ localhost:5000/Cart?returnUrl=%2FPage1

SPORTS STORE

Your cart

Quantity Item Price Subtotal
1 Kayak $275.00 $275.00

Total: $275.00

Continue shopping

Figure 8-11. Displaying the contents of the shopping cart
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UNIT TESTING: RAZOR PAGES

Testing Razor Pages can require a lot of mocking to create the context objects that the page model class requires. To test
the behavior of the OnGet method defined by the CartModel class, | added a class file named CartPageTests.cs to the
SportsStore.Tests project and defined this test:

using Microsoft.AspNetCore.Http;
using Microsoft.AspNetCore.Mvc;
using Microsoft.AspNetCore.Mvc.RazorPages;
using Microsoft.AspNetCore.Routing;
using Mogq;

using SportsStore.Models;

using SportsStore.Pages;

using System.ling;

using System.Text;

using System.Text.Json;

using Xunit;

namespace SportsStore.Tests {
public class CartPageTests {

[Fact]
public void Can_Load Cart() {

// Arrange
// - create a mock repository
Product p1 = new Product { ProductID = 1, Name = "P1" };
Product p2 = new Product { ProductID = 2, Name = "P2" };
Mock<IStoreRepository> mockRepo = new Mock<IStoreRepository>();
mockRepo.Setup(m => m.Products).Returns((new Product[] {

p1, p2
}) .AsQueryable<Product>());

// - create a cart

Cart testCart = new Cart();

testCart.AddItem(p1, 2);

testCart.AddItem(p2, 1);

// - create a mock page context and session

Mock<ISession> mockSession = new Mock<ISession>();

byte[] data =
Encoding.UTF8.CetBytes(JsonSerializer.Serialize(testCart));

mockSession.Setup(c => c.TryGetValue(It.IsAny<string>(), out data));

Mock<HttpContext> mockContext = new Mock<HttpContext>();

mockContext.SetupGet(c => c.Session).Returns(mockSession.Object);

// Action
CartModel cartModel = new CartModel(mockRepo.Object) {
PageContext = new PageContext(new ActionContext {
HttpContext = mockContext.Object,
RouteData = new RouteData(),
ActionDescriptor = new PageActionDescriptor()

H
};
cartModel.OnGet ("myUrl");

//Assert
Assert.Equal(2, cartModel.Cart.Lines.Count());
Assert.Equal("myUrl", cartModel.ReturnUrl);
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| am not going to describe these unit tests in detail because there is a simpler way to perform these tests, which | explain in
the next chapter. The complexity in this test is mocking the ISession interface so that the page model class can use extension
methods to retrieve a JSON representation of a Cart object. The ISession interface only stored byte arrays, and getting and
deserializing a string is performed by extension methods. Once the mock objects are defined, they can be wrapped in context
objects and used to configure an instance of the page model class, which can be subjected to tests.

The process of testing the OnPost method of the page model class means capturing the byte array that is passed to the
ISession interface mock and then deserializing it to ensure that it contains the expected content. Here is the unit test | added to
the CartTestsPage class:

[Fact]
public void Can Update Cart() {
// Arrange
// - create a mock repository
Mock<IStoreRepository> mockRepo = new Mock<IStoreRepository>();
mockRepo.Setup(m => m.Products).Returns((new Product[] {
new Product { ProductID = 1, Name = "P1" }
}) .AsQueryable<Product>());

Cart testCart = new Cart();

Mock<ISession> mockSession = new Mock<ISession>();
mockSession.Setup(s => s.Set(It.IsAny<string>(), It.IsAny<byte[]>()))
.Callback<string, byte[]>((key, val) => {
testCart =
JsonSerializer.Deserialize<Cart>(Encoding.UTF8.CGetString(val));
D;

Mock<HttpContext> mockContext = new Mock<HttpContext>();
mockContext.SetupGet(c => c.Session).Returns(mockSession.Object);

// Action
CartModel cartModel = new CartModel(mockRepo.Object) {
PageContext = new PageContext(new ActionContext {
HttpContext = mockContext.Object,
RouteData = new RouteData(),
ActionDescriptor = new PageActionDescriptor()

H
};
cartModel.OnPost(1, "myUrl");

//Assert

Assert.Single(testCart.Lines);

Assert.Equal("P1", testCart.Lines.First().Product.Name);
Assert.Equal(1, testCart.lLines.First().Quantity);

Patience and a little experimentation are required to write effective unit tests, especially when the feature you are testing
operates on the context objects that ASP.NET Core provides.

Summary

In this chapter, I started to flesh out the customer-facing parts of the SportsStore app. I provided the means by which the user can
navigate by category and put the basic building blocks in place for adding items to a shopping cart. I have more work to do, and I
continue the development of the application in the next chapter.
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SportsStore: Completing the Cart

In this chapter, I continue to build the SportsStore example app. In the previous chapter, I added the basic support for a shopping
cart, and now [ am going to improve on and complete that functionality.

Tip You can download the example project for this chapter—and for all the other chapters in this book—from https://github.
com/apress/pro-asp.net-core-3. See Chapter 1 for how to get help if you have problems running the examples.

Refining the Cart Model with a Service

I defined a Cart model class in the previous chapter and demonstrated how it can be stored using the session feature, allowing the
user to build up a set of products for purchase. The responsibility for managing the persistence of the Cart class fell to the Cart Razor
Page, which has to deal with getting and storing Cart objects as session data.

The problem with this approach is that I will have to duplicate the code that obtains and stores Cart objects in any other Razor
Page or controller that uses them. In this section, I am going to use the services feature that sits at the heart of ASP.NET Core to
simplify the way that Cart objects are managed, freeing individual components such as the Cart controller from needing to deal
with the details directly.

Services are commonly used to hide details of how interfaces are implemented from the components that depend on them. But
services can be used to solve lots of other problems as well and can be used to shape and reshape an application, even when you are
working with concrete classes such as Cart.

Creating a Storage-Aware Cart Class

The first step in tidying up the way that the Cart class is used will be to create a subclass that is aware of how to store itself using
session state. To prepare, I apply the virtual keyword to the Cart class, as shown in Listing 9-1, so that I can override the members.

Listing 9-1. Applying the Virtual Keyword in the Cart.cs File in the SportsStore/Models Folder

using System.Collections.Generic;
using System.Lling;

namespace SportsStore.Models {
public class Cart {
public List<CartLine> Lines { get; set; } = new List<CartLine>();
public virtual void AddItem(Product product, int quantity) {
CartlLine line = Lines

.Where(p => p.Product.ProductID == product.ProductID)
.FirstOrDefault();
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if (line == null) {
Lines.Add(new CartlLine {
Product = product,
Quantity = quantity
1;
} else {
line.Quantity += quantity;
}

}

public virtual void Removeline(Product product) =»
Lines.RemoveAll(1l => 1.Product.ProductID == product.ProductID);

public decimal ComputeTotalValue() =>
Lines.Sum(e => e.Product.Price * e.Quantity);

public virtual void Clear() =» Lines.Clear();

}

public class CartLine {
public int CartLineID { get; set; }
public Product Product { get; set; }
public int Quantity { get; set; }

Next, [ added a class file called SessionCart.cs to the Models folder and used it to define the class shown in Listing 9-2.

Listing 9-2. The Contents of the SessionCart.cs File in the SportsStore/Models Folder

using System;

using System.Text.Json.Serialization;

using Microsoft.AspNetCore.Http;

using Microsoft.Extensions.DependencyInjection;
using SportsStore.Infrastructure;

namespace SportsStore.Models {
public class SessionCart : Cart {

public static Cart GetCart(IServiceProvider services) {
ISession session = services.GetRequiredService<IHttpContextAccessor>()?
.HttpContext.Session;
SessionCart cart = session?.GetJson<SessionCart>("Cart")
?? new SessionCart();
cart.Session = session;
return cart;

}

[JsonIgnore]
public ISession Session { get; set; }

public override void AddItem(Product product, int quantity) {

base.AddItem(product, quantity);
Session.SetJson("Cart", this);
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public override void RemovelLine(Product product) {
base.Removeline(product);
Session.SetJson("Cart", this);

}

public override void Clear() {
base.Clear();
Session.Remove("Cart");

The SessionCart class subclasses the Cart class and overrides the AddItem, Removeline, and Clear methods so they call the
base implementations and then store the updated state in the session using the extension methods on the ISession interface. The
static GetCart method is a factory for creating SessionCart objects and providing them with an ISession object so they can store
themselves.

Getting hold of the ISession object s a little complicated. I obtain an instance of the IHttpContextAccessor service, which
provides me with access to an HttpContext object that, in turn, provides me with the ISession. This indirect approach is required
because the session isn’t provided as a regular service.

Registering the Service

The next step is to create a service for the Cart class. My goal is to satisfy requests for Cart objects with SessionCart objects that will
seamlessly store themselves. You can see how I created the service in Listing 9-3.

Listing 9-3. Creating the Cart Service in the Startup.cs File in the SportsStore Folder

using System;

using System.Collections.Generic;

using System.Ling;

using System.Threading.Tasks;

using Microsoft.AspNetCore.Builder;

using Microsoft.AspNetCore.Hosting;

using Microsoft.AspNetCore.Http;

using Microsoft.Extensions.DependencyInjection;
using Microsoft.Extensions.Hosting;

using Microsoft.Extensions.Configuration;
using Microsoft.EntityFrameworkCore;
using SportsStore.Models;

namespace SportsStore {
public class Startup {

public Startup(IConfiguration config) {
Configuration = config;
}

private IConfiguration Configuration { get; set; }

public void ConfigureServices(IServiceCollection services) {
services.AddControllersWithViews();
services.AddDbContext<StoreDbContext>(opts => {
opts.UseSqlServer(
Configuration["ConnectionStrings:SportsStoreConnection"]);
D;

services.AddScoped<IStoreRepository, EFStoreRepository>();
services.AddRazorPages();

191



CHAPTER 9 © SPORTSSTORE: COMPLETING THE CART

services.AddDistributedMemoryCache();

services.AddSession();

services.AddScoped<Cart>(sp => SessionCart.GetCart(sp));
services.AddSingleton<IHttpContextAccessor, HttpContextAccessors();

}

public void Configure(IApplicationBuilder app, IWebHostEnvironment env) {

app.UseDeveloperExceptionPage();

app.UseStatusCodePages();

app.UseStaticFiles();

app.UseSession();

app.UseRouting();

app.UseEndpoints(endpoints => {
endpoints.MapControllerRoute("catpage”,

"{category}/Page{productPage:int}",

new { Controller = "Home", action = "Index" });

endpoints.MapControllerRoute("page", "Page{productPage:int}",
new { Controller = "Home", action = "Index", productPage = 1 });

endpoints.MapControllerRoute("category”, "{category}",

new { Controller = "Home", action = "Index", productPage = 1 });
endpoints.MapControllerRoute("pagination",

"Products/Page{productPage}",

new { Controller = "Home", action = "Index", productPage = 1 });

endpoints.MapDefaultControllerRoute();
endpoints.MapRazorPages();

1

SeedData.EnsurePopulated(app);

The AddScoped method specifies that the same object should be used to satisfy related requests for Cart instances. How
requests are related can be configured, but by default, it means that any Cart required by components handling the same HTTP
request will receive the same object.

Rather than provide the AddScoped method with a type mapping, as I did for the repository, I have specified a lambda
expression that will be invoked to satisfy Cart requests. The expression receives the collection of services that have been registered
and passes the collection to the GetCart method of the SessionCart class. The result is that requests for the Cart service will be
handled by creating SessionCart objects, which will serialize themselves as session data when they are modified.

I also added a service using the AddSingleton method, which specifies that the same object should always be used. The service
I created tells ASP.NET Core to use the HttpContextAccessor class when implementations of the IHttpContextAccessor interface
are required. This service is required so I can access the current session in the SessionCart class.

Simplifying the Cart Razor Page

The benefit of creating this kind of service is that it allows me to simplify the code where Cart objects are used. In Listing 9-4, I have
reworked the page model class for the Cart Razor Page to take advantage of the new service.

Listing 9-4. Using the Cart Service in the Cart.cshtml.cs File in the SportsStore/Pages Folder

using Microsoft.AspNetCore.Mvc;

using Microsoft.AspNetCore.Mvc.RazorPages;
using SportsStore.Infrastructure;

using SportsStore.Models;

using System.Ling;
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namespace SportsStore.Pages {

public class CartModel : PageModel {
private IStoreRepository repository;

public CartModel(IStoreRepository repo, Cart cartService) {
repository = repo;
Cart = cartService;

}

public Cart Cart { get; set; }
public string ReturnUrl { get; set; }

public void OnGet(string returnUrl) {
ReturnUrl = returnUrl ?? "/";
}

public IActionResult OnPost(long productld, string returnUrl) {
Product product = repository.Products
.FirstOrDefault(p => p.ProductID == productld);
Cart.AddItem(product, 1);
return RedirectToPage(new { returnUrl = returnUrl });

The page model class indicates that it needs a Cart object by declaring a constructor argument, which has allowed me to
remove the statements that load and store sessions from the handler methods. The result is a simpler page model class that focuses
on its role in the application without having to worry about how Cart objects are created or persisted. And, since services are
available throughout the application, any component can get hold of the user’s cart using the same technique.

UPDATING THE UNIT TESTS

The simplification of the CartModel class in Listing 9-4 requires a corresponding change to the unit tests in the CartPageTests.cs
file in the unit test project so that the Cart is provided as a constructor argument and not accessed through the context objects.
Here is the change to the test for reading the cart:

[Fact]
public void Can_Load Cart() {
// Arrange
// - create a mock repository
Product p1 = new Product { ProductID = 1, Name = "P1" };
Product p2 = new Product { ProductID = 2, Name = "P2" };
Mock<IStoreRepository> mockRepo = new Mock<IStoreRepository>();
mockRepo.Setup(m => m.Products).Returns((new Product[] {
p1, p2
}) .AsQueryable<Product>());

// - create a cart

Cart testCart = new Cart();
testCart.AddItem(p1, 2);
testCart.AddItem(p2, 1);

// Action
CartModel cartModel = new CartModel(mockRepo.Object, testCart);
cartModel.OnGet ("myUrl");
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//Assert
Assert.Equal(2, cartModel.Cart.Lines.Count());
Assert.Equal("myUrl", cartModel.ReturnUrl);

| applied the same change to the unit test that checks changes to the cart:

[Fact]
public void Can Update Cart() {
// Arrange
// - create a mock repository
Mock<IStoreRepository> mockRepo = new Mock<IStoreRepository>();
mockRepo.Setup(m => m.Products).Returns((new Product[] {
new Product { ProductID = 1, Name = "P1" }
}) .AsQueryable<Product>());

Cart testCart = new Cart();

// Action
CartModel cartModel = new CartModel(mockRepo.Object, testCart);
cartModel.OnPost(1, "myUrl");

//Assert

Assert.Single(testCart.Lines);

Assert.Equal("P1", testCart.Lines.First().Product.Name);
Assert.Equal(1, testCart.Lines.First().Quantity);

Using services simplifies the testing process and makes it much easier to provide the class being tested with its dependencies.

Completing the Cart Functionality

Now that I have introduced the Cart service, it is time to complete the cart functionality by adding two new features. The first will
allow the customer to remove an item from the cart. The second feature will display a summary of the cart at the top of the page.

Removing Items from the Cart

To remove items from the cart, I need to add a Remove button to the content rendered by the Cart Razor Page that will submit an
HTTP POST request. The changes are shown in Listing 9-5.

Listing 9-5. Removing Cart Items in the Cart.cshtml File in the SportsStore/Pages Folder

@page
@model CartModel

<h2>Your cart</h2>
<table class="table table-bordered table-striped">
<thead>
<tr>
<th>Quantity</th>
<th>Item</th>
<th class="text-right">Price</th>
<th class="text-right">Subtotal</th>
<th></th>
</tr>
</thead>
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<tbody>
@foreach (var line in Model.Cart.Lines) {
<tr>
<td class="text-center">@line.Quantity</td>
<td class="text-left">@line.Product.Name</td>
<td class="text-right">@line.Product.Price.ToString("c")</td>
<td class="text-right">
@((1line.Quantity * line.Product.Price).ToString("c"))
</td>
<td class="text-center">
<form asp-page-handler="Remove" method="post">
<input type="hidden" name="ProductID"
value="@line.Product.ProductID" /»
<input type="hidden" name="returnUrl"
value="@Model.ReturnUrl" />
<button type="submit" class="btn btn-sm btn-danger"s
Remove
</button>
</formy
</td>
</tr>
}
</tbody>
<tfoot>
<tr>
<td colspan="3" class="text-right">Total:</td>
<td class="text-right">
@Model.Cart.ComputeTotalValue().ToString("c")
</td>
</tr>
</tfoot>
</table>

<div class="text-center">
<a class="btn btn-primary" href="@lodel.ReturnUrl">Continue shopping</a>
</div>

SPORTSSTORE: COMPLETING THE CART

The button requires a new handler method in the page model class that will receive the request and modify the cart, as shown

in Listing 9-6.

Listing 9-6. Removing an Item in the Cart.cshtml.cs File in the SportsStore/Pages Folder

using Microsoft.AspNetCore.Mvc;

using Microsoft.AspNetCore.Mvc.RazorPages;
using SportsStore.Infrastructure;

using SportsStore.Models;

using System.Lling;

namespace SportsStore.Pages {

public class CartModel : PageModel {
private IStoreRepository repository;

public CartModel(IStoreRepository repo, Cart cartService) {
repository = repo;
Cart = cartService;
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public Cart Cart { get; set; }
public string ReturnUrl { get; set; }

public void OnGet(string returnUrl) {
ReturnUrl = returnUrl ?2? "/";
}

public IActionResult OnPost(long productId, string returnUrl) {
Product product = repository.Products
.FirstOrDefault(p => p.ProductID == productId);
Cart.AddItem(product, 1);
return RedirectToPage(new { returnUrl = returnUrl });

}

public IActionResult OnPostRemove(long productId, string returnUrl) {
Cart.RemovelLine(Cart.Lines.First(cl =>
cl.Product.ProductID == productId).Product);
return RedirectToPage(new { returnUrl = returnUrl });

The new HTML content defines an HTML form. The handler method that will receive the request is specified with the asp-
page-handler tag helper attribute, like this:

<form asp-page-handler="Remove" method="post">

The specified name is prefixed with On and given a suffix that matches the request type so that a value of Remove selects the
OnRemovePost handler method. The handler method uses the value it receives to locate the item in the cart and remove it.

Restart ASP.NET Core and request http://localhost:5000. Click the Add To Cart buttons to add items to the cart and then
click a Remove button. The cart will be updated to remove the item you specified, as shown in Figure 9-1.

r @ SportsStore x

&« C @ locathost:5000/Cart?returnlrl =%2F b ¢

@ Sportsitore L+
(_

C (@ localhost5000/Cart?returnUl=2%2F

SPORTS STORE

SPORTS STORE

Your cart
Your cart
Quantity Item Price Subtotal
Quantity Item Price Subtotal
1 Lifejacket §48.95 $48.95
| 1 Lifejacket $48.95 $43.95 Rarre
1 Comer Flags $3495 $34.95 |m —_—
| 1 Kayak $275.00 $275.00 m
1 Kayak $275.00 527500 m

Total: $323.95

Total: $358.90
Continue shopping

Figure 9-1. Removing items from the shopping cart

Adding the Cart Summary Widget

I may have a functioning cart, but there is an issue with the way it is integrated into the interface. Customers can tell what is in their
cart only by viewing the cart summary screen. And they can view the cart summary screen only by adding a new item to the cart.
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To solve this problem, I am going to add a widget that summarizes the contents of the cart and that can be clicked to display
the cart contents throughout the application. I will do this in much the same way that I added the navigation widget—as a view
component whose output I can include in a Razor layout.

Adding the Font Awesome Package

As part of the cart summary, I am going to display a button that allows the user to check out. Rather than display the word checkout
in the button, I want to use a cart symbol. Since I have no artistic skills, I am going to use the Font Awesome package, which is an
excellent set of open source icons that are integrated into applications as fonts, where each character in the font is a different image.
You can learn more about Font Awesome, including inspecting the icons it contains, at http://fortawesome.github.io/Font-
Awesonme.

To install the client-side package, use a PowerShell command prompt to run the command shown in Listing 9-7 in the
SportsStore project.

Listing 9-7. Installing the Icon Package

libman install font-awesome@®5.12.0 -d wwwroot/lib/font-awesome

Creating the View Component Class and View

Iadded a class file called CartSummaryViewComponent.cs in the Components folder and used it to define the view component shown
in Listing 9-8.

Listing 9-8. The Contents of the CartSummaryViewComponent.cs File in the SportsStore/Components Folder

using Microsoft.AspNetCore.Mvc;

using SportsStore.Models;

namespace SportsStore.Components {

public class CartSummaryViewComponent : ViewComponent {
private Cart cart;

public CartSummaryViewComponent(Cart cartService) {
cart = cartService;
}

public IViewComponentResult Invoke() {
return View(cart);
}

This view component is able to take advantage of the service that I created earlier in the chapter to receive a Cart object
as a constructor argument. The result is a simple view component class that passes on the Cart to the View method to generate
the fragment of HTML that will be included in the layout. To create the view for the component, I created the Views/Shared/
Components/CartSummary folder and added to it a Razor View named Default.cshtml with the content shown in Listing 9-9.

Listing 9-9. The Default.cshtml File in the Views/Shared/Components/CartSummary Folder

@model Cart

<div class=""»>
@if (Model.Lines.Count() > 0) {
<small class="navbar-text">

<b>Your cart:</b>
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@Model.Lines.Sum(x => x.Quantity) item(s)
@Model.ComputeTotalValue().ToString("c")
</small>
}
<a class="btn btn-sm btn-secondary navbar-btn" asp-page="/Cart"
asp-route-returnurl="@ iewContext.HttpContext.Request.PathAndQuery()">
<i class="fa fa-shopping-cart"></i>
</a>
</div>

The view displays a button with the Font Awesome cart icon and, if there are items in the cart, provides a snapshot that details
the number of items and their total value. Now that I have a view component and a view, I can modify the layout so that the cart

summary is included in the responses generated by the Home controller, as shown in Listing 9-10.

Listing 9-10. Adding the Cart Summary in the _Layout.cshtml File in the Views/Shared Folder

<!DOCTYPE html>
<html>
<head>
<meta name="viewport" content="width=device-width" />
<title>SportsStore</title>
<link href="/1ib/twitter-bootstrap/css/bootstrap.min.css" rel="stylesheet" />
<link href="/1ib/font-awesome/css/all.min.css" rel="stylesheet" />
</head>
<body>
<div class="bg-dark text-white p-2"»
<div class="container-fluid"»>
<div class="row"»
<div class="col navbar-brand"»>SPORTS STORE</div>
<div class="col-6 text-right"»
<vc:cart-summaxy />
</div>
</div>
</div>
</div»
<div class="row m-1 p-1">
<div id="categories" class="col-3">
<vc:navigation-menu />

</div>
<div class="col-9">
@RenderBody()
</div>
</div>
</body>
</html>

You can see the cart summary by starting the application. When the cart is empty, only the checkout button is shown. If you
add items to the cart, then the number of items and their combined cost are shown, as illustrated in Figure 9-2. With this addition,

customers know what is in their cart and have an obvious way to check out from the store.
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@ SportsStore x

“

C @ localhost:5000

SPORTS STORE

@ SportsStore X

&

$275.00

C @ localhost:5000 Add To Cart

SPORTS STORE

Home Kayak m},

O i o e LW Gy SPEY SR  _

$48.95

Add To Cart

Figure 9-2. Displaying a summary of the cart

Submitting Orders

I have now reached the final customer feature in SportsStore: the ability to check out and complete an order. In the following
sections, I will extend the data model to provide support for capturing the shipping details from a user and add the application
support to process those details.

Creating the Model Class

Tadded a class file called Order. cs to the Models folder and used it to define the class shown in Listing 9-11. This is the class I will
use to represent the shipping details for a customer.

Listing 9-11. The Contents of the Order.cs File in the SportsStore/Models Folder

using System.Collections.Generic;
using System.ComponentModel.DataAnnotations;
using Microsoft.AspNetCore.Mvc.ModelBinding;

namespace SportsStore.Models {
public class Order {

[BindNever]

public int OrderID { get; set; }

[BindNever]

public ICollection<CartLine> Lines { get; set; }

[Required(ErrorMessage = "Please enter a name")]
public string Name { get; set; }

[Required(ErrorMessage = "Please enter the first address line")]
public string Linel { get; set; }
public string Line2 { get; set; }
public string Line3 { get; set; }

[Required(ErrorMessage = "Please enter a city name")]
public string City { get; set; }
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[Required(ErrorMessage = "Please enter a state name")]
public string State { get; set; }

public string Zip { get; set; }

[Required(ErrorMessage = "Please enter a country name")]
public string Country { get; set; }

public bool GiftWrap { get; set; }

I am using the validation attributes from the System.ComponentModel.DataAnnotations namespace, just as I did in Chapter 3.
I describe validation further in Chapter 29.

I also use the BindNever attribute, which prevents the user from supplying values for these properties in an HTTP request. This
is a feature of the model binding system, which I describe in Chapter 28, and it stops ASP.NET Core using values from the HTTP
request to populate sensitive or important model properties.

Adding the Checkout Process

The goal is to reach the point where users are able to enter their shipping details and submit an order. To start, I need to add a
Checkout button to the cart view, as shown in Listing 9-12.

Listing 9-12. Adding a Button in the Cart.cshtml File in the SportsStore/Pages Folder

<div class="text-center">
<a class="btn btn-primary" href="@Model.ReturnUrl">Continue shopping</a>
<a class="btn btn-primary" asp-action="Checkout" asp-controller="Order"»>
Checkout
</ay
</div>

This change generates a link that [ have styled as a button and that, when clicked, calls the Checkout action method of the Order
controller, which I create in the following section. To show how Razor Pages and controllers can work together, I am going to handle
the order processing in a controller and then return to a Razor Page at the end of the process. To see the Checkout button, restart
ASP.NET Core, request http://localhost:5000, and click one of the Add To Cart buttons. The new button is shown as part of the
cart summary, as shown in Figure 9-3.
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@ SportsStore

“— C @ localhost:5000/Cart?returnUrl=%2FChess%2FPage1

SPORTS STORE

Your cart
Quantity Item Price Subtotal
1 Unsteady Chair $29.95 $29.95

Total: $29.95

Continue shopping

Figure 9-3. The Checkout button

Creating the Controller and View

I now need to define the controller that will deal with the order. I added a class file called OrderController.cs to the Controllers
folder and used it to define the class shown in Listing 9-13.

Listing 9-13. The Contents of the OrderController.cs File in the SportsStore/Controllers Folder

using Microsoft.AspNetCore.Mvc;
using SportsStore.Models;

namespace SportsStore.Controllers {
public class OrderController : Controller {

public ViewResult Checkout() => View(new Order());

The Checkout method returns the default view and passes a new Order object as the view model. To create the view, I created
the Views/Order folder and added to it a Razor View called Checkout.cshtml with the markup shown in Listing 9-14.

Listing 9-14. The Contents of the Checkout.cshtml File in the SportsStore/Views/Order Folder
@model Order

<h2>Check out now</h2>
<p>Please enter your details, and we'll ship your goods right away!</p>

<form asp-action="Checkout" method="post">
<h3>Ship to</h3>
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<div class="form-group">

<label>Name:</label><input asp-for="Name" class="form-control" />
</div>
<h3>Address</h3>
<div class="form-group">

<label>Line 1:</label><input asp-for="Line1" class="form-control" />
</div>
<div class="form-group">

<label>Line 2:</label><input asp-for="Line2" class="form-control" />
</div>
<div class="form-group">

<label>Line 3:</label><input asp-for="Line3" class="form-control" />
</div>
<div class="form-group">

<label>City:</label><input asp-for="City" class="form-control" />
</div>
<div class="form-group">

<label>State:</label><input asp-for="State" class="form-control" />
</div>
<div class="form-group">

<label>Zip:</label><input asp-for="Zip" class="form-control" />
</div>
<div class="form-group">

<label>Country:</label><input asp-for="Country" class="form-control" />
</div>
<h3>0ptions</h3>
<div class="checkbox">

<label>

<input asp-for="GiftWrap" /> Gift wrap these items

</label>
</div>
<div class="text-center">

<input class="btn btn-primary" type="submit" value="Complete Order" />
</div>

</form>

For each of the properties in the model, I have created a label and input elements to capture the user input, styled with
Bootstrap and configured using a tag helper. The asp-for attribute on the input elements is handled by a built-in tag helper that
generates the type, id, name, and value attributes based on the specified model property, as described in Chapter 27.

You can see the form, shown in Figure 9-4, by restarting ASP.NET Core, requesting http://localhost:5000, adding an item to
the basket, and clicking the Checkout button. Or, more directly, you can request http://localhost:5000/order/checkout.
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Home

Chess

Soccer

Watersports

= C @ localhost:5000/Order/Checkout e

SPORTS STORE L

Check out now

Please enter your details, and we'll ship your goods right away!

Ship to

Name:

Address

Line 1:
Line 2:
Line 3:
City:
State:
Zip:

Country:

Options

Gift wrap these items

Complete Order

Figure 9-4. The shipping details form
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Implementing Order Processing

I will process orders by writing them to the database. Most e-commerce sites would not simply stop there, of course, and I have not
provided support for processing credit cards or other forms of payment. But I want to keep things focused on ASP.NET Core, so a
simple database entry will do.

Extending the Database

Adding a new kind of model to the database is simple because of the initial setup I went through in Chapter 7. First, I added a new
property to the database context class, as shown in Listing 9-15.

Listing 9-15. Adding a Property in the StoreDbContext.cs File in the SportsStore/Models Folder

using Microsoft.EntityFrameworkCore;

namespace SportsStore.Models {
public class StoreDbContext: DbContext {

public StoreDbContext(DbContextOptions<StoreDbContext> options)
: base(options) { }

public DbSet<Product> Products { get; set; }
public DbSet<Orders> Orders { get; set; }

This change is enough for Entity Framework Core to create a database migration that will allow Order objects to be stored
in the database. To create the migration, use a PowerShell command prompt to run the command shown in Listing 9-16 in the
SportsStore folder.

Listing 9-16. Creating a Migration
dotnet ef migrations add Orders

This command tells Entity Framework Core to take a new snapshot of the application data model, work out how it differs from
the previous database version, and generate a new migration called Orders. The new migration will be applied automatically when
the application starts because the SeedData calls the Migrate method provided by Entity Framework Core.

RESETTING THE DATABASE

When you are making frequent changes to the model, there will come a point when your migrations and your database schema
get out of sync. The easiest thing to do is delete the database and start over. However, this applies only during development, of
course, because you will lose any data you have stored. Run this command to delete the database:

dotnet ef database drop --force --context StoreDbContext

Once the database has been removed, run the following command from the SportsStore folder to re-create the database and
apply the migrations you have created by running the following command:

dotnet ef database update --context StoreDbContext

The migrations will also be applied by the SeedData class if you just start the application. Either way, the database will be reset
so that it accurately reflects your data model and allows you to return to developing your application.
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Creating the Order Repository

I am going to follow the same pattern I used for the product repository to provide access to the Order objects. I added a class file
called I0rderRepository.cs to the Models folder and used it to define the interface shown in Listing 9-17.

Listing 9-17. The Contents of the IOrderRepository.cs File in the SportsStore/Models Folder

using System.Ling;
namespace SportsStore.Models {
public interface IOrderRepository {

IQueryable<Order> Orders { get; }
void SaveOrder(Order order);

To implement the order repository interface, I added a class file called EFOrderRepository.cs to the Models folder and defined
the class shown in Listing 9-18.

Listing 9-18. The Contents of the EFOrderRepository.cs File in the SportsStore/Models Folder

using Microsoft.EntityFrameworkCore;
using System.ling;

namespace SportsStore.Models {

public class EFOrderRepository : IOrderRepository {
private StoreDbContext context;

public EFOrderRepository(StoreDbContext ctx) {
context = ctx;
}

public IQueryable<Order> Orders => context.Orders
.Include(o => o.Lines)
.ThenInclude(1l => 1.Product);

public void SaveOrder(Order order) {
context.AttachRange(order.Lines.Select(l => 1.Product));
if (order.OrderID == 0) {
context.Orders.Add(order);
}

context.SaveChanges();

This class implements the I0rderRepository interface using Entity Framework Core, allowing the set of Order objects that have
been stored to be retrieved and allowing for orders to be created or changed.

UNDERSTANDING THE ORDER REPOSITORY

Entity Framework Core requires instruction to load related data if it spans multiple tables. In Listing 9-18, | used the Include and
ThenInclude methods to specify that when an Order object is read from the database, the collection associated with the Lines
property should also be loaded along with each Product object associated with each collection object.
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public IQueryable<Order> Orders => context.Orders
.Include(o => o.Lines)
.ThenInclude(1l => 1.Product);

This ensures that | receive all the data objects that | need without having to perform separate queries and then assemble the
data myself.

An additional step is also required when | store an Order object in the database. When the user’s cart data is de-serialized

from the session store, new objects are created that are not known to Entity Framework Core, which then tries to write all the
objects into the database. For the Product objects associated with an Order, this means that Entity Framework Core tries to
write objects that have already been stored, which causes an error. To avoid this problem, | notify Entity Framework Core that the
objects exist and shouldn’t be stored in the database unless they are modified, as follows:

context.AttachRange(order.Lines.Select(l => 1.Product));

This ensures that Entity Framework Core won't try to write the de-serialized Product objects that are associated with the Order
object.

In Listing 9-19, I have registered the order repository as a service in the ConfigureServices method of the Startup class.

Listing 9-19. Registering the Order Repository Service in the Startup.cs File in the SportsStore Folder

public void ConfigureServices(IServiceCollection services) {
services.AddControllersWithViews();
services.AddDbContext<StoreDbContext>(opts => {
opts.UseSqlServer(
Configuration["ConnectionStrings:SportsStoreConnection"]);
D;

services.AddScoped<IStoreRepository, EFStoreRepository>();
services.AddScoped<IOrderRepository, EFOrderRepositorys();
services.AddRazorPages();

services.AddDistributedMemoryCache();

services.AddSession();

services.AddScoped<Cart>(sp => SessionCart.GetCart(sp));
services.AddSingleton<IHttpContextAccessor, HttpContextAccessor>();

Completing the Order Controller

To complete the OrderController class, I need to modify the constructor so that it receives the services it requires to process an
order and add an action method that will handle the HTTP form POST request when the user clicks the Complete Order button.
Listing 9-20 shows both changes.

Listing 9-20. Completing the Controller in the OrderController.cs File in the SportsStore/Controllers Folder

using Microsoft.AspNetCore.Mvc;
using SportsStore.Models;
using System.Ling;

namespace SportsStore.Controllers {
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public class OrderController : Controller {
private IOrderRepository repository;
private Cart cart;

public OrderController(IOrderRepository repoService, Cart cartService) {
repository = repoService;
cart = cartService;

}

public ViewResult Checkout() => View(new Order());

[HttpPost]
public IActionResult Checkout(Order order) {
if (cart.Lines.Count() == 0) {
ModelState.AddModelError("", "Sorry, your cart is empty!");

if (ModelState.IsValid) {

order.Lines = cart.Lines.ToArray();

repository.SaveOrder(order);

cart.Clear();

return RedirectToPage("/Completed”, new { orderId = order.OrderID });
} else {

return View();
}

The Checkout action method is decorated with the HttpPost attribute, which means that it will be used to handle POST
requests—in this case, when the user submits the form.

In Chapter 8, I use the ASP.NET Core model binding feature to receive simple data values from the request. This same feature
is used in the new action method to receive a completed Order object. When a request is processed, the model binding system tries
to find values for the properties defined by the Order class. This works on a best-effort basis, which means I may receive an Order
object lacking property values if there is no corresponding data item in the request.

To ensure I have the data I require, I applied validation attributes to the Order class. ASP.NET Core checks the validation
constraints that [ applied to the Order class and provides details of the result through the ModelState property. I can see whether
there are any problems by checking the ModelState.IsValid property. I call the ModelState.AddModelError method to register an
error message if there are no items in the cart. I will explain how to display such errors shortly, and I have much more to say about
model binding and validation in Chapters 28 and 29.

UNIT TEST: ORDER PROCESSING

To perform unit testing for the OrderController class, | need to test the behavior of the POST version of the Checkout method.
Although the method looks short and simple, the use of model binding means that there is a lot going on behind the scenes that
needs to be tested.

| want to process an order only if there are items in the cart and the customer has provided valid shipping details. Under all
other circumstances, the customer should be shown an error. Here is the first test method, which | defined in a class file called
OrderControllerTests.cs in the SportsStore.Tests project:

using Microsoft.AspNetCore.Mvc;
using Moq;
using SportsStore.Controllers;

using SportsStore.Models;
using Xunit;

namespace SportsStore.Tests {
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public class OrderControllerTests {

[Fact]
public void Cannot_Checkout Empty Cart() {
// Arrange - create a mock repository
Mock<IOrderRepository> mock = new Mock<IOrderRepository>();
// Arrange - create an empty cart
Cart cart = new Cart();
// Arrange - create the order
Order order = new Order();
// Arrange - create an instance of the controller
OrderController target = new OrderController(mock.Object, cart);

// Act
ViewResult result = target.Checkout(order) as ViewResult;

// Assert - check that the order hasn't been stored
mock.Verify(m => m.SaveOrder(It.IsAny<Order>()), Times.Never);
// Assert - check that the method is returning the default view
Assert.True(string.IsNullOrEmpty(result.ViewName));

// Assert - check that I am passing an invalid model to the view
Assert.False(result.ViewData.ModelState.IsValid);

}

This test ensures that | cannot check out with an empty cart. | check this by ensuring that the SaveOrder of the mock
I0rderRepository implementation is never called, that the view the method returns is the default view (which will redisplay
the data entered by customers and give them a chance to correct it), and that the model state being passed to the view has
been marked as invalid. This may seem like a belt-and-braces set of assertions, but | need all three to be sure that | have the
right behavior. The next test method works in much the same way but injects an error into the view model to simulate a problem
reported by the model binder (which would happen in production when the customer enters invalid shipping data):

[Fact]

public void Cannot_Checkout Invalid ShippingDetails() {
// Arrange - create a mock order repository
Mock<IOrderRepository> mock = new Mock<IOrderRepository>();
// Arrange - create a cart with one item
Cart cart = new Cart();
cart.AddItem(new Product(), 1);
// Arrange - create an instance of the controller
OrderController target = new OrderController(mock.Object, cart);
// Arrange - add an error to the model
target.ModelState.AddModelError("error”, "error");

// Act - try to checkout
ViewResult result = target.Checkout(new Order()) as ViewResult;

// Assert - check that the order hasn't been passed stored
mock.Verify(m => m.SaveOrder(It.IsAny<Order>()), Times.Never);
// Assert - check that the method is returning the default view
Assert.True(string.IsNullOrEmpty(result.ViewName));

// Assert - check that I am passing an invalid model to the view
Assert.False(result.ViewData.ModelState.IsValid);
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Having established that an empty cart or invalid details will prevent an order from being processed, | need to ensure that |
process orders when appropriate. Here is the test:

[Fact]
public void Can_Checkout And Submit Order() {
// Arrange - create a mock order repository
Mock<IOrderRepository> mock = new Mock<IOrderRepository>();
// Arrange - create a cart with one item
Cart cart = new Cart();
cart.AddItem(new Product(), 1);
// Arrange - create an instance of the controller
OrderController target = new OrderController(mock.Object, cart);

// Act - try to checkout
RedirectToPageResult result =
target.Checkout(new Order()) as RedirectToPageResult;

// Assert - check that the order has been stored

mock.Verify(m => m.SaveOrder(It.IsAny<Order>()), Times.Once);

// Assert - check that the method is redirecting to the Completed action
Assert.Equal("/Completed"”, result.PageName);

| did not need to test that | can identify valid shipping details. This is handled for me automatically by the model binder using the
attributes applied to the properties of the Order class.

Displaying Validation Errors

ASP.NET Core uses the validation attributes applied to the Order class to validate user data, but I need to make a simple change to
display any problems. This relies on another built-in tag helper that inspects the validation state of the data provided by the user and
adds warning messages for each problem that has been discovered. Listing 9-21 shows the addition of an HTML element that will be
processed by the tag helper to the Checkout.cshtml file.

Listing 9-21. Adding a Validation Summary to the Checkout.cshtml File in the SportsStore/Views/Order Folder
@model Order

<h2>Check out now</h2>
<p>Please enter your details, and we'll ship your goods right away!</p>

<div asp-validation-summary="Al1" class="text-danger"»</div»

<form asp-action="Checkout" method="post">
<h3>Ship to</h3>
<div class="form-group">
<label>Name:</label><input asp-for="Name" class="form-control" />
</div>
<h3>Address</h3>
<div class="form-group">
<label>Line 1:</label><input asp-for="Line1" class="form-control" />
</div>
<div class="form-group">
<label>Line 2:</label><input asp-for="Line2" class="form-control" />
</div>
<div class="form-group">
<label>Line 3:</label><input asp-for="Line3" class="form-control" />
</div>
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<div class="form-group">

<label>City:</label><input asp-for="City" class="form-control" />
</div>
<div class="form-group">

<label>State:</label><input asp-for="State" class="form-control" />
</div>
<div class="form-group">

<label>Zip:</label><input asp-for="Zip" class="form-control" />
</div>
<div class="form-group">

<label>Country:</label><input asp-for="Country" class="form-control" />
</div>
<h3>0ptions</h3>
<div class="checkbox">

<label>

<input asp-for="GiftWrap" /> Gift wrap these items

</label>
</div>
<div class="text-center">

<input class="btn btn-primary" type="submit" value="Complete Order" />
</div>

</form>

With this simple change, validation errors are reported to the user. To see the effect, restart ASP.NET Core, request http://

localhost:5000/0rder/Checkout, and click the Complete Order button without filling out the form. ASP.NET Core will process the

form data, detect that the required values were not found, and generate the validation errors shown in Figure 9-5.

@ SportsStore X
— C @ localhost:5000/Order/Checkout o :
SPORTS STORE w
.~ wme | Check out now
‘ Chii ‘ Please enter your details, and we’ll ship your goods right away!
e Please enter a name
‘ Soccer ‘

e Please enter the first address line

‘ i . ‘ ® Please enter a city name
Watersports
e Please enter a state name

® Please enter a CC)Ur'!tI";,-' name

SOy, vol t 1 !
L SOli},}-Odr cart is empty.

Ship to

Name

ot et _ihn
I NS e f’ _,}.;»-_..m.—._u—.. ’,_r it o a0 dB . P f L

Figure 9-5. Displaying validation messages
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Tip The data submitted by the user is sent to the server before it is validated, which is known as server-side validation and for
which ASP.NET Core has excellent support. The problem with server-side validation is that the user isn’t told about errors until after the
data has been sent to the server and processed and the result page has been generated—something that can take a few seconds on a
busy server. For this reason, server-side validation is usually complemented by client-side validation, where JavaScript is used to check
the values that the user has entered before the form data is sent to the server. | describe client-side validation in Chapter 29.

Displaying a Summary Page

To complete the checkout process, I am going to create a Razor Page that displays a thank-you message with a summary of the order.
Add a Razor Page named Completed.cshtml to the Pages folder with the contents shown in Listing 9-22.

Listing 9-22. The Contents of the Completed.cshtml File in the SportsStore/Pages Folder
@page

<div class="text-center">

<h2>Thanks!</h2>

<p>Thanks for placing order #@0rderId</p>

<p>We'll ship your goods as soon as possible.</p>

<a class="btn btn-primary" asp-controller="Home">Return to Store</a>
</div>

@functions {

[BindProperty(SupportsGet = true)]
public string OrderId { get; set; }

—

Although Razor Pages usually have page model classes, they are not a requirement, and simple features can be developed
without them. In this example, [ have defined a property named OrderId and decorated it with the BindProperty attribute, which
specifies that a value for this property should be obtained from the request by the model binding system

Now customers can go through the entire process, from selecting products to checking out. If they provide valid shipping details
(and have items in their cart), they will see the summary page when they click the Complete Order button, as shown in Figure 9-6.

“— C @ localhost:5000/Completed?orderld=1 w :

SPORTS STORE

Thanks!

Thanks for placing order #1

We'll ship your goods as soon as possible.

Return to Store

Figure 9-6. The completed order summary view
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Notice the way the application moves between controllers and Razor Pages. The application features that ASP.NET Core
provides are complementary and can be mixed freely in projects.

Summary

I have completed all the major parts of the customer-facing portion of SportsStore. It might not be enough to worry Amazon, but I
have a product catalog that can be browsed by category and page, a neat shopping cart, and a simple checkout process.

The approach I have taken means I can easily change the behavior of any piece of the application without causing problems
or inconsistencies elsewhere. For example, I could change the way that orders are stored, and it would not have any impact on the
shopping cart, the product catalog, or any other area of the application. In the next chapter, I add the features required to administer
the SportsStore application.

212



CHAPTER 10

SportsStore: Administration

In this chapter, I continue to build the SportsStore application in order to give the site administrator a way to manage orders and
products. In this chapter, I use Blazor to create administration features. Blazor is a new addition to ASP.NET Core, and it combines
client-side JavaScript code with server-side code executed by ASP.NET Core, connected by a persistent HTTP connection. I describe
Blazor in detail in Chapters 32-35, but it is important to understand that the Blazor model is not suited to all projects. (I use Blazor
Server in this chapter, which is a supported part of the ASP.NET Core platform. There is also Blazor WebAssembly, which is, at the
time of writing, experimental and runs entirely in the browser. I describe Blazor WebAssembly in Chapter 36.)

Tip You can download the example project for this chapter—and for all the other chapters in this book—from https://github.
com/apress/pro-asp.net-core-3. See Chapter 1 for how to get help if you have problems running the examples.

Preparing Blazor Server

The first step is to enable the services and middleware for Blazor, as shown in Listing 10-1.

Listing 10-1. Enabling Blazor in the Startup.cs File in the SportsStore Folder

using System;

using System.Collections.Generic;

using System.Lling;

using System.Threading.Tasks;

using Microsoft.AspNetCore.Builder;

using Microsoft.AspNetCore.Hosting;

using Microsoft.AspNetCore.Http;

using Microsoft.Extensions.DependencyInjection;
using Microsoft.Extensions.Hosting;

using Microsoft.Extensions.Configuration;
using Microsoft.EntityFrameworkCore;
using SportsStore.Models;

namespace SportsStore {
public class Startup {

public Startup(IConfiguration config) {
Configuration = config;
}
private IConfiguration Configuration { get; set; }
public void ConfigureServices(IServiceCollection services) {

services.AddControllersWithViews();
services.AddDbContext<StoreDbContext>(opts => {
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opts.
Configuration["ConnectionStrings:SportsStoreConnection"]);

1

services.
services.
services.
services.
services.
services.
services.

UseSqlServer(

AddScoped<IStoreRepository, EFStoreRepository>();
AddScoped<IOrderRepository, EFOrderRepository>();
AddRazorPages();

AddDistributedMemoryCache();

AddSession();

AddScoped<Cart>(sp => SessionCart.GetCart(sp));
AddSingleton<IHttpContextAccessor, HttpContextAccessor>();

services.AddServerSideBlazor();

}

public void Configure(IApplicationBuilder app, IWebHostEnvironment env) {
app.UseDeveloperExceptionPage();
app.UseStatusCodePages();
app.UseStaticFiles();
app.UseSession();
app.UseRouting();

app.UseEndpoints(endpoints => {
endpoints.MapControllerRoute("catpage”,

"{category}/Page{productPage:int}",
new { Controller = "Home", action = "Index" });

endpoints.MapControllerRoute("page", "Page{productPage:int}",

new { Controller = "Home", action = "Index", productPage = 1 });

endpoints.MapControllerRoute("category", "{category}",

new { Controller = "Home", action = "Index", productPage = 1 });
endpoints.MapControllerRoute("pagination”,

'Products/Page{productPage}",

new { Controller = "Home", action = "Index", productPage = 1 });

endpoints.MapDefaultControllerRoute();

endpoints.MapRazorPages();

endpoints.MapBlazorHub();
endpoints.MapFallbackToPage("/admin/{*catchall}", "/Admin/Index");

1

SeedData.EnsurePopulated(app);

The AddServerSideBlazor method creates the services that Blazor uses, and the MapBlazorHub method registers the Blazor
middleware components. The final addition is to finesse the routing system to ensure that Blazor works seamlessly with the rest of

the application.

Creating the Imports File

Blazor requires its own imports file to specify the namespaces that it uses. Create the Pages/Admin folder and add to it a file named
Imports.razor with the content shown in Listing 10-2. (If you are using Visual Studio, you can use the Razor Components template

to create this file.)

Note The conventional location for Blazor files is within the Pages folder, but Blazor files can be defined anywhere in the project. In
Part 4, for example, | used a folder named Blazor to help emphasize which features were provided by Blazor and which by Razor Pages.
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Listing 10-2. The Contents of the _Imports.razor File in the SportsStore/Pages/Admin Folder

@using Microsoft.AspNetCore.Components

@using Microsoft.AspNetCore.Components.Forms
@using Microsoft.AspNetCore.Components.Routing
@using Microsoft.AspNetCore.Components.Web
@using Microsoft.EntityFrameworkCore

@using SportsStore.Models

The first four @using expressions are for the namespaces required for Blazor. The last two expressions are for convenience in the
examples that follow because they will allow me to use Entity Framework Core and the classes in the Models namespace.

Creating the Startup Razor Page

Blazor relies on a Razor Page to provide the initial content to the browser, which includes the JavaScript code that connects to the
server and renders the Blazor HTML content. Add a Razor Page named Index.cshtml to the Pages/Admin folder with the contents
shown in Listing 10-3.

Listing 10-3. The Contents of the Index.cshtml File in the SportsStore/Pages/Admin Folder

@page "/admin"
@{ Layout = null; }

<!DOCTYPE html>
<html>
<head>
<title>SportsStore Admin</title>
<link href="/1ib/twitter-bootstrap/css/bootstrap.min.css" rel="stylesheet" />
<base href="/" />
</head>
<body>
<component type="typeof(Routed)" render-mode="Server" />
<script src="/_framework/blazor.server.js"></script>
</body>
</html>

The component element is used to insert a Razor Component in the output from the Razor Page. Razor Components are the
confusingly named Blazor building blocks, and the component element applied in Listing 10-3 is named Routed and will be created
shortly. The Razor Page also contains a script element that tells the browser to load the JavaScript file that Blazor Server uses. Requests
for this file are intercepted by the Blazor Server middleware, and you don’t need to explicitly add the JavaScript file to the project.

Creating the Routing and Layout Components

Add a Razor Component named Routed.razor to the Pages/Admin folder and add the content shown in Listing 10-4.

Listing 10-4. The Contents of the Routed.razor File in the SportsStore/Pages/Admin Folder

<Router AppAssembly="typeof(Startup).Assembly">
<Found>
<RouteView RouteData="@context" Defaultlayout="typeof(AdminLayout)" />
</Found>
<NotFound>
<h4 class="bg-danger text-white text-center p-2">
No Matching Route Found
</h4>
</NotFound>
</Router>
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The content of this component is described in detail in Part 4 of this book, but, for this chapter, it is enough to know that the
component will use the browser’s current URL to locate a Razor Component that can be displayed to the user. If no matching
component can be found, then an error message is displayed.

Blazor has its own system of layouts. To create the layout for the administration tools, add a Razor Component named
AdminLayout.razor to the Pages/Admin folder with the content shown in Listing 10-5.

Listing 10-5. The Contents of the AdminLayout.razor File in the SportsStore/Pages/Admin Folder

@inherits LayoutComponentBase

<div class="bg-info text-white p-2">
<span class="navbar-brand ml-2">SPORTS STORE Administration</span>
</div>
<div class="container-fluid">
<div class="row p-2">
<div class="col-3">
<NavLink class="btn btn-outline-primary btn-block"
href="/admin/products”
ActiveClass="btn-primary text-white"
Match="NavLinkMatch.Prefix">
Products
</NavLink>
<NavLink class="btn btn-outline-primary btn-block"
href="/admin/orders"
ActiveClass="btn-primary text-white"
Match="NavLinkMatch.Prefix">
Orders
</NavLink>
</div>
<div class="col">
@Body
</div>
</div>
</div>

Blazor uses Razor syntax to generate HTML but introduces its own directives and features. This layout renders a two-column
display with Product and Order navigation buttons, which are created using NavLink elements. These elements apply a built-in
Razor Component that changes the URL without triggering a new HTTP request, which allows Blazor to respond to user interaction
without losing the application state.

Creating the Razor Components

To complete the initial setup, I need to add the components that will provide the administration tools, although they will contain
placeholder messages at first. Add a Razor Component named Products.razor to the Pages/Admin folder with the content shown in
Listing 10-6.

Listing 10-6. The Contents of the Products.razor File in the SportsStore/Pages/Admin Folder

@page "/admin/products”
@page "/admin"

<h4>This is the products component</h4>

The @page directives specify the URLs for which this component will be displayed, which is /admin/products and /admin. Next,
add a Razor Component named Orders.razor to the Pages/Admin folder with the content shown in Listing 10-7.
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Listing 10-7. The Contents of the Orders.razor File in the SportsStore/Pages/Admin Folder

@page "/admin/orders"

<h4>This is the orders component</h4>

Checking the Blazor Setup

To make sure that Blazor is working correctly, start ASP.NET Core and request http://localhost:5000/admin. This request will be
handled by the Index Razor Page in the Pages/Admin folder, which will include the Blazor JavaScript file in the content it sends to the
browser. The JavaScript code will open a persistent HTTP connection to the ASP.NET Core server, and the initial Blazor content will
be rendered, as shown in Figure 10-1.

Note Microsoft has not yet released the tools required to test Razor Components, which is why there are no unit testing examples in
this chapter.

@ SportsStore Admin X

&« C @ localhost:5000/admin/ Ty

SPORTS STORE Administration

| Products \ This is the products component

‘ Orders ’

Figure 10-1. The Blazor application

Click the Orders button, and content generated by the Orders Razor Component will be displayed, as shown in Figure 10-2.
Unlike the other ASP.NET Core application frameworks I used in earlier chapters, the new content is displayed without a new HTTP
request being sent, even though the URL displayed by the browser changes.

@ SportsStore Admin

&« - C @ localhost:5000/admin/orders

SPORTS STORE Administration

[ Products ‘ This is the orders component

Figure 10-2. Navigating in the Blazor application
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Managing Orders

Now that Blazor has been set up and tested, I am going to start implementing administration features. In the previous chapter,
I added support for receiving orders from customers and storing them in a database. In this section, I am going to create a simple
administration tool that will let me view the orders that have been received and mark them as shipped.

Enhancing the Model

The first change I need to make is to enhance the data model so that I can record which orders have been shipped. Listing 10-8
shows the addition of a new property to the Order class, which is defined in the Order. cs file in the Models folder.

Listing 10-8. Adding a Property in the Order.cs File in the SportsStore/Models Folder

using System.Collections.Generic;
using System.ComponentModel.DataAnnotations;
using Microsoft.AspNetCore.Mvc.ModelBinding;

namespace SportsStore.Models {
public class Order {

[BindNever]

public int OrderID { get; set; }

[BindNever ]

public ICollection<CartLine> Lines { get; set; }

[Required(ErrorMessage = "Please enter a name")]
public string Name { get; set; }

[Required(ErrorMessage = "Please enter the first address line")]

public string Linel { get; set; }
public string Line2 { get; set; }
public string Line3 { get; set; }

[Required(ErrorMessage = "Please enter a city name")]
public string City { get; set; }

[Required(ErrorMessage = "Please enter a state name")]
public string State { get; set; }

public string Zip { get; set; }

[Required(ErrorMessage = "Please enter a country name")]
public string Country { get; set; }

public bool GiftWrap { get; set; }

[BindNever]
public bool Shipped { get; set; }

This iterative approach of extending and adapting the data model to support different features is typical of ASP.NET Core
development. In an ideal world, you would be able to completely define the data model at the start of the project and just build the
application around it, but that happens only for the simplest of projects, and, in practice, iterative development is to be expected as
the understanding of what is required develops and evolves.

Entity Framework Core migrations make this process easier because you don’t have to manually keep the database schema
synchronized to the model class by writing your own SQL commands. To update the database to reflect the addition of the Shipped
property to the Order class, open a new PowerShell window and run the command shown in Listing 10-9 in the SportsStore project.
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Listing 10-9. Creating a New Migration
dotnet ef migrations add ShippedOrders

The migration will be applied automatically when the application is started and the SeedData class calls the Migrate method
provided by Entity Framework Core.

Displaying Orders to the Administrator

I am going to display two tables, one of which shows the orders waiting to be shipped and the other the shipped orders. Each order
will be presented with a button that changes the shipping state. This is not entirely realistic because orders processing is typically
more complex than simply updating a field in the database, but integration with warehouse and fulfillment systems is well beyond
the scope of this book.

To avoid duplicating code and content, I am going to create a Razor Component that displays a table without knowing which
category of order it is dealing with. Add a Razor Component named OrderTable.razor to the Pages/Admin folder with the content
shown in Listing 10-10.

Listing 10-10. The Contents of the OrderTable.razor File in the SportsStore/Pages/Admin Folder

<table class="table table-sm table-striped table-bordered">
<thead>
<tr><th colspan="5" class="text-center">@TableTitle</th></tr>
</thead>
<tbody>
@if (Orders?.Count() > 0) {
@foreach (Order o in Orders) {
<tr>
<td>@o.Name</td><td>@0.Zip</td><th>Product</th><th>Quantity</th>
<td>
<button class="btn btn-sm btn-danger"
@onclick="@(e => OrderSelected.InvokeAsync(o.0rderID))">

@ButtonLabel
</button>
</td>
</tr>
@foreach (CartLine line in o.Lines) {
<tr>
<td colspan="2"></td>
<td>@line.Product.Name</td><td>@line.Quantity</td>
<td></td>
</tr>
}
}
} else {
<tr><td colspan="5" class="text-center">No Orders</td></tr>
}
</tbody>
</table>
@code {
[Parameter]

public string TableTitle { get; set; } = "Orders";

[Parameter]
public IEnumerable<Order> Orders { get; set; }
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[Parameter]
public string ButtonLabel { get; set; } = "Ship";

[Parameter]
public EventCallback<int> OrderSelected{ get; set; }

Razor Components, as the name suggests, rely on the Razor approach to annotated HTML elements. The view part of the
component is supported by the statements in the @code section. The @code section in this component defines four properties that
are decorated with the Parameter attribute, which means the values will be provided at runtime by the parent component, which
I'will create shortly. The values provided for the parameters are used in the view section of the component to display details of a
sequence of Order objects.

Blazor adds expressions to the Razor syntax. The view section of this component includes this button element, which has an
@onclick attribute.

<button class="btn btn-sm btn-danger"
@onclick="@(e => OrderSelected.InvokeAsync(o.0rderID))">
@ButtonLabel
</button>

This tells Blazor how to react when the user clicks the button. In this case, the expression tells Razor to call the InvokeAsync
method of the OrderSelected property. This is how the table will communicate with the rest of the Blazor application and will
become clearer as I build out additional features.

Tip | describe Blazor in-depth in Part 4 of this book, so don’t worry if the Razor Components in this chapter do not make
immediate sense. The purpose of the SportsStore example is to show the overall development process, even if individual features are
not understood.

The next step is to create a component that will get the Order data from the database and use the OrderTable component to
display it to the user. Remove the placeholder content in the Orders component and replace it with the code and content shown in
Listing 10-11.

Listing 10-11. The Revised Contents of the Orders.razor File in the SportsStore/Pages/Admin Folder

@page "/admin/orders"
@inherits OwningComponentBase<IOrderRepository>

<OrderTable TableTitle="Unshipped Orders"

Orders="UnshippedOrders" ButtonLabel="Ship" OrderSelected="ShipOrder" />
<OrderTable TableTitle="Shipped Orders"

Orders="ShippedOrders" ButtonLabel="Reset" OrderSelected="ResetOrder" />
<button class="btn btn-info" @onclick="@(e => UpdateData())">Refresh Data</button>

@code {
public IOrderRepository Repository => Service;
public IEnumerable<Order> AllOrders { get; set; }
public IEnumerable<Order> UnshippedOrders { get; set; }
public IEnumerable<Order> ShippedOrders { get; set; }

protected async override Task OnInitializedAsync() {
await UpdateData();
}
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public async Task UpdateData() {
AllOrders = await Repository.Orders.TolListAsync();
UnshippedOrders = AllOrders.Where(o => !o.Shipped);
ShippedOrders = AllOrders.Where(o => o.Shipped);

public void ShipOrder(int id) => UpdateOrder(id, true);
public void ResetOrder(int id) => UpdateOrder(id, false);

private void UpdateOrder(int id, bool shipValue) {
Order o = Repository.Orders.FirstOrDefault(o => 0.0rderID == id);
0.Shipped = shipValue;
Repository.SaveOrder(o);

Blazor Components are not like the other application framework building blocks used for the user-facing sections of the
SportsStore application. Instead of dealing with individual requests, components can be long-lived and deal with multiple user
interactions over a longer period. This requires a different style of development, especially when it comes to dealing with data using
Entity Framework Core. The @inherits expression ensures that this component gets its own repository object, which ensures its
operations are separate from those performed by other components displayed to the same user. And to avoid repeatedly querying
the database—which can be a serious problem in Blazor, as I explain in Part 4—the repository is used only when the component is
initialized, when Blazor invokes the OnInitializedAsync method, or when the user clicks a Refresh Data button.

To display its data to the user, the OrderTable component is used, which is applied as an HTML element, like this:

<OrderTable TableTitle="Unshipped Orders"
Orders="UnshippedOrders" ButtonLabel="Ship" OrderSelected="ShipOrder" />

The values assigned to the OrderTable element’s attributes are used to set the properties decorated with the Parameter
attribute in Listing 10-10. In this way, a single component can be configured to present two different sets of data without the need to
duplicate code and content.

The ShipOrder and ResetOrder methods are used as the values for the OrderSelected attributes, which means they are invoked
when the user clicks one of the buttons presented by the OrderTable component, updating the data in the database through the repository.
To see the new features, restart ASP.NET Core, request http://localhost:5000, and create an order. Once you have at least
one order in the database, request http://localhost:5000/admin/orders, and you will see a summary of the order you created
displayed in the Unshipped Orders table. Click the Ship button, and the order will be updated and moved to the Shipped Orders

table, as shown in Figure 10-3.

Products Unshipped Orders dministration
Joe Smith NY10036 Product i
ik A Smnshy Unshipped Orders
Lifejacket 1 Ordars

Corner Flags 2
rders

Shipped Orders Joe Smith  NY10036  Product Quantity [

No Orders gt
Lifejacket 1

Refresh Data Corner Flags 2
Refresh Data

Figure 10-3. Administering orders
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Adding Catalog Management

The convention for managing more complex collections of items is to present the user with two interfaces: a list interface and an edit
interface, as shown in Figure 10-4.

List Screen Edit Item: Kayak
ltem Actions e Kayak
Kayak Edit| Delete Description: | A boat for one pe...
Lifejacket Edit| Delete Category: Watersports
Soccer ball Edit| Delete Price ($): 275.00

Add New Iltem Save Cancel

Figure 10-4. Sketch of a CRUD UI for the product catalog

Together, these interfaces allow a user to create, read, update, and delete items in the collection. Collectively, these actions are
known as CRUD. In this section, I will implement these interfaces using Blazor.

Tip Developers need to implement CRUD so often that Visual Studio scaffolding includes scenarios for creating CRUD controllers
or Razor Pages. But, like all Visual Studio scaffolding, | think it is better to learn how to create these features directly, which is why |
demonstrate CRUD operations for all the ASP.NET Core application frameworks in later chapters.

Expanding the Repository

The first step is to add features to the repository that will allow Product objects to be created, modified, and deleted. Listing 10-12
adds new methods to the IStoreRepository interface.

Listing 10-12. Adding Methods in the IStoreRepository.cs File in the SportsStore/Models Folder

using System.Ling;

namespace SportsStore.Models {
public interface IStoreRepository {

IQueryable<Product> Products { get; }
void SaveProduct(Product p);

void CreateProduct(Product p);
void DeleteProduct(Product p);

Listing 10-13 adds implementations of these methods to the Entity Framework Core repository class.
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Listing 10-13. Implementing Methods in the EFStoreRepository.cs File in the SportsStore/Models Folder
using System.Lling;
namespace SportsStore.Models {

public class EFStoreRepository : IStoreRepository {
private StoreDbContext context;

public EFStoreRepository(StoreDbContext ctx) {
context = ctx;
}
public IQueryable<Product> Products => context.Products;
public void CreateProduct(Product p) {

context.Add(p);
context.SaveChanges();

}

public void DeleteProduct(Product p) {
context.Remove(p);
context.SaveChanges();

}

public void SaveProduct(Product p) {
context.SaveChanges();
}

Applying Validation Attributes to the Data Model

I want to validate the values the user provides when editing or creating Product objects, just as I did for the customer checkout
process. In Listing 10-14, I have added validation attributes to the Product data model class.

Listing 10-14. Adding Validation Attributes in the Product.cs File in the SportsStore/Models Folder

using System.ComponentModel.DataAnnotations.Schema;
using System.ComponentModel.DataAnnotations;

namespace SportsStore.Models {

public class Product {
public long ProductID { get; set; }

[Required(ErrorMessage = "Please enter a product name")]
public string Name { get; set; }

[Required(ErroxMessage = "Please enter a description")]
public string Description { get; set; }

[Required]
[Range(0.01, double.MaxValue,
ErrorMessage = "Please enter a positive price")]
[Column(TypeName = "decimal(8, 2)")]
public decimal Price { get; set; }
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[Required(ErrorMessage = "Please specify a category”)]
public string Category { get; set; }

Blazor uses the same approach to validation as the rest of ASPNET Core but, as you will see, applies it a different way to deal
with the more interactive nature of Razor Components.

Creating the List Component

I am going to start by creating the table that will present the user with a table of products and the links that will allow them to be
inspected and edited. Replace the contents of the Products.razor file with those shown in Listing 10-15.

Listing 10-15. The Revised Contents of the Products.razor File in the SportsStore/Pages/Admin Folder

@page "/admin/products”
@page "/admin"
@inherits OwningComponentBase<IStoreRepository>

<table class="table table-sm table-striped table-bordered">
<thead>
<tr>
<th>ID</th><th>Name</th>
<th>Category</th><th>Price</th><td/>
</tr>
</thead>
<tbody>
@if (ProductData?.Count() > 0) {
@foreach (Product p in ProductData) {
<tr>
<td>@p.ProductID</td>
<td>@p.Name</td>
<td>@p.Category</td>
<td>@p.Price.ToString("c")</td>
<td>
<NavLink class="btn btn-info btn-sm"
href="@GetDetailsUr1l(p.ProductID)">
Details
</NavLink>
<NavLink class="btn btn-warning btn-sm"
href="@GetEditUrl(p.ProductID)">
Edit
</NavLink>
</td>
</tr>

} else {
<tr>
<td colspan="5" class="text-center">No Products</td>
</tr>

}
</tbody>

</table>

<NavLink class="btn btn-primary" href="/admin/products/create">Create</NavLink>
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@code {
public IStoreRepository Repository => Service;
public IEnumerable<Product> ProductData { get; set; }
protected async override Task OnInitializedAsync() {

await UpdateData();
}

public async Task UpdateData() {
ProductData = await Repository.Products.TolListAsync();
}

public string GetDetailsUrl(long id) => $"/admin/products/details/{id}";
public string GetEditUrl(long id) => $"/admin/products/edit/{id}";

—

The component presents each Product object in the repository in a table row with NavLink components that will navigate to the
components that will provide a detailed view and an editor. There is also a button that navigates to the component that will allow
new Product objects to be created and stored in the database. Restart ASP.NET Core and request http://localhost:5000/admin/
products, and you will see the content shown in Figure 10-5, although none of the buttons presented by the Products component
work currently because I have yet to create the components they target.

@ SportsStore Admin 3

Fa C @ localhost:5000/admin/products %4 :

SPORTS STORE Administration

ID Name Category  Price

i e I 1 Kayak Watersports  $275.00 m Edit
2 Lifejacket Watersports $48.95 m Edit
3 Soccer Ball Soccer $19.50 m Edit
4 Corner Flags Soccer $34.95 m Edit
5 Stadium Soccer $79,500.00 m Edit
6 Thinking Cap Chess $16.00 @ Edit
7 Unsteady Chair Chess §29.95 Edit
8 Human Chess Board Chess $75.00 m Edit
9 Bling-Bling King Chess $1,200.00 m Edit

Figure 10-5. Presenting a list of products
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Creating the Detail Component

The job of the detail component is to display all the fields for a single Product object. Add a Razor Component named Details.razor
to the Pages/Admin folder with the content shown in Listing 10-16.

Listing 10-16. The Contents of the Details.razor File in the SportsStore/Pages/Admin Folder

@page "/admin/products/details/{id:long}"
<h3 class="bg-info text-white text-center p-1">Details</h3>

<table class="table table-sm table-bordered table-striped">
<tbody>
<tr><th>ID</th><td>@Product.ProductID</td></tr>
<tr><th>Name</th><td>@Product.Name</td></tr>
<tr><th>Description</th><td>@Product.Description</td></tr>
<tr><th>Category</th><td>@Product.Category</td></tr>
<tr><th>Price</th><td>@Product.Price.ToString("C")</td></tr>
</tbody>
</table>

<NavLink class="btn btn-warning" href="@EditUrl">Edit</NavLink>
<NavLink class="btn btn-secondary" href="/admin/products">Back</NavLink>

@code {

[Inject]
public IStoreRepository Repository { get; set; }

[Parameter]
public long Id { get; set; }

public Product Product { get; set; }
protected override void OnParametersSet() {

Product = Repository.Products.FirstOrDefault(p => p.ProductID == Id);
}

public string EditUrl => $"/admin/products/edit/{Product.ProductID}";

The component uses the Inject attribute to declare that it requires an implementation of the IStoreRepository interface,
which is one of the ways that Blazor provides access to the application’s services. The value of the Id property will be populated from
the URL that has been used to navigate to the component, which is used to retrieve the Product object from the database. To see the
detail view, restart ASP.NET Core, request http://localhost:5000/admin/products, and click one of the Details buttons, as shown
in Figure 10-6.
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@ SportsStore Admin

=

Name Lifejacket

Description Protective and fashionable
Category Watersports

Price $48.95

Figure 10-6. Displaying details of a product

Creating the Editor Component

The operations to create and edit data will be handled by the same component. Add a Razor Component named Editor.razor to
the Pages/Admin folder with the content shown in Listing 10-17.

Listing 10-17. The Contents of the Editor.razor File in the SportsStore/Pages/Admin Folder

@page "/admin/products/edit/{id:long}"
@page "/admin/products/create”
@inherits OwningComponentBase<IStoreRepository>

<style>
div.validation-message { color: rgb(220, 53, 69); font-weight: 500 }
</style>

<h3 class="bg-@ThemeColor text-white text-center p-1">@TitleText a Product</h3>
<EditForm Model="Product" OnValidSubmit="SaveProduct">
<DataAnnotationsValidator />
@if(Product.ProductID != 0) {
<div class="form-group">
<label>ID</label>
<input class="form-control" disabled value="@Product.ProductID" />
</div>
}
<div class="form-group">
<label>Name</label>
<ValidationMessage For="@(() => Product.Name)" />
<InputText class="form-control"” @bind-Value="Product.Name" />
</div>
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<div class="form-group">

<label>Description</label>

<ValidationMessage For="@(() => Product.Description)" />

<InputText class="form-control" @bind-Value="Product.Description" />
</div>
<div class="form-group">

<label>Category</label>

<ValidationMessage For="@(() => Product.Category)" />

<InputText class="form-control" @bind-Value="Product.Category" />

</div>
<div class="form-group">
<label>Price</label>

<ValidationMessage For="@(() => Product.Price)" />
<InputNumber class="form-control" @bind-Value="Product.Price" />
</div>
<button type="submit" class="btn btn-@ThemeColor">Save</button>
<NavLink class="btn btn-secondary" href="/admin/products”>Cancel</NavLink>
</EditForm>

@code {
public IStoreRepository Repository => Service;

[Inject]
public NavigationManager NavManager { get; set; }

[Parameter]
public long Id { get; set; } = 0;

public Product Product { get; set; } = new Product();
protected override void OnParametersSet() {

if (Id != 0) {
Product = Repository.Products.FirstOrDefault(p => p.ProductID == Id);

}
}
public void SaveProduct() {
if (Id == 0) {
Repository.CreateProduct(Product);
} else {
Repository.SaveProduct(Product);
}
NavManager.NavigateTo("/admin/products");
}
public string ThemeColor => Id == 0 ? "primary" : "warning";

public string TitleText => Id == 0 ? "Create" : "Edit";

Blazor provides a set of built-in Razor Components that are used to display and validate forms, which is important because the
browser can’t submit data using a POST request in a Blazor Component. The EditForm component is used to render a Blazor-friendly
form, and the InputText and InputNumber components render input elements that accept string and number values and that
automatically update a model property when the user makes a change.

Data validation is integrated into these built-in components, and the OnValidSubmit attribute on the EditForm component
is used to specify a method that is invoked only if the data entered into the form conforms to the rules defined by the validation
attributes.
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Blazor also provides the NavigationManager class, which is used to programmatically navigate between components without

triggering a new HTTP request. The Editor component uses NavigationManager, which is obtained as a service, to return to the

Products component after the database has been updated.
To see the editor, restart ASP.NET Core, request http://localhost:5000/admin, and click the Create button. Click the Save button
without filling out the form fields, and you will see the validation errors that Blazor produces automatically, as shown in Figure 10-7. Fill

out the form and click Save again, and you will see the product you created displayed in the table, also as shown in Figure 10-7.

&«

Orders

@ SportsStore Admin

Create a Prog
MName

Please enter a product name

Description

Please enter a description

Category

Please specify a category

Price

Please enter a pasitive price

Orders | Name

Tinted Goggles

Description

Lock cool, see better

Category
Snowsports

Price

28

Products

Orders

ID Mame

1 Kayak

2 Lifejacket

3 Soccer Ball
4  Comer Flags

5 Stadium

& Thinking Cap

7 Unsteady Chair

Category
Watersports

Watersports
Soccer
Soccer
Soccer
Chess

Chess.

& Human Chess Board Chess

Price

soso0 [N R
54395 Detais 170
$18.50 Dataits Y
3495 mhn
s79.50000 [N [EE
$16.00 Edit
$20.95 Edit
ss0 [ R

9 Bling-BlingKing  Chess $1,20000 m Edn
Snowsports  $28.00 Lu-.u-, Edit l

_"*I 10 Tinted Goggles

0

Figure 10-7. Using the Editor component

Click the Edit button for one of the products, and the same component will be used to edit the selected Product object’s properties.

Click the Save button, and any changes you made—if they pass validation—will be stored in the database, as shown in Figure 10-8.

@ SportsStore Admin

«

I Orders |

10

Name

Deluxe Tinted Goggles

Description

Look coo)fsee better

ID Name
1 Kayak

2 Lifejacket

3 Soccer Ball

4 Corner Flags

5 Stadium

6 Thinking Cap

7 Unsteady Chair

8 Human Chess Board

9 Bling-Bling King

Category
Watersports

Watersports
Soccer
Soccer
Soccer
Chess
Chess
Chess

Chess

10 Deluxe Tinted Goggles

Snpwsports

Create

Price

sa7so0 RN feg
$48.95 Edit
SEELI oo |0
$34.95 Detaits 710
$79,50000 [N [E
$16.00 it
$29.95 [ ea
$75.00 Detaits 210
§1.20000 NS Segi
o

Figure 10-8. Editing products
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Deleting Products

The final CRUD feature is deleting products, which is easily implemented in the Products component, as shown in Listing 10-18.

Listing 10-18. Adding Delete Support in the Products.razor File in the SportsStore/Pages/Admin Folder

@page "/admin/products”
@page "/admin"
@inherits OwningComponentBase<IStoreRepository>

<table class="table table-sm table-striped table-bordered">
<thead>
<tr>
<th>ID</th><th>Name</th>
<th>Category</th><th>Price</th><td/>
</tr>
</thead>
<tbody>
@if (ProductData?.Count() > 0) {
@foreach (P